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ChemiSoft TPx Operator’s Manual Organization of the Manual
1.  GENERAL DESCRIPTION

This manual describes how to install and operate the ChemiSoft TPx program in conjunc-
tion with the ChemiSorb 2750 and 2720 analyzers. 

Organization of the Manual

The ChemiSoft operator’s manual is organized as follows:

Chapter 1 
General Description

Provides a general description of the ChemiSoft pro-
gram, its features, and specifications.

Chapter 2 
Installation

Provides instructions for installing the program.

Chapter 3 
User Interface

Provides basic software and instrument interface.

Chapter 4 
Operating Procedures

Provides brief step-by-step procedures for the opera-
tions you can perform with the program.

Chapter 5 
File Menu

Provides a description of the commands available on the 
File menu.

Chapter 6 
Unit Menu

Provides a description of the commands available on the 
Unit menu.

Chapter 7 
Reports Menu

Provides a description of the commands available on the 
Reports menu.

Chapter 8 
Options Menu

Provides a description of the commands available on the 
Options menu

Appendix A
Forms

Provides a form for you to copy and use for recording 
values to be entered in the controller.

Appendix B
Error Messages

Provides a listing of error messages that may be dis-
played by the ChemiSoft program, as well as causes and 
actions for each.
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Conventions

This manual uses the symbols shown below to identify notes of importance and warnings:

Appendix C
Calculations

Contains the calculations used by the software to 
produce reports.

Appendix D
Format of Exported Data

Provides the ASCII and Grams/32 formats for exported 
data.

Index Provides quick access to a subject matter.

Notes contain important information pertinent to the subject matter.

Warnings contain information that help you prevent actions that could cause 
personal injury.

Cautions contain information that help you prevent actions that could damage the 
controller..
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Description

The ChemiSoft program has been developed to interface with the ChemiSorb 2750 and 
2720 analyzers. This program allows you to:

• monitor and record analysis signal and sample temperature data
• monitor and record the furnace temperature
• create and store sample files
• create analysis conditions files for specialized analyses, such as TPR, TPO, etc.
• perform analyses using prompts on the software screens and manually interface with 

the analyzer 
• integrate detector signal peaks, automatically and manually
• perform peak deconvolution using peak-fitting algorithms
• generate and customize reports
• display and edit peak graphs and reports
• establish calibration curves for calculation of unknown sample concentrations
• export data in ASCII text for use in other applications 

Online Help

An extensive online help system is provided for quick-and-easy access to a subject 
matter. The ChemiSoft help system functions in the same manner as most other help 
systems. You can:

• choose a subject from the Contents window where topics are organized in “books” 

• locate your topic using the Index window where topics are listed alphabetically by 
key words, or 

• search for information on a specific topic using the Find window.

Report System

The ChemiSoft program includes a report system which allows you to manipulate and 
customize reports. You can zoom in on portions of the graphs or shift the axes to examine 
fine details. Scalable graphs can be copied to the clipboard and pasted into other 
applications. Reports can be customized with your choice of fonts and a company logo 
added to the report header for an impressive presentation. Refer to Chapter 7 for the 
options available for reports.
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Peak Editor

The ChemiSoft program includes an integrated Peak Editor. The Peak Editor provides an 
easy-to-use interface enabling you to view TCD signal and temperature data for sample 
files containing up to 16 experiments. the Peak Editor also allows you to specify and 
integrate peaks in the TCD signal so that the volume and gas consumed or evolved may 
be quantified. Peak fitting (deconvolution) is also included for TCD signals that feature 
overlapping peaks. Chapter 7 provides details for the Peak Editor.
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Types of Analyses

Regardless of which type of experiment you perform, the basic concept is the same: the 
Thermal Conductivity Detector (TCD) detects changes in the gas mixture flowing 
through it. The sample, gas selection, and analysis conditions determine what changes 
occur. Some of the analyses you can perform using the ChemiSoft option are described 
below.

TPD Analysis

Temperature-Programmed Desorption (TPD) analyses determine the number, type, and 
strength of active sites available on the surface of a catalyst from measurement of the 
amount of gas desorbed at various temperatures.

After the sample has been outgassed, reduced, or otherwise prepared, a steady stream of 
analysis gas flows through the sample and adsorbs on the active sites. Programmed 
desorption begins by raising the temperature linearly with time while a steady stream of 
inert carrier gas flows through the sample.

At a certain temperature, the heat overcomes the activation energy; therefore, the bond 
between the adsorbate and adsorbent will break and the adsorbed species desorb. If dif-
ferent active metals are present, they usually desorb the adsorbed species at different 
temperatures. These desorbed molecules enter the stream of inert carrier gas and are 
swept to the detector, which measures the gas concentrations. The volume of desorbed 
species, combined with the stoichiometry factor and the temperature at which pre-
adsorbed species desorb, yields the number and strength of active sites.

TPR Analysis

Temperature-Programmed Reduction (TPR) determines the number of reducible species 
present in the catalyst and reveals the temperature at which the reduction occurs. An 
important aspect of TPR analyses is that the sample need not have any special character-
istics other than containing reducible metals.

The TPR analysis begins by flowing analysis gas (typically hydrogen in an inert carrier 
gas such as nitrogen or argon) through the sample, usually at ambient temperature. While 
the gas is flowing, the temperature of the sample is increased linearly with time and the 
consumption of hydrogen by the reaction is monitored. Changes in the concentration of 
the gas mixture are determined. This information yields the hydrogen uptake volume.
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TPO Analysis

Temperature-Programmed Oxidation (TPO) examines the extent to which a catalyst can 
be oxidized or, by inference, was previously reduced.

Usually the sample is pretreated and the metal oxides are reduced to the base metal, 
typically with a gas mixture of hydrogen with either nitrogen or argon. Then the reactant 
gas, typically 2-5% oxygen with helium, is applied to the sample as a steady stream.

The furnace heats the sample tube and sample according to the user-selected temperature 
program. The oxidation reaction occurs at a specific temperature. The uptake of oxygen. 
is determined.

When using any mixture of gases for either TPR or TPO analyses, make sure the thermal 
conductivities of the two gases in the mixture are quite different for maximum sensitivity.

Pulse Chemisorption Analysis

A Pulse Chemisorption analysis determines active surface area, percent metal dispersion, 
and the average active particle size by applying measured doses of reactant gas to the 
sample, usually while the sample is held at a steady temperature.

The gas reacts with each active site until all sites have reacted. Once the active sites have 
completely reacted, the discretely injected gas volumes elute from the sample tube 
unchanged. The amount chemisorbed is the difference between the total amount of reac-
tant gas injected and the amount that eluted from the sample. The quantity of each pulse 
of reactant gas is determined by the loop volume on an automatically controlled valve, or 
from syringe injections. Three loops of different volumes are provided with the Chemi-
Sorb 2750 analyzer.

BET Surface Area Analysis 

The BET Surface Area analysis lets you evaluate total surface area of the catalyst before 
and after chemisorption. Pore-plugging phenomena which might occur due to the irre-
versible adsorbed species during chemical reactions, as well as the occurrence of 
sintering, can be studied.

After outgassing the sample, mixtures of nitrogen and helium (typically 5 to 30% nitro-
gen) flow over the sample which is immersed in a liquid nitrogen (LN2) bath. The 
adsorption and, upon removal of the LN2, the desorption of the N2 are recorded. The 
amount of nitrogen desorbed and the sample mass are used to calculate total specific sur-
face area.

The entire BET analysis — or even repeat analyses — is performed in situ.
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Langmuir Surface Area analysis

The Langmuir surface area analysis allows you to evaluate the total surface area of the 
catalyst and is especially useful for adsorbate/adsorbent systems that adsorb only a 
monolayer. These materials typically exhibit a Type 1 isotherm and are often 
microporous. The Langmuir surface area analysis may be best applied to zeolites and 
microporous carbons – typically the Langmuir surface area will exceed the BET surface 
area for these materials and provide a more accurate estimation of the total surface area.

The Langmuir surface area report may be applied to a wide range of gas concentrations 
and is not limited to the typical BET range (5-30%).

Total Pore Volume analysis

The Total Pore Volume is a single-point estimate of the pore capacity of a material. The 
total pore volume analysis is usually conducted near the saturation pressure of the 
adsorbate (0.995 P/Po). The total pore volume of a material can be determined on both 
fresh and used materials, the difference in pore volume may indicate pore plugging and 
directly relate to changes in the performance of catalysts and adsorbents.

For high surface area (> 100 m2/g), a sample quantity less than 50 mg is recommended. 
The high sensitivity combined with the large quantity of adsorbed gas allows the use of 
smaller sample quantities while maintaining high precision. The reduced sample quantity 
will also reduce the likelihood of saturating the high sensitivity detector.
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Specifications

Your system must meet or exceed the following requirements:

• Pentium 733 MHz computer (or equivalent)
• CD-ROM drive
• USB port
• 128 megabytes of main memory
• 1-gigabyte hard drive
• SVGA monitor (800 x 600 minimum; 1024 x 768 recommended)
• Windows 2000 or Windows XP Professional
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2.  INSTALLATION

This chapter describes how to install the ChemiSoft program.

The ChemiSoft option includes the following:

• Furnace controller and operating accessories
• One CD containing the software program
• Operator’s manual

Notify Micromeritics immediately if you failed to receive all items (compare your 
packing list with items received).

Installing the Software

The ChemiSoft software is supplied on a CD. Perform the following steps to install the 
software:

1. Insert the program CD into the CD-ROM drive.

2. Select Start from the Status bar, then Run from the Start menu.

3. Enter the name of the drive designator, followed by setup. For example, if your CD-
ROM drive is drive e, enter: e:setup

Alternatively you may click Browse, navigate to the CD-ROM drive, and select 
setup.

4. Click OK; the New Installation dialog is displayed.
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5. The Destination folder group box displays the amount of current disk space, the 
amount of disk space required for the application, and the directory into which the 
application will be installed. If you wish to install the application into a different 
directory, click Browse to choose the directory.

6. Click the Add icon option to run the ChemiSoft application from your desktop.

7. The ChemiSoft icon is added to the Micromeritics folder by default; if you prefer a 
different folder, click the down arrow and choose the desired folder.

8. Click Next, the Analyzer Configuration dialog is displayed.

9. Ensure that 1 is selected in the Step 1 group box.

10. In the Step 2 group box, enter the serial number of the analyzer, then choose from the 
drop-down list the model number of the ChemiSorb that you have.

11. Click Next to complete installation; the Installation complete dialog box containing 
the Readme file is displayed.

12. Use the scroll bar if you wish to read the contents of the file, then click Finish to close 
the dialog box.

13. Do not remove the ChemiSoft program CD. The CD must remain in the drive when 
connecting the USB cable (refer to the next procedure). 
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Installing the Furnace Controller

Connecting the USB Cable

1. Connect one end of the USB cable to the USB port on the controller, and the other end 
to the USB port on the computer. 

• Windows XP systems: the Found New Hardware Wizard is displayed, prompting 
you through the process.

• Windows 2000 systems: the driver is loaded automatically.

2. Remove the CD containing the ChemiSoft program and store in a secure location.

Selecting the Input Power

All units leave the factory set for 120 VAC and with the line fuse removed. The correct 
setting of the universal power entrance must be checked and the appropriate fuse installed 
before the furnace controller can be operated. The furnace controller operates with 100, 
120, 200, or 240 VAC at 50 or 60 Hz. Voltage selection and fusing are made at the power 
connector, which is located on the rear panel of the unit.

1. Place the controller on the tabletop next to the analyzer with the rear panel facing 
outward.

2. Ensure that the power cord is disconnected from the controller.

3. Check the voltage setting on the cover of the power entrance, then open the cover and 
remove the fuse block.

Do not disconnect the USB cable from the furnace controller while the ChemiSoft 
program is operating. Doing so will cause the program and any operation in 
progress to terminate.

The power cord should be disconnected from the controller before opening the 
cover on the input power connector. Failure to disconnect the power cord could 
result in electrical shock.

If the voltage setting is incorrect, you will find instructions in the next step for 
selecting the correct voltage.
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a. Using a pointed object, pop the cover open. 

b. The cover is hinged and cannot be removed; grasp the upper side with your 
fingers and swing it downward.

c. Remove the fuse block; you may have to use needle-nose pliers to grasp the fuse 
block.

4. Advance to Step 5 if the line voltage setting is correct. If the setting is incorrect, 
perform the following steps before proceeding:

a. Using needle-nose pliers, grasp the edge of the voltage selector card and pull it 
straight out of the power connector housing.

Swing the cover 
downward; the 
cover is hinged.

Fuse block

Grasp the card 
here and pull 
straight out of the 
housing.
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b. Orient the voltage selector card so that the desired voltage is indicated at the 
bottom. Orient the indicator pin so that it points upward.

c. Insert the voltage selector card into the power connector housing with the edge 
containing the desired voltage first, and with the printed side toward the power 
connector.

5. Fuse the input power line according to local safety practices. The input power 
connector can be used with either a single-fuse arrangement (100-120 VAC) or a 
double-fuse arrangement (200-240 VAC).

Insert the appropriate fuse(s) for the input power source. Refer to the chart below for 
the appropriate fuse rating.

Power Source                          Fuse                            
100-120 VAC 5.0 Amp (slow-blow) Type 3AG
200-240 VAC 2.0 Amp (slow-blow) 5 x 20 mm

Indicator Pin

Voltage

Voltage Selector Card

Printed Side

The fuses used in the furnace controller must be identical in type and rating to that 
specified. Use of other fuses could result in electrical shock and/or damage to the 
unit.
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6. Insert the fuse block into the input power connector. The arrangement shown here is 
for a single fuse.

• If the single-fuse arrangement is desired, the fuse block is positioned so that the side 
with the single-fuse slot and the jumper bar is away from the cover.

• If the double-fuse arrangement is desired, the fuse block is positioned so that the 
side with the double-fuse slots is away from the cover.

7. Snap the fuse block into place.

8. Close the cover. Once the fuse block and cover are in place, the position of the 
indicator pin shows the input power selected.

9. Plug the controller power cord into an appropriate power source.

Programming the Controller

Program the Controller following the instructions provided in Chapter 5 of the 
Installation and Operation Handbook (included with your Controller).

Single Fuse

Double-Fuse slots

Cover

When using the double-fuse arrangement, the fuse block will not snap into place. 
Simply position the fuse block properly. When you close the cover, the fuse block 
will seat properly.
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Installing the Furnace

The furnace is installed on two metal supports (posts); one located on the underside of the 
top panel and one directly below on the shelf portion of the analyzer.

1. Position the furnace underneath the top support, aligning the support with the cavity in 
the furnace. Push the furnace upward until it stops. 

2. Then lower the furnace down onto the bottom support. Make sure the furnace is secure 
on both supports. 

3. Connect the furnace power cord to the Furnace Power connector on the controller, 
then connect the other end to the furnace.

Connecting the Detector Cable

Connect one end of the detector cable to the Detector connector on the controller, and the 
other end to the connector on the analyzer labeled Detector Signal Out.

Furnace 
Power

Furnace Thermocouple
(2 prongs)

Sample Thermocouple
(2 slots)

USB Port

Detector 
Connector
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Attaching the Thermocouples

1. Attach one end of the Furnace thermocouple cable (with the two slots) to the Furnace 
thermocouple connector on the controller, and the other end to the connector on the 
side of the furnace.

2. Attach the pronged end of the Sample thermocouple cable to the Sample 
thermocouple connector on the controller, and the slotted end to the sample 
thermocouple.

Thermocouple 
Connector
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Using the Setup Program for Other Functions

After initial installation of the ChemiSoft program, the application setup program is also 
used to:

• Upgrade software
• Move an analyzer from one computer to another one
• Remove an analyzer from the computer on which it is installed
• Uninstall the ChemiSoft program

To start the application setup program.

1. Ensure that the ChemiSoft program is not operating.

2. Insert the CD into your CD-Rom drive.

3. Select Start from the Status bar, then Run from the Start menu.

4. Enter the drive designator of the CD-ROM drive, followed by setup. For 
example:e:setup

Alternatively you may click Browse, navigate to the CD-ROM drive, and select 
setup.

5. Click OK; the Setup Welcome screen showing the options available is displayed.

6. Choose the desired option.
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Reinstalling the Software

When you install a software upgrade the system installs all of the application files that do 
not already exist on the computer. There are three types of subsequent installations:

• A later version than the version installed on the computer
• the same version as the version installed on the computer
• an earlier version than the version installed on the computer.

The setup program automatically detects which type of installation applies and 
customizes the selection in the Setup dialog accordingly.

1. Start the Setup program. Choose the software option; remember, only the applicable 
option will display:

• Upgrade software to version (number) from version (number)
• Reinstall software version (number)
• Downgrade software to version (number) from version (number)

2. Click Start file installation; the application installs the software and redisplays the 
setup Welcome dialog.

3. Click Exit to close the dialog.
2-10                                                    May 04



ChemiSoft TPx Operator’s Manual Using the Setup Program for Other Functions
Moving an Analyzer from One Computer to Another Computer

You can move an analyzer, along with its status files, from one computer (Source PC) to 
another computer (Destination PC).

1. Install the analysis program on the destination computer. Refer to Installing the 
Software earlier in this chapter. Be sure to select 0 as the number of instruments; all 
related instrument information will be transferred in the Move operation.

If the analysis program is already installed on the destination computer, proceed to 
Step 2.

2. Start the application setup program on the source computer. Refer to Using the Setup 
Program for Other functions earlier in this chapter.

3. In the Setup dialog, select Move an analyzer from one PC to another PC, then click 
Next; the Move analyzer operation dialog is displayed.

This operation does not move sample or parameter files. To move these files, use a 
file management program such as Explorer or a backup/restore utility.
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4. Select Source PC, then click Next; the following dialog is displayed.

5. In the Step 1 group box, the current analyzer should display in the field of the drop-
down list.

6. In the Step 2 group box, choose a location in which the moved files will be stored. If 
possible, choose a floppy drive or a shared network drive. If this is not possible, select 
a local folder. After the files are placed here, use a folder transfer utility to copy this 
folder from the Source PC to the Destination PC.

7. Click Finish; the files are moved and the setup Welcome screen is displayed.

8. Remove the CD from the Source computer and insert it into the appropriate drive on 
the Destination computer.

9. Start the application setup program on the Destination computer.

10. In the Setup dialog, select Move an analyzer from one PC to another PC; the Move 
analyzer operation dialog is displayed (shown on previous page).
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11. Select Destination PC, then click Next; the following dialog is displayed.

12. In the Step 1 group box, enter the serial number of the analyzer being moved.

13. In the Step 2 group box, click Browse and choose the location of the moved files. 

14. Click Finish; the files are moved to the Destination computer and the setup Welcome 
dialog is displayed.

15. Click Exit to close the Welcome dialog.
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Removing an Analyzer

You can remove an analyzer from the computer as follows. When you remove an 
analyzer, the status files are removed as well.

1. Start the application setup program. Refer to Using the Setup Program for Other 
functions earlier in this chapter.

2. From the Setup dialog, select Remove an analyzer, then click Next; the Remove an 
analyzer dialog is displayed.

3. The serial number of the analyzer should display in the drop-down list.

4. Click Remove; the analyzer is removed and the Welcome screen is again displayed.

5. Click Exit to close the Welcome dialog.
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Uninstalling the Software

When you uninstall the ChemiSoft program, the application removes the ChemiSoft 
program; it does not remove data files. Perform the following steps to uninstall the 
program:

1. Start the  application setup program. Refer to Using the Setup Program for Other 
functions earlier in this chapter.

2. From the Setup dialog, select Uninstall, then click Next; the Uninstall ChemiSoft TPx 
dialog is displayed.

3. Click Uninstall; the Select Uninstall Method dialog is displayed.

4. Choose one of the following:

• Automatic: the system uninstalls the ChemiSoft program automatically 
• Custom: displays a dialog allowing you to choose the items you wish to uninstall

5. Click Next; the Perform Uninstall dialog is displayed. Click Finish to complete the 
uninstall operation.
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3.  USER INTERFACE

This chapter provides instructions for using the software, as well as the menu structure of 
the ChemiSoft program. It also contains a brief description of the front panel display on 
the Controller. Refer to Chapter 2 of the Controller Installation and Operation Handbook 
for a more detailed description.  

ChemiSoft Software

The ChemiSoft program operates in the Windows environment and requires familiarity 
with standard Windows operations such as using the mouse, menus, and dialog boxes. 
This manual provides brief instructions for standard operations; however, you may need 
to refer to your Windows documentation or the Windows help system to clarify functions 
which are specific to Windows. Since most Windows operators use a mouse, this manual 
is written for mouse-driven operations. 

Shortcut keys

Shortcut keys may be used instead of, or in addition to, a mouse. With the main menu 
displayed, simply press the shortcut key(s) for the function desired. For example, if you 
wish to open a Sample Information file, press F2 and the Open Sample Information 
dialog box is displayed. You may also access any function that contains an underlined 
letter by pressing Alt plus the underlined letter. For example, to access the File menu, 
simply press Alt, then F.

Table 3-1 lists the shortcut key(s) available for operating the ChemiSoft program. 

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus) are available for  
onscreen graphs, tabular reports, and for use in the Peak Editor. These menus are 
accessed by clicking in the graph or table area and clicking the right mouse button. For 
example, right-click in a column of an onscreen report and the following menu is 
displayed.
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Table 3-1. Shortcut Keys

Key(s) Function

F1 Access Help 

F2 Open a sample information file

F3 Open an analysis conditions file

F4 Open a report options file

F6 Tile windows

F7 Cascade windows

F8 Start report

F9 Close all open reports

Alt + F4 Exit the ChemiSoft program

Shift + F2 List sample information files

Shift + F3 List analysis conditions files

Shift + F4 List report options files

Shift + F9 Displays the shortcut menu for onscreen reports

a
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Dialog Boxes and Subdialog Boxes

Dialog boxes are displayed when an item followed by an ellipsis (...) is selected. 
Subdialog boxes are displayed when a push button on a dialog box is selected. 

Both types of boxes may contain one or more of the following:

Data entry field These fields may be either numeric (numbers only) or 
alphanumeric (numbers, letters, or printable characters). 
If you make an invalid entry in either of these fields, an 
error message occurs.

Push Button A push button is used to display subdialog boxes in 
which to edit, enter, or specify additional information 
about the subject matter. For example, click Dates on 
the Open Sample Information dialog to display a 
subdialog enabling you to specify dates in which to 
display sample files (explained later in this chapter).

Push buttons are also used to invoke an action; for 
example, click OK on the Select Dates dialog to save the 
changes and close the dialog, or click Cancel to discard 
changes and close the dialog.
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Radio Button Radio buttons are contained within a group box. These 
buttons are used to select options; you may choose only 
one item.

Check Boxes Check boxes also are used to select options. You may 
select as many items as you wish.

Drop-down lists A drop-down list is indicated by a down arrow to the 
right of the field. Drop-down lists contain a list of 
options from which you may choose one.

Information Bar Some dialog boxes contain information pertinent to the 
selected field in an information bar across the bottom of 
the dialog. For example, a range is shown for fields in 
which numeric entries are required.

Radio 
button

Check box

Down Arrow

Information Bar
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Selecting Files

Sample information is stored in files and saved under file names. Certain dialog boxes 
contain a Files list box which displays a list of files available for that particular operation. 
For example, the Open Sample Information dialog box:

When opening sample information files, the next automatically sequenced file number 
appears in the File name field. For parameter files, a wildcard character with the default 
extension for the type of file you are opening appears in the File name field. Simply 
select the desired file, then click OK to open the file. Alternatively, you can double-click 
on the desired file.

You may limit the list of files displayed in the Files list box by choosing one (or more) of 
the following:

• Use wildcard characters in the path name you enter in the File name field. Wildcard 
characters such as * and ? can be used to filter file names. For example, you could 
filter a list  to display files beginning with P by entering P*.smp (or other 
appropriate extension) in the File name field.

• Enter a range of dates. Click Dates; the Select Dates dialog is displayed.

Select the Show Date Range radio button. This enables the From and To fields so 
that you may enter a beginning and ending date. Alternatively, you may double-
click in each field to display a calendar from which to choose a date. The range of 
dates remains the default until you change the dates or select Show All Dates.
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For convenience in choosing dates, the following function keys are available when 
the From or To field is selected:

F2 Clears the field
F3 Inserts the current date
F4 Displays a calendar from which to select a date

• Select a file status from the Status drop-down list. 

Table 3-2. File Status and Description

You may change the date format by using the International Date Format function 
on the Windows Control Panel.

Status Description

All All sample information files in the specified directory and within 
the specified range of dates

Analyzing Sample information files that are currently being used in an 
analysis.

Complete Sample information files that were used in an analysis that has 
been completed.

No Analysis Sample information files that have not been used in an analysis.
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File Name Conventions

For sample information and report options files, a wildcard character (*) and a default 
extension display. 

The following table shows the file name extensions for the ChemiSoft program.

Table 3-3. Default File Name Extensions

File Type Extension

Sample Information SMP

Report Options RPO

Analysis Conditions ANC

Export to disk (ASCII) EXP

Report to disk RPT

List to disk LST

The following types are available for reports saved from the Report window

Report REP

Spreadsheet XLS

ASCII TXT
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Menu Structure

All functions for the ChemiSoft program are located on menus which are accessed from 
the Menu bar. Each menu contains commands, and in some cases a submenu. A submenu 
is indicated when the command is followed by an arrow. 

File The options on the File menu enable you to create and 
manage sample and parameter files. (Chapter 5)

Reports Enables you to generate and close reports, and use the 
Peak Editor. (Chapter 6)

Options Allows you to choose sample editing mode, specify your 
system configuration, select data presentation formats, 
and specify a location for predefined parameter files. 
(Chapter 7)

Windows Enables you to arrange the windows and icons on your 
screen. It also displays the names of all open windows. 
(this chapter)

Help Displays information about the ChemiSoft program. (this 
chapter)
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Windows Menu

Help Menu

Tile Resizes all open windows and arranges them side by 
side. 

Cascade Resizes all open windows and arranges them in a stacked 
fashion. The active window is positioned on top of the 
stack. Each window’s title remains visible, making it 
easy to select other windows.

Arrange icons Arranges all minimized icons in an orderly manner. 

Open Files Displays all currently open files. The active file is 
preceded with a check mark.

Help Lists help topics for the ChemiSoft program.

About Displays information about the ChemiSoft program
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Controller Display 

Certain functions on the controller are used to enter parameters for your analysis. This 
section provides a brief description of the controls on the front panel of the controller. 
Refer to the Installation and Operation Handbook for a more detailed description.

OP1 Furnace output; blinks while the furnace is heating 
during a dwell step

OP2
SP2
REM

Not used with the ChemiSoft program

Auto/Man button Enables you to toggle between Automatic and Manual 
mode. When in Automatic mode, Auto is illuminated 
and when in Manual mode, Man is illuminated.

Run/Hold button Press the button once; Run is illuminated. You should 
use this mode when you start the analysis. If you press 
this button twice, the controller will be put on Hold. 
Press the button again to restart, or press and hold for 
two seconds to reset the controller.

Page button Press to select a new list of parameters

Scroll button Press to select a new parameter in a list

Down button Press to decrease the set point value

Furnace thermocouple 
temperature

Furnace set point

Run/Hold buttonAuto/Man button

Up
button

Scroll
button

Down
button

Page
button

Furnace output
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Up button Press to increase the set point value

Upper readout Displays the temperature of the furnace thermocouple

Lower readout Displays the furnace set point
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4.  GENERAL OPERATING PROCEDURES

This chapter provides brief step-by-step procedures for operating the ChemiSoft program 
with your ChemiSorb analyzer.  

Specifying Sample Defaults

Sample information files include the information required to perform analyses and collect 
data. The ChemiSoft program automatically generates sample information file names and 
assigns default values. The program is shipped with default values, however, they may be 
unsuitable for your type of material. The Sample Defaults command on the Options menu 
enables you to specify values specific to your type of analysis. You can always edit the 
values when the sample file is created.

The sample information presentation can be presented in a basic, advanced, or restricted 
format. Sample defaults can be specified in the basic and advanced formats only; you 
cannot specify sample defaults using the restricted format. The sample defaults you 
specify for the basic format display for the restricted format.

If desired, you can define parameter files before entering sample defaults (refer to 
Defining Parameter Files in this chapter).

Advanced Format

1. Select Sample defaults from the Options menu; the Sample Defaults dialog is 
displayed. 
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2. In the Sequence field, specify a default string. This is the number that is incrementally 
sequenced and displays in the File name field when you select File, Open, Sample 
information.

3. In the field on the right of the Sample line, enter a format for the identification. Be 
sure to include the $ symbol if you want the sample file number included as part of the 
identification.

4. Edit the Operator and Submitter lines as desired. Or, you may have either (or both) 
of these limes omitted entirely by selecting Omit. 

5. In the Mass field, enter a value to represent the amount of sample you typically use in 
your analysis. This value can be edited when you create your file, or after the analysis.

6. Click the Analysis Conditions tab and enter appropriate information for your most 
commonly analyzed sample material. Remember, you can always edit this information 
in the sample file when it is created.

7. Click the Report Options tab and choose the desired reports. Again, this selection can 
be edited in the sample file when it is created.

8. Click Save, then Close.

You can also edit the word Sample that displays for the prompt in the sample file. 
For example, you may prefer to use Test or Material to display as the prompt.

The default values you specify for Analysis conditions and Report options display 
as the defaults for newly created parameter files.
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Basic Format

The defaults you specify for this format also display as the defaults for sample files 
created using the Restricted format.

1. Select Sample defaults from the Options menu; the Basic Sample Information 
Defaults dialog is displayed. 

2. In the Sequence field, specify a default string. This is the number that is incrementally 
sequenced and displays in the File name field when you select File, Open, Sample 
information.

3. In the field on the right of the Sample line, enter a format for the identification. Be 
sure to include the $ symbol if you want the sample file number included as part of the 
identification.

4. In the Mass field, enter a value to represent the amount of sample you typically use in 
your analysis. This value can be edited when you create your file, or after the analysis.

5. Select the down arrow to the right of the Analysis Conditions field  to choose a 
default parameter file. The steps included in this file will display in the window below 
the field. You may view the details of these steps by selecting View .

6. Select the down arrow to the right of the Report Options field to choose a default 
parameter file. The reports chosen (preceded with a check mark) for the selected file 
will display in the list of reports below the field. Edit selections if desired.

7. Click Save, then Close.

You can also edit the word Sample that displays for the prompt in the sample file. 
For example, you may prefer to use Test or Material to display as the prompt.
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Defining Parameter Files

Analysis Conditions and Report Options files can exist as part of the sample information 
file or as an individual parameter file. Having these files exist independently allows you 
to use them over and over again. For example; unless you expect each analysis to use 
unique sets of analysis conditions and report options, you can create a group of standard 
parameter files containing the values you expect to use most frequently. The contents of 
these files can be copied and imported into multiple sample information files, providing 
speed and consistency. After these values have been copied and imported into the sample 
information file, they can be edited in any way that you wish. The original parameter file 
remains intact and ready for its next use.

Several predefined parameter files (located in the PARAMS directory) are included with 
the ChemiSoft program. These files are examples only and the gases specified in these 
files may not match the gases connected to your analyzer. If you wish to use one of these 
files as a starting point, simply create a new file and select Replace. A dialog is displayed 
so that you can select an existing parameter file. After the values from this file are copied 
into the current file, you can edit them as desired. 

Make sure you save these files to the directory specified as the Parameter File directory 
(refer to Chapter 8 for additional information). If you do not save these files to the 
parameter file directory, they will not display in the drop-down lists on the Basic and 
Restricted sample file editors.

Parameter files can also be created from the Advanced Sample information window using 
the Save as function on the File menu. For example, you have a sample information file 
open that contains exactly the analysis conditions that you use often in your analyses. 
Simply select Save As, Analysis Conditions from the File menu and enter a name for the 
file. After this file has been created, it can be copied into as many sample files as you wish 
using the Replace push button on the sample file editor. 

This makes it possible for one person (such as a laboratory manager) to create 
standard parameter sets that can be used easily by others (such as laboratory 
technicians).
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Analysis Conditions

Analysis conditions specify data to guide an analysis.

1. Select Open, Analysis conditions from the File menu; the Open Analysis Conditions 
File dialog is displayed.

2. Enter a name for the file (up to eight characters) in the File name field.

3. Click OK, then Yes to create the file; the Analysis Conditions dialog is displayed.

4. Enter a description in the Analysis Conditions field. Use a description that will help 
you identify the conditions specified. You can use up to 42 characters.

5. Click Insert to insert steps for the analysis. Each step you insert has an associated 
dialog, which contains the parameters for that step. You can insert up to 1000 steps in 
the Synopsis.

6. Choose Experiment (or Loop Calibration), then click OK; an associated dialog is 
displayed.

7. Define the experiment (or calibration) as desired, then click OK; the experiment (or 
calibration) will display in the Synopsis window; details of each step you specify will 
display in the Step Detail group box.

8. Click Save, then Close.
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Report Options

1. Select Open, Report options from the File menu; the Open Report Options File dialog 
is displayed.

2. Enter a name for the file (up to eight characters) in the File name field.

3. Click OK, then Yes to create the file; the Report Options dialog is displayed.

4. Enter a description (up to 42 characters) in the Report Options field. Use a 
description that will help you identify the types of reports selected.

5. Select Show report title and enter the title you wish to appear at the top of the report. 
Or deselect this option if you do not wish to have a title on your report.

6. Select (or deselect) desired reports by: highlight the report and double-click. 
Alternatively, you can press the Spacebar after the report is highlighted. A report is 
selected when it is preceded with a check mark

7. Click Edit to edit report details if desired.

8. Click Save, then Close.

If your company logo exists as a bitmap (bmp) or enhanced metafile (emf) and you 
would like to have it display in the report header, select Show graphic. Then click 
Browse to select the file. Use the Width and Height fields to specify the size.
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Creating Sample Information Files

A sample information file consists of information groups which, collectively, identify the 
sample, detail steps for the analysis, and specify the data reduction.

A sample file may be created in three different formats:

• Advanced
Provides complete access to all parts of the sample file, allowing you to quickly edit 
parameters as required.

• Basic
Presents a single window in which you select predefined parameter files for your 
analysis. You can also switch to the Advanced format to edit parameters if desired.

• Restricted
Presents a single window in which you select predefined parameter files (identical to 
the Basic format). You cannot, however, switch to the Advanced format for editing 
purposes. This format is password-protected.

Select Option presentation from the Options menu to choose the format you wish to use.

Sample information files can be created in advance of the analysis or they can be created 
at the time of analysis, whichever is convenient for you.
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Advanced Format

The Advanced format presents the sample information editor in a manner similar to that 
of an index card file. Simply click on the appropriate tab and enter the required 
information.

1. Select Open, Sample information from the File menu; the Open Sample Information 
dialog is displayed.

2. Accept the next sequenced file number or enter a new name in the File name field; 
you can use up to eight characters.

3. Click OK, then Yes to create the file; the Advanced sample dialog is displayed.

4. In the Sample field, enter a description or add to the existing one. You can use up to 
42 characters.

5. Edit the Operator and Submitter fields if desired. You can use up to 40 characters in 
these fields. 

6. Use the Comments window to enter any comments about the sample or analysis 
conditions. Anything you enter in this field will display in the header of some reports.

7. Click the Analysis Conditions tab and define analysis conditions. Refer to Defining 
Parameter Files if you need assistance in completing this dialog. 

The values contained on the dialog are those specified in Sample Defaults. You can 
accept these defaults to create your file or continue with the subsequent steps to 
edit them.
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8. Click the Report Options tab and specify desired report options. Refer to Defining 
Parameter Files if you need assistance in completing this dialog. 

9. Click Save, then Close.

Basic Format

The Basic format allows you to create a sample file by choosing from predefined 
parameter files. The values in these files can be edited when needed by switching to the 
Advanced format.

1. Select Open, Sample information from the File menu; the Open Sample Information 
dialog is displayed.

2. Accept the next sequenced file number or enter a new name in the File name field; 
you can use up to eight characters.

3. Click OK, then Yes to create the file; the Basic Sample Information dialog is 
displayed.

4. In the Sample field, enter a description or add to the existing one. You can use up to 
42 characters.

5. Click the down arrow to the right of the Analysis Conditions field and choose the file 
containing the appropriate analysis conditions. After you choose a file, its steps are 
displayed in the window below the Analysis Conditions field. You can view the 
details of the steps by highlighting the step and clicking View.

The values contained on the dialog are those specified in Sample Defaults. You can 
accept these defaults to create your file or continue with the subsequent steps to 
edit them.
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6. Click the down arrow to the right of the Report Options field and choose an 
appropriate file. You can select additional (or deselect current) reports by double-
clicking on the report(s).

7. Click Save, then Close.

Restricted Format

Sample information files are created using the Restricted format in the same manner as 
with the Basic format. The name displayed in the title bar even displays as Basic Sample 
Information. However, the dialog for this format does not include the Advanced push 
button allowing you to switch to the Advanced format to edit parameters. Certain menu 
functions are also disabled with the Restricted format. 

An Advanced push button 
is not included with the 
Restricted format.
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Performing an Analysis

Loading the Sample

1. Install the furnace on the analyzer (refer to Chapter 2 for instructions); open it fully.

2. Load the sample tube (containing the prepared sample) onto the sample port of the 
analyzer.

3. Carefully close the furnace around the sample tube and latch the furnace.

4. Insert the sample thermocouple into the desired position. You can insert the 
thermocouple inside the tube or on the outside of the tube.  

The best accuracy is obtained when the thermocouple is placed inside the sample 
tube;  adjust the thermocouple so that the end is located in the sample or just above it. 

If the thermocouple is placed outside the sample tube, make sure it is clamped against 
the sample tube (using the clamp provided in the accessories kit). Orient the 
thermocouple so that its tip is at the same level as the sample and that it does not 
extend below the point where the sample tube begins to taper.

Appendix F contains a tutorial for a typical multipoint BET analysis, including 
creating the sample file; performing the analysis; and editing peaks.

Insert the thermocouple 
here if using outside of 
the tube.

Insert the 
thermocouple here if 
using inside of the 
tube.

Clamp

Sample Tube

Thermocouple
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Programming the Eurotherm Controller

The Eurotherm controller must be idle before you can enter analysis parameters. The idle 
state is indicated when the Run/Hold lights are not illuminated. If either light is 
illuminated or flashing, press and hold the Run/Hold button for three seconds. 

Since the controller will reset after a very brief idle period, it is best to have all 
information available so you can quickly complete the entries. Make a copy of the 
Worksheet provided in Appendix A, record the values, then enter them into the controller.

1. Press  until ProG LiSt is displayed.

2. Press  until SEG.n is displayed; 1 defaults on line 2 of the display.

3. Press  to display tYPE.

4. Press  or  to select the type of segment; the ChemiSoft program uses only the 
following segments:

rmP.r Ramp to a new setpoint at a set rate 

dwEll Dwell for a set time

5. Press  ;  SEG.n is displayed with 2 (representing the second segment) displayed 
on line 2.

6. Press  or  until End is displayed.

Quartz sample tubes may be used up to 1100 ºC. Borosilicate sample tubes must 
not be used above 500 ºC.

When you see this symbol while performing the steps in the following table, refer 
to the appropriate column of your Controller Worksheet for the value. 

If you choose.... Perform the following steps....

rmP.r Press  until tGt is displayed.

Press  or  to set the target setpoint (ºC).  

Press  to display rAtE.

Press  or  to set the ramp rate (ºC/min).  

dwEll Press  until dur is displayed.

Press  or  to set the dwell time (min).  
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7. Press until End.t is displayed on the top line and dWEll on the bottom line.

8. Press  to choose dWell. This holds the furnace at the previously attained 
temperature.

9. Press  until ProG LiSt is displayed.

10. Press  to return to the Home screen (the Home screen shows the current 
temperature on the top line and the current setpoint on the bottom line).

Starting the Analysis

1. Select Start analysis from the Unit menu; the Sample Analysis dialog is displayed 
with the Open Sample information dialog positioned on top.

2. Choose a file for your analysis (or accept the default to create a new one) and click 
OK; the Sample analysis dialog containing the parameters of the selected file (or the 
defaults) is displayed.

3. Review and verify analysis conditions and report options; edit if necessary.

4. Click Next; the second view of the analysis dialog is displayed.This view of the dialog 
displays the gases that are to be used in the analysis; ensure that appropriate gases are 
connected.

5. Click Next; this view of the dialog contains report output options. If you wish to have 
a report generated automatically after the analysis; select Report after Analysis and 
specify the destination.You can use the Start Report option on the Reports menu to 
generate reports if desired.
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6. Click Next;  this view of the dialog displays safety information.

7. Click Start; this view of the dialog, as well as subsequent dialogs, contains a Prompt 
section. Pay close attention to the information displayed at the Prompt and perform 
any requested action(s) accordingly. The information in this prompt enables you to 
interface manually with the analyzer to complete analysis.

8. After performing the task(s) listed, click Continue; this view of the analysis dialog 
instructs you to turn on the Eurotherm controller. 

Lists the task(s) 
required before 
continuing with 
analysis.

Shows how the 
analyzer should 
be set up.
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9. Press the Run/Hold button on the controller (the Run light illuminates), then click 
Continue.

10. Observe the Run light on the controller; when it begins to flash, the End step of the 
current step has been reached.

11. Press and hold the Run/Hold button for three seconds to return to its original 
programming mode; the Run light will turn off.

12. Continue to perform the task(s) as displayed, clicking Continue after each one.

Each time your analysis reaches a Temperature Ramp, program the Eurotherm 
controller (refer to Programming the Eurotherm Controller if you need assistance). 
Programming for each temperature ramp individually provides the best 
synchronization between the analysis conditions and the Eurotherm operation. 
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Generating a List

You can generate a list of the following information on one or more sample or parameter 
files:

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status (sample information files)

Perform the following steps to generate a list:

1. Select List from the File menu.

2. Select the type of file on which you wish information; a dialog similar to the one 
shown below is displayed.

3. From the Files list box, choose the desired file(s). If you wish to include all files in the 
list, leave all files deselected.

4. At the Destination field, click on the down arrow and choose an output destination. If 
you choose File as the destination, enter a name in the File name field (or accept the 
default).

5. Click OK; a list for the requested file(s) is sent to the specified destination.

The Status drop-down 
list does not display on 
a parameter file list 
dialog.
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Exporting Data from a Sample Information File

Data from a sample information file can be exported in ASCII or Grams/32 format. 
ASCII data can then be imported into other applications, such as spreadsheets. Grams/32 
data can be imported into the Grams/32 program (a peak-editing program used with early 
versions of Micromeritics’ AutoChem software). Refer to Appendix D for a description 
of exported data.

Perform the following steps to export a sample information file:

1. Select Export from the File menu; the Export Sample File dialog is displayed.

2. From the Files list box, choose the file(s) you wish to export. You can choose multiple 
files by holding down  and clicking on the desired files.

3. From the Settings group box:

a. Choose whether you are exporting in ASCII or Grams/32 format.

b. Choose a destination for your exported file. If you choose File, enter a name in the 
File name field (or accept the default). If you choose Printer or Printer/Plotter, 
the Copies field is enabled allowing you to print up to 4 copies.

If you are exporting in Grams/32 format, you must choose File as the destination. 
Refer to Appendix D for additional information.
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4. Click OK; the Collected Data Export Options dialog is displayed.

5. Choose the experiments whose data you wish to export. Then select any other desired 
options. Refer to Chapter 5 for additional information on this dialog.

6. Click OK; data are exported to the specified destination.
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5.  FILE MENU

The File menu contains options that allow you to manage sample and parameter files.

Description

Listed below are brief descriptions of the File menu options. Detailed descriptions follow 
this section.

Open Opens an existing file or creates a new file. When you 
select this item, a drop-down menu is displayed 
containing three types of files: sample information, 
analysis conditions, and report options. Page 5-3.

Save Saves the file in the active window. Page 5-44.

Save As Allows you to save the file that is in the active window 
under a different name. It also can be used to save a 
subset of a sample file as an independent parameter file. 
Page 5-44.

Save All Saves all open files. Page 5-44.

Close Closes the file in the active window. Page 5-45.

Close All Closes all open files. Page 5-45.

Print Prints details of the selected file(s). Page 5-46.
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List Generates a list of certain information for the selected 
sample file(s) or parameter file(s). Page 5-47.

Import MS Signal Allows you to import data collected on a Pfeiffer Vacuum 
(formerly Balzers) mass spectrometer which uses  the 
Quadstar software. Page 5-49.

Export Exports a sample file in ASCII format or in a format 
compatible with the Grams/32 application (a peak editing 
program used previously with the AutoChem analyzer). 
Page 5-51.

Exit Exits the ChemiSorb program. Page 5-54.
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Open

Select Open to create a new sample or parameter file or to edit an existing one. Regardless 
of which file type you select, a dialog box similar to the one shown below is displayed. 

File name For sample information files, this field contains the next 
sequenced file name generated by the system. 

For parameter files (analysis conditions and report 
options), the file name displayed includes the wild card 
(*) and the default extension as follows:

     *.ANC for analysis conditions
    *.RPO for report options

If you are creating a new file, enter a name in the File 
name field. You can use up to eight characters. 
If you are editing an existing file, select a file from the 
list.

Status This drop-down list allows you to choose the types of 
files to display in the Files window.

All Displays all sample information files in the specified 
directory and within the range of dates selected in the 
Dates dialog.

Analyzing Displays sample information files that are currently 
being used for analysis.
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Complete Displays sample information files that have been used in 
an analysis.

No Analysis Displays sample information file that have been prepared 
but not yet used in an analysis.

Dates Displays the Select Dates dialog.

This dialog enables you to specify a date range for the 
files you wish to display in the Files window.

Show All Dates Displays all sample files of the type selected in the 
Status list, in the current directory.

Show Date Range Enables the From and To fields allowing you to specify 
a range of dates in which to display the sample files. Use 
one of the following methods to select date ranges:

• Highlight the field and enter a date, simply by typing 
the date; you do not have to enter a slash (/).

• Double-click in the selected field to display a calendar 
from which you can select a date.

For convenience, the following shortcut keys are 
available to assist you:

F2 Clears the field
F3 Inserts the current date
F4 Displays a calendar from which to select a date

Files This window displays the files available in the selected 
directory for the chosen status within the selected date 
range.
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Sample Information

Sample Information files contain information used to control the analysis, as well as 
collected data. A sample information file consists of:

• Sample information
• Analysis conditions
• Report options
• Collected data (appears after analysis is complete)

Portions of the sample file can also exist as parameter files separate from the sample 
information file itself. These parameter files contain frequently used analysis conditions 
and report options that can be conveniently loaded into a new sample information file.

Sample information files are presented in three different formats, Basic, Advanced, and 
Restricted. You can select any one of these formats as your default. A convenient toggle 
button makes it easy to switch between Basic and Advanced formats, regardless of which 
is selected as your default. The Restricted format does not allow switching to the 
Advanced format.

• Basic Format 
Presents the entire sample information file in a single dialog box. Basic format 
makes it easy to select previously created, standard parameter files from convenient 
drop-down lists.

• Advanced Format 
Presents all parts of the sample information file as a group of dialog boxes with 
index card-type tabs (although the Collected Data tab does not appear until after 
analysis). Clicking on each tab opens the associated dialog. Use this format to create 
customized sample information files. 

• Restricted Format 
Restricted presentation format is identical to Basic presentation format, except that 
you cannot switch to the Advanced presentation. Restricted presentation limits the 
operator’s ability to change analysis conditions and report options. 

Select Option presentation from the Options menu to specify your default format. 
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Basic Presentation

The Basic format displays all parameters of the sample information file on a single 
dialog. With the Basic format, you can quickly create a sample information file using 
predefined parameter files from the drop-down lists. 

Sample Contains the description of the current sample file.

If this is a new file, this field contains the description  
you specified in Sample defaults (see Chapter 8). You 
can enter a new description or add to the existing one if 
desired.

Range: 50 alphanumeric characters

Replace All This push button allows you to replace the values for all 
parameters of the current file with the values from an 
existing file. Simply click the push button, choose the 
desired file, and click OK. This does not import the file 
itself; only the values are copied and imported. The file 
remains intact.

Mass Enables you to enter the mass (weight) of the sample.
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Analysis Conditions Displays the name of the current Analysis Conditions 
file.

If this is a new file, this field contains the name of the 
file you specified as the default. Click the down arrow to 
the right of the field to choose a different file. This list 
includes Analysis Conditions files supplied with the 
analysis program as well as those you create and save to 
the directory specified as the Parameter Files directory 
(Chapter 8). If new files are not saved to the specified 
directory, they are not included in the list.

This list is disabled for files which have been used for an 
analysis.

View Allows you to view details about the currently selected 
step in the analysis conditions set.

Report Options Displays the name of the current Report Options file.

If this is a new file, this field contains the Report options 
file you specified as the default. Click the down arrow to 
the right of the field to choose a different file. This list 
includes Report Options files supplied with the analysis 
program as well as those you create and save to the 
directory specified as the Parameter Files directory 
(Chapter 8). If new files are not saved to the specified 
directory, they are not included in the list.

Reports List Box Displays a list of available reports. The checked reports 
are the ones requested for the current Report options file.

If this is a new file, the checked reports are the ones you 
specified for the default(s). You can select (or deselect) 
reports by double-clicking on the desired report. 
Alternatively, you can highlight the report and press the 
Spacebar.

Save Saves the current file.

Close Closes the current file. If the file contains unsaved 
values, you are prompted to save before closing.

Advanced Switches the presentation format to the Advanced 
presentation. 
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Advanced Presentation

The Advanced format displays the sample information file in a manner similar to that of 
an index card file. Each parameter has its own tab and is accessed by clicking the tab. Or, 
you can use Next and Prev to move through the dialogs. This format allows you to create 
customized sample information files. 

The prompts for the Sample, Operator and Submitter fields may be customized by 
selecting Sample defaults from the Options menu. Refer to Chapter 8 for instructions on 
customizing these prompts. 

Sample Contains the description of the current sample file.

If this is a new file, this field contains the description  
you specified in Sample Defaults (see Chapter 8). You 
can enter a new description or add to the existing one if 
desired.

Range: 50 alphanumeric characters

Operator
Submitter

Displays the Operator and Submitter names (if specified) 
of the current sample file.

If this is a new file, these fields contain the names 
specified in Sample defaults. You can enter a different 
name in either (or both) field if desired. You can also 
edit the prompts for these fields or choose to have them 
omitted entirely (refer to Sample defaults in Chapter 8).

Range: 40 characters
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The Analysis Conditions and Report Options tabs of the Advanced presentation sample 
information file are described in subsequent sections.

Mass Allows you to enter the mass of the sample. 

Add Log Entry Displays a dialog box allowing you to enter pertinent 
information relating to the sample. Any information you 
enter here is printed as part of the Analysis Log report 
(select in Report Options).

Comments Use this field to enter any comments about the sample or 
the planned analysis conditions that you wish to note. 
Comments entered here are printed in the header of some 
reports.

Range: Up to 500 alphanumeric characters

Replace All This push button allows you to replace the values for all 
parameters of the current file with the values from an 
existing file. Simply click the push button, choose the 
desired file, and click OK. This does not import the file 
itself; only the values are copied and imported. The file 
remains intact.

Save Saves the current file.

Close Closes the current file. If the file contains unsaved 
values, you are prompted to save before closing.

Basic Switches the presentation format to the Basic 
presentation. 
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Restricted Presentation

A third format is provided to control access to some portions of the sample information 
file. Restricted format displays in the same manner as the Basic presentation format.

The Restricted presentation does not allow you to switch to the Advanced format. This 
format is also password-protected, preventing the operator from making changes to 
analysis conditions and report options sets. Chapter 8 provides additional information on 
this format.

Restricted presentation is ideal for laboratories in which standard analysis procedures are 
established by a lab manager, while one or more lab technicians actually perform the 
analyses. The lab manager can create independent analysis conditions and report options 
files containing standard sets of operating conditions, then the operator(s) can use 
Restricted mode for daily operations, selecting the standard parameter files from the 
drop-down lists.
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Analysis Conditions

Analysis conditions files specify each step in the analysis, including temperatures, 
pressures, and gases. You can create an Analysis Conditions file as an independent 
parameter file or as part of a sample information file. You can also save the analysis 
conditions portion of a sample information file as an analysis conditions file.

When creating parameter files to display in the drop-down list on the Basic and 
Restricted sample information dialogs, be sure to save them to the directory 
specified as the Parameter file directory (Chapter 8).

Analysis Conditions If you are opening an existing analysis conditions file, 
this field contains the description.

If you are creating an analysis conditions file, this field 
contains the description specified in Sample defaults. 
You can enter a new description or add to the existing 
one if desired. Use a description that will help you 
identify this set of analysis conditions in the future.

Range: 40 alphanumeric characters.

Replace Allows you to copy values from an existing file to the 
one you are creating. A dialog box is displayed allowing 
you to choose the desired file. You can then edit these 
values if desired; the file you copied them from will not 
be affected.
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Synopsis Displays a list of the steps the analyzer will follow 
during the analysis.

Steps within 
Experiment 1

An analysis is a complete characterization of the sample; in other words, it is all of 
the experiments and steps within the Synopsis. It may consist of up to 99 separate 
experiments, such as TPR or TPO. Each experiment may consist of up to 99 steps.

Insert Enables you to insert an experiment or a step within an 
experiment.

This dialog 
displays if you are 
inserting a new 
experiment.

This dialog 
displays if you are 
inserting a step 
within an 
experiment.
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Insert
(continued)

At some points in the sequence of steps, all steps are 
available. At other points, certain steps cannot be 
performed. For example, you cannot start a new 
experiment inside a Repeat loop. The steps that appear in 
the list box are those which are currently available.

Highlight the desired experiment or step, then click OK; 
a related dialog allowing you to specify instructions is 
displayed. The dialogs for each experiment and step are 
discussed in subsequent sections.

When you insert a step, it is inserted above the one you 
have highlighted in the Synopsis. 

You can easily move a step from one position in the list 
to another. Simply click on the step you wish to move, 
then use Ctrl +(Up Arrow) or  Ctrl + Down Arrow) 
to move the highlighted step. 

Delete Deletes the selected item from the synopsis list. If you 
click this button when an experiment is selected, the 
entire experiment (including all its steps) is deleted after 
a confirmation.

Edit Enables you to edit the selected experiment or step; an 
associated dialog is displayed. 

You can also edit a step or experiment during analysis. 
However, you must suspend the experiment before any 
editing can be accomplished; any temperature ramps will 
continue. The temperature ramps may be paused (if 
desired) using the furnace controller. You can edit only 
the steps or experiments following the current one; all 
completed steps will be disabled. After an analysis has 
been completed, Edit displays as View; steps may be 
viewed but not edited.

Clear Clears the list of experiments and steps for this Analysis 
Conditions dialog. A confirmation message is displayed.

Insert Method Allows you to insert the entire list of steps from another 
analysis conditions file. After you click this button, 
select an analysis conditions file from the list. All the 
steps in that file are inserted directly above the 
highlighted step. Inserted methods can be edited without 
altering the original analysis conditions file(s) from 
which they were copied.
May 04                                                      5-13 



Open ChemiSoft TPx Operator’s Manual
Insert Method
(continued)

For example, if you have three different standard sample 
preparation methods that you use under varying 
circumstances, create an analysis conditions file for each 
preparation method. Then use Insert Method to insert 
the appropriate preparation method in the analysis 
conditions file you create when you are ready to analyze 
a sample.

You can also create several analysis conditions files 
containing individual experiments, then use Insert 
Method to combine them into a comprehensive analysis 
comprised of these individual analyses.

Step Detail Displays information about the currently highlighted 
step in the Synopsis. The information displayed for each 
step is a summary of the information contained on that 
step’s dialog. 
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Insert Experiments

An analysis set is created by inserting a series of experiments in the sample file Synopsis. 
You can insert up to 99 experiments. There are two types of experiments that you can 
insert in an analysis conditions set. The following dialog is displayed when you choose to 
insert an experiment:

The first type is the customizable Experiment. You will insert into this Experiment the 
individual steps which control the reaction(s) in the analysis. When you insert an 
experiment, you specify the Initial Conditions, then insert individual steps. Each step can 
be customized in detail.

You can also perform a Loop Calibration if you have the Model 2750; the sequence of 
steps in the Loop Calibration cannot be altered. 

Model 2750 only
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Experiment

Inserts a basic experiment into the list of steps.

Experiment description Allows you to enter a description or identifier for this 
experiment. The description you enter in this field 
appears in the legend of the report.

Range: 40 alphanumeric characters

Type of analysis Select the type of analysis from the drop-down list.

Choices: Temperature-Programmed Oxidation

Temperature-Programmed Reduction
Temperature-Programmed Desorption
Physisorption Surface Area
Pulse Chemisorption
Other

It is important to select the correct experiment type because the type is referenced 
during some other operations. For example, a Pulse Chemisorption report can only 
be generated for those experiments specifying Pulse Chemisorption as the type.
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Active Metals Opens the Active Metals Table dialog, allowing you to 
specify the percent sample mass of the active metals in 
the sample (in the far right column), and the 
stoichiometry factor.

Enabled when you choose a Pulse Chemisorption 
experiment.

This table displays the defaults specified using the Active Metals Defaults option 
on the Options menu. After this sample file is created, this table becomes specific 
to the sample file. Therefore changes made in the current table do not affect 
default settings.

Insert Inserts a new row into the table; the row is inserted 
above the selected one.

Delete Deletes the selected row.

Clear Clears the table of all entries except one; one is required.
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Gas Flows Displays the Gas Flows dialog.

This dialog allows you to specify details for the carrier 
and injection gases, and valves

Gases The gases included in the drop-down lists for the Carrier 
and Injection gases are the ones specified in Gas 
Defaults on the Options menu.

Select None when you wish not to have gas flowing (the 
flow rate is ignored). 

When you start an analysis, you are prompted to verify 
that the selected gases are connected to the appropriate 
ports.

Carrier Gas After selecting the desired gas, enter a flow rate in the 
Rate field.

Injection Gas After selecting the desired gas, ensure that the value in 
the Active Concentration field is appropriate. The value 
for this field should be the percent of the gas mixture 
which is composed of the reactive gas versus an inert 
filler. The value that defaults in this field is the one 
specified in Gas Defaults on the Options menu. 

This value is used for pulse chemisorption data 
reduction.
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When inserting multiple experiments into the Synopsis, consider the following when 
selecting gases:

• Avoid placing incompatible gases in the analyzer in immediate sequence.

When you change the gas flowing into the analyzer, the new gas enters the analyzer 
while the previous gas is still present. 

You can “purge” the previous gas before starting to flow the new gas by selecting 
an inert gas for the initial conditions gas in an experiment step, or by inserting an 
extra Change gas flows step in which you flow an inert gas between the flows of 
incompatible gases. If you do so, you must also insert a Wait step specifying how 
long to flow the inert gas. You can specify a specific time period or select one of the 
other Wait step criteria. (Each of these step types is described later in this chapter.)

• Changes in the gas cause a brief disturbance of the flow rate.

This disturbance may be detected by the TCD and may be visible in the data (if data 
are being recorded when the gas flow is changed). Either disregard such 
disturbances in the data or stop recording before you change the gas flows, then 
insert a Wait for stable baseline step after the Change gas flows step. Resume 
recording after a stable baseline is detected. A suggested sequence of steps then 
might be as follows:

Start recording
Experiment steps as needed
Stop recording
Change gas flows
Wait for stable baseline
Start recording
Experiment steps as needed

Path Select These valves enable flow of the gas stream from the 
sample or from the septum and loop to the detector. 
Typically, this selection should be Sample. Use Bypass 
when performing a loop calibration.

Delay Serves to delay the arrival of desorbed gases at the 
detector system long enough for the flow rate to recover 
from the rapid desorption of adsorbed gases created 
when the cryogenic liquid is removed. Choose Long 
when performing physisorption analyses. For other 
operations, Short is sufficient. 
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Cold Trap Dewar Use the Installed option when using a Dewar of 
cryogenic liquid to trap water and/or condensable vapors 
to prevent them from reaching the TCD. This option is 
often useful for TPR analyses.

For other analyses, choose Removed.

Loop (2750 only) Choose the initial position for the loop valve. The Load 
position is recommended for the start of each analysis.

The loop is used for pulse chemisorption experiments.

Peaks Displays the Peak Detection/Integration dialog.

This dialog enables you to specify peak detection and 
integration criteria for the analysis After analysis, you 
can further control peak detection using the Peak Editor, 
described in Chapter 7. Refer to Appendix E for 
additional information on the fields of this dialog.

The TCD detects and records all deviations from 
baseline, but only those which satisfy the criteria 
established in this dialog are reported as peaks.

Zero the TCD signal when 
recording starts

Allows you to zero the TCD signal automatically the 
first time recording starts in an experiment. 
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Loop Calibration

Loop Calibration enables you to calibrate the gas injection loop (ChemiSorb 2750 only). 
This experiment verifies the exact volume of the loop for use in calculations on analyses in 
which the loop is used. Sample analysis data yield signal vs. temperature data and peak 
areas. Associating the sample information file with a loop calibration file makes it 
possible for the software to convert sample peak data to gas quantity values.

Invert the TCD signal Inverts the TCD signal. For example, if you expect to 
obtain only negative peaks, this option can be used to 
record the peaks in the positive direction.

Description Enter a description or identifier for this experiment. It is 
important to use a descriptive identifier here, in order to 
easily identify this data when displayed in sample 
reports.

Calibration Gases Allow you to select the carrier and loop gases to be used 
in this calibration. The gases available are those speci-
fied in Gas defaults on the Options menu.

Flow Rate Specify the flow rate for the carrier gas; typically, the 
default of 25 mL/min is appropriate.

Loop thermal equilibration 
delay

Allows you to specify the duration of the equilibration 
delay. This delay allows extra time for the instrument to 
stabilize thermally after the baseline has fully stabilized.

Injection Volume Enter the physical volume of gas you will inject from the 
syringe.
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Insert Experiment Step

After you have set up the initial conditions for your basic Experiment, the Analysis Con-
ditions dialog is again displayed showing the Experiment inserted. Clicking Insert now 
allows you to insert a step in the Experiment you just added to the Synopsis. You can 
insert steps in a wide variety of sequences. You can also use steps repetitively within the 
Experiment.

You cannot insert steps within a Loop calibration. The Loop calibration is prepro-
grammed with appropriate steps.

Change Gas Flows

Displays the Gas Flows dialog. This dialog is identical to the one that is opened when  
selected from the Insert Experiment Step dialog. A complete description of this dialog is 
found earlier in the Experiment section.

Zero the TCD signal 
when recording starts

Select this option to zero the TCD signal automatically 
the first time recording starts in an experiment. 

Invert the TCD signal Inverts the TCD signal. For example, if you expect to 
obtain only negative peaks, this option can be used to 
record the peaks in the positive direction.

You cannot change the steps included in a loop calibration, but you can include a 
loop calibration in analyses that contain other experiments. For example, you can 
include a loop calibration experiment in an analysis that also contains a pulse 
chemisorption experiment.
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Change Flow Options

Displays the Change Flow Options dialog.

Path Select These valves allow flow of the gas stream from the 
sample or from the septum and loop to the detector. 
Typically, this selection should be Sample. Use Bypass 
when performing a loop calibration.

Delay Serves to delay the arrival of desorbed gases at the 
detector system long enough for the flow rate to recover 
from the rapid desorption of adsorbed molecules created 
when the cryogenic liquid is removed during physical 
adsorption experiments. Choose Long when performing 
physisorption analyses. For other operations, Short is 
sufficient. 

Cold Trap Dewar Use the Installed option when using a Dewar of cryo-
genic liquid or a slush bath around the sample. For other 
analyses, choose Removed.

Loop (2750 only) Choose the initial position for the loop valve. The Load 
position is recommended for the start of each analysis.

The loop is used for pulse chemisorption experiments 
and calibrations.
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Dose

Displays the Dose dialog enabling you to specify dosing methods.

Inject Loop Gas
(2750 only)

Injects the contents of the loop into the path that leads to 
the sample. The contents of the loop are pushed out of 
the loop by the Carrier Gas.

Manual Injection Prompts you to inject a dose of gas into the septum using 
a syringe. The Physical Injection Volume field is 
enabled allowing you to enter the volume of gas 
injected.

Get Physisorption 
Point

Prompts you through the steps necessary to collect data 
for a physisorption point. These steps include: placing a 
Dewar of liquid nitrogen around the sample tube, 
waiting for a return to baseline, then replacing the Dewar 
with water at room temperature. You can take repeated 
points by inserting the Dose step within a Repeat Loop 
(discussed later in this chapter).

After Injection Enables you to choose the waiting method after injection 
of the gas. 
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Baseline Displays the Baseline Detection Parameters dialog 
allowing you to specify baseline settings when a Wait 
step involving the baseline is selected.

Establish the Slope or Acceleration threshold and 
Duration for determining what constitutes a Stable 
Baseline, a Change From Baseline, and a Return To 
Baseline. These values control whether a particular 
change in the signal is significant to the current 
experiment; in other words, they define a stable baseline.

Some Wait steps are contingent upon the values you 
select here. For example, if your experiment contains a 
Wait until Baseline is stable step, the signal is 
compared to these values to determine if a stable 
baseline has been established. Lower slope/acceleration 
values and longer durations create a more rigorous 
definition of these factors than higher values and shorter 
durations. Normally the default values are satisfactory.

Ranges for each field are displayed in the information 
bar across the lower section of the dialog.
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Recording

Enables you to specify how frequently the signal reading is recorded.

Recommended values are 1.0 for TPR, TPD, and TPO experiments, and 0.4 for pulse 
chemisorption.

The Start Recording dialog starts the recording of the signal for the analysis. A Stop 
Recording step is inserted in the list of steps automatically on the Analysis Conditions 
dialog when you insert a Start Recording step. 

If a Start Recording step is immediately followed by a step that prompts an immediate 
peak, peak data are recorded before any baseline readings can be collected. To collect 
some baseline data before the first peak in such an experiment, insert a Wait (Wait _____ 
minutes option) step after the Start Recording step, but before the step which causes the 
peak.
5-26                                                    May 04



ChemiSoft TPx Operator’s Manual Open
Repeat

When you insert a Repeat step in your analysis conditions, the Start Repeat Sequence 
dialog opens allowing you to specify the duration of the repeat sequence. After you 
complete the Start Repeat Sequence dialog and click OK, a Start Repeat step and a Stop 
Repeat step are automatically inserted in the list of steps for this analysis. You may insert 
multiple experiment steps within the Repeat loop.

During the Repeat sequence, the values for peak areas are displayed at the Prompt on the 
operational window. Regardless of which option you choose, you will be given the 
opportunity to continue with the Repeat sequence or you can click Exit Repeat to exit the 
Repeat sequence. 

Repeat until peaks
are equal or [n] times 

Choose this option to display values for the last two peak 
areas, or you can enter a number for the repeat sequence.

This option is useful when performing H2 or CO pulse 
chemisorption on supported metal catalysts.

Repeat until peaks are 
zero or [n] times

Choose this option to display the values for the last peak 
area and the maximum peak area, or you can enter a 
number for the repeat sequence.

This option is useful when performing an N2O 
decomposition for characterizing copper catalysts.

Repeat [n] times This option does not display peak area data; you will be 
presented with the opportunity to continue the repeat 
sequence or, as with the other options, you can exit the 
repeat sequence.

Repeat until peaks match 
the first peak or [n] times

Choose this option to display values for the first and last 
peak area, or you can enter a number for the repeat 
sequence. 
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Temperature Ramp

Insert this step to change the sample temperature.

Target Setpoint Enter the ending temperature for this ramping procedure. 

Ramp Rate Enter the ramp rate for this ramping procedure.

Dwell Time Enter the amount of time to hold the temperature at the 
conclusion of this step. 

Enable Cooling Fan Select this option to enable the cooling fan to reduce the 
furnace temperature more rapidly during cool-down.
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Wait

Enables you to specify a waiting routine.

Wait [n] minutes. Specify an exact number of minutes to wait.

Wait for operator Enter a description of the operator’s task; for example 
“Fill the dewar, then click OK.”

During an analysis, the message you enter is displayed 
on the monitor at the appropriate time. The analysis 
continues after you perform the task and click OK. 

Wait until Baseline 
is stable

Waits until the baseline becomes stable. If you choose 
this option, click Baseline to specify the settings

Wait for change from 
Baseline or [n] minutes

Enter the number of minutes to wait, then click  to 
specify the settings

Wait for return to 
Baseline

Waits for a return to Baseline. If you choose this option, 
click  Baseline to specify the settings.
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Done

This step is automatically inserted in every experiment. The defaults for this step are the  
ones specified for Sample defaults (Options menu). You can view and/or edit the details 
of this dialog by clicking Edit when Done is selected (highlighted); the Done dialog is 
displayed.   

Gas Flows Displays the Gas Flows dialog allowing you to view or 
edit current gasses and their flows. Refer to Experiment 
earlier in this chapter for information on this dialog. 

Return to ambient 
temperature

Select this option to have the sample cooled to ambient 
temperature.

Enable Cooling Fan Select this option to enable cooling fan during the cool-
down operation.
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Report Options

This dialog is used to edit existing report options, or to specify report options for a new 
file.

When creating parameter files to display in the drop-down list on the Basic and 
Restricted sample information dialogs, be sure to save them to the directory 
specified as the Parameter File directory (see Chapter 8).

Report options If you are editing an existing file, this field displays the 
description or identification of the report options file. 
This description can be edited if desired.

If this is a new file, this field contains the description 
specified in Sample defaults. You can enter a new 
description or add to the existing one if desired. Use a 
description that will help you identify this set of report 
options in the future.

Range: 40 alphanumeric characters

Replace Enables you to copy values from an existing file to the 
one you are creating. A dialog is displayed so that you 
may choose the file containing the values you wish to 
copy. Since the values are copied into the new file, you 
can edit them without affecting the source file.

A report is 
selected when 
preceded with a 
check mark.
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Show report title This option allows you to have a heading appear on your 
report and to enter a title for it.

If this is a new file, the title you specified as the default 
is displayed. Accept the default title or enter a different 
one.

Range: 40 characters

Show graphic Select this option to have a graphic (bitmap or enhanced 
metafile) display above the report title. For example, you 
may wish to display your company logo. Click Browse 
to select the desired graphic, then enter the Height and 
Width in the fields provided. This image can also be 
edited from the report window.

Selected Reports Contains a list of available reports. A report is selected 
when it is preceded with a check mark. Select reports by 
double-clicking the desired report(s). Alternatively, you 
can highlight the desired report and press Spacebar. 
Reports are deselected in the same manner. Certain 
reports can be edited by highlighting the desired report 
and clicking Edit. 

Edit Enables you to edit the highlighted report. The dialog(s) 
associated with each type of report are described in the 
following sections.

The Summary Report and the Analysis Log cannot be 
edited.
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Tabular Report Option

Clicking Edit when Tabular Report is selected opens the following dialog:

Selected Experiments Displays all of the experiments in the current file. All 
experiments are selected by default; you may deselect 
any that you do not wish to include in the report. 

If this is a new file, no experiments are listed. 
Experiments are not included in the list until data are 
collected.

Report data points at 
specified interval

Select this option to report data points at a specified 
interval, then specify the frequency of reported data (the 
number of seconds between reported data readings).

This feature is useful if you anticipate a large amount of 
data to be collected during the analysis (such as in a 
lengthy analysis with readings taken every second). If 
you do not specify an interval for data reporting, all 
points are reported, regardless of the length of the report. 
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BET Surface Area Report Option

Clicking Edit when BET Surface Area is selected opens the following dialog:

Selected Experiments Displays all BET surface area experiments in the current 
file. All experiments are selected by default; you may 
deselect any that you do not wish to include in the 
report. 

If this is a new file, no experiments are listed. 
Experiments are not included in the list until BET data 
are collected.

Report Type From this group box, choose the type of report(s) desired. 
If you choose Multipoint or Multipoint plus one single 
point, the choices on the right side of the group box are 
enabled. You can choose as many of these options as 
desired.

Adsorbate cross-sectional 
area

Enter the appropriate value. The adsorbate cross-section 
is the area occupied by a single adsorbed molecule on 
the adsorbent surface.
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 Langmuir Surface Area Report Option

Clicking Edit when Langmuir Surface Area is selected opens the following dialog:

Selected Experiments Displays all Langmuir surface area experiments in the 
current file. All experiments are selected by default; you 
may deselect any that you do not wish to include in the 
report. 

If this is a new file, no experiments are listed. 
Experiments are not included in the list until data are 
collected.

Report Type From this group box, choose the type(s) of reports you 
wish to generate.

Adsorbate cross-sectional 
area

Enter the appropriate value. The adsorbate cross-section 
is the area occupied by a single adsorbed molecule on 
the adsorbent surface
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Total Pore Volume

Clicking Edit when Total Pore Volume is selected opens the following dialog:

Selected Experiments Displays all Total pore volume experiments in the 
current file. All experiments are selected by default; you 
may deselect any that you do not wish to include in the 
report. 

If this is a new file, no experiments are listed. 
Experiments are not included in the list until data are 
collected.

Adsorbate density 
conversion factor

Enter the appropriate value for converting the gas volume 
to liquid volume. This value can be obtained by dividing 
the gas density by the liquid density at the adsorption 
temperature.

Density conversion factor = 
gas

l
----------

TBATH

TSTD
----------------
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Pulse Chemisorption Report Option

Clicking Edit when Pulse Chemisorption is selected opens the following dialog:

Selected Experiments Displays all pulse chemisorption experiments in the 
current file. All experiments are selected by default; you 
may deselect any that you do not wish to include in the 
report.

If this is a new file, no experiments are listed. 
Experiments are not included in the list until related data 
are collected.
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First Order Kinetics Report Option

Clicking Edit when First Order Kinetics (heat of adsorption) is selected opens the 
following dialog:

Selected Experiments Displays all TPD experiments in the current file. All 
experiments are selected by default; you may deselect 
any that you do not wish to include in the report. 
However, you must include at least three experiments for 
the first order kinetics to be calculated. 

If this is a new file, no experiments are listed. 
Experiments are not included in the list until related data 
are collected.

Tabular Report Select this option to have a tabular (data in a table form) 
report generated.

Plot Select this option to have the data plotted in a graphical 
format
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Loop Calibration Report Option

Clicking Edit when Loop Calibration is selected opens the following dialog:

Analysis Log Report

When Analysis Log is selected, a log of analysis operations is included in the reports. The 
Analysis Log cannot be edited.

Selected Experiments Displays all loop calibration experiments in the current 
file. All experiments are selected by default; you may 
deselect any that you do not wish to include in the 
report. 

If this is a new file, no experiments are listed. Experi-
ments are not included in the list until related data are 
collected.
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Graph Report Options

All graph report options are similar and are edited in the same manner. Click Edit for a 
selected graph report; a dialog similar to the following is displayed:

The detector signal may be plotted against time or temperature.  

For color output to a monitor or printer, signals are displayed in different colors. For 
black and white output, different symbols are used.

Selected Experiments Displays all related experiments in the current file. All 
experiments are selected by default; you may deselect 
any that you do not wish to include in the report. 

If this is a new file, no experiments are listed. 
Experiments are not included in the list until related data 
are collected.

Select peaks Select this option to:

• display the areas and baselines on the graph
• draw a straight baseline between the selected peaks
• enable the Peaks push button, allowing you to specify 

the peaks to include in the experiment

This option is disabled for new files.
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Do not plot more 
than _____ points

Allows you to specify a maximum number of points to 
plot. Typically, the default of 1000 is sufficient. You can 
specify up to 8000 if higher resolution and more detail is 
desired. The speed at which graphs are plotted on some 
computers may be affected when large numbers of points 
are requested.

Peaks Opens a dialog that contains a list of all the peaks for the 
results of the experiment highlighted in the Experiments 
list box. All peaks are selected by default; remove the 
check mark next to any peak you do not wish to include 
on the graph. 

X-Axis group box The options in this group box enable you to specify X-
axis criteria.

Time/Temperature Select the variable you wish to have as the X-axis.

Autoscale Select this option to have the X-Axis scaled 
automatically. As the default, this axis begins at zero, 
and the system uses the highest value collected during 
analysis as the ending point. The Axis From and To 
fields are disabled if you choose to autoscale data.

If you choose not to autoscale data, you must enter a 
range. The value entered in the To field must be greater 
than the value entered in the From field.

Y-Axis 

Variable Choose a variable for the Y-axis from the drop-down list.

Overlay Use this option to overlay another variable with the 
current one. Select a variable from the drop-down list if 
desired.

Autoscale Select this option to have the Y-Axis scaled 
automatically. As the default, this axis begins at zero, 
and the system uses the highest value collected during 
analysis as the ending point. The Axis From and To 
fields are disabled if you choose to autoscale data.

If you choose not to autoscale data, you must enter a 
range. The value entered in the To field must be greater 
than the value entered in the From field.
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Collected Data

The tab for Collected Data does not appear on the Advanced dialog presentation until after 
analysis.

Po of adsorbate Displays the saturation pressure of the adsorbate.

Ambient temperature Displays the room temperature.

Ambient pressure Displays the room pressure.

Experiment Defaults to the first experiment of the current file. Click 
the down arrow to choose other experiments in the file.

Physical injection volume Displays the volume of the syringe used to perform the 
manual injections.

Active Concentration Displays the percent of the gas mixture that is composed 
of the reactive gas versus an inert filler.

Peak table Displays the peak summaries for the experiment shown 
in the Experiment field.

Use Fitted points Select this option to report peak data obtained using the 
Fit peak option in the Peak Editor (refer to Peak Editor 
in Chapter 7).
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Active Metals Enabled for Pulse Chemisorption reports; displays the 
Active Metals Table dialog, allowing you to specify the 
percent of sample weight of the active metals in the 
sample (in the far right column), and the stoichiometry 
factor.

This table displays the defaults specified using the Active Metals Defaults option 
on the Options menu. After a sample file is created, the table becomes specific to 
the sample file. Therefore changes made in the current table do not affect default 
settings.

Insert Inserts a new row into the table; the row is inserted 
above the selected one.

Delete Deletes the selected row.

Clear Clears the table of all entries except one; one is required.
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Save

Save enables you to save any changes made to the file in the active window. The file is 
saved under its current name.

Save As

Save As enables you to save the sample file or parameter file in the active window under 
a new name. Saving the file under a new name allows you to make modifications without 
changing the original file. 

You can save a sample information file as another sample information file or as any 
parameter file. Parameter files, however, can be saved only as another parameter file of 
the same type. For example, you can save the analysis conditions portion of a Sample 
Information file as an analysis conditions file or the report options portion as a report 
options file. But an analysis conditions file can be saved only as another analysis 
conditions file.

Be sure to save parameter files to the directory specified as the Parameter Files directory 
(see Parameter Files Directory in Chapter 8) or it will not display in the drop-down list on 
the Basic Sample Information file editor. The default directory is PARAMS. 

Save All

Save All enables you to save all open files under their current names. This option provides 
a faster way to save all open files at one time and avoids having to perform a Save 
operation on each individual file. 

After you use the Save As function, the original file is still open, not the new one. 
To edit the new file, close the original file, then open the new file.
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Close

Close enables you to close the file in the active window. The following message is 
displayed if changes have been made to the file:

(path\file name) has been changed. Save changes 
before closing?

Yes No Cancel

• Click Yes to save the changes and close the dialog box
• Click No to discard the changes and close the dialog box
• Click Cancel to allow the file to remain active

Close All 

Close All enables you to close all open files under their current names. The following 
message is displayed for each file in which changes have been made:

(path\file name) has been changed. Save changes 
before closing?

Yes No Cancel

• Click Yes to save the changes and close the dialog box
• Click No to discard the changes and close the dialog box
• Click Cancel to allow the file to remain active
May 04                                                      5-45 



Print ChemiSoft TPx Operator’s Manual
Print

Print enables you to print details of a sample or parameter file; a dialog similar to the one 
shown below is displayed.

File name The name of the file you select from the Files list 
window is copied to this field. If choosing multiple files, 
the last name chosen is displayed.

Status Enables you to choose the type of files to display in the 
Files window.

Dates Enables you to choose a date range for the files to 
display in the Files window.

Settings group box The Destination field contains a list of the available 
print destinations.

If you select Printer or Printer/Plotter, the Copies field 
is enabled allowing you to enter up to four copies.

If you select File, the tabular reports of the requested file 
are converted to a text file which can be viewed with a 
text editor or other text file manipulation tools. The File 
name field is also enabled allowing you to enter a name 
(or you can accept the default).
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List

List enables you to generate a listing of the following information on a selected file, or on 
multiple files:

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status

Regardless of which file type you select, a dialog similar to the one shown below is 
displayed.

File name If you select only one file from the Files list window, the 
name is copied to this field. If multiple files are selected, 
the last one selected displays.

To select multiple files, hold down the Ctrl key while 
selecting the files.

Status Enables you to choose the type of files to display in the 
Files window.

Dates Enables you to choose a date range for the files to 
display in the Files window.
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Settings group box The Destination field contains a list of the available 
print destinations.

If you select Printer or Printer/Plotter, the Copies field 
is enabled allowing you to enter up to four copies.

If you select File, the tabular reports of the requested file 
are converted to a text file which can be viewed with a 
text editor or other text file manipulation tools. The File 
name field is also enabled allowing you to enter a name 
(or you can accept the default).
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Import MS Signal

Import MS Signal allows you to import data collected by Pfeiffer Vacuum’s ThermoStar 
mass spectrometer (which uses QuadStar software).  

Select Import MS Signal from the File menu; the Open Mass Spectrometer Data File 
dialog is displayed.

Analog signals must be configured in the QuadStar software before they can be 
imported properly. Refer to Configuring Analog Signals on the following page.

File name Displays the wildcard (*) with an MDC extension. This 
is the file extension used by QuadStar software. 

Dates Enables you to choose a date range for the files you wish 
to display in the Files window.

Files list Displays the files available in the current directory.
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After you select the desired file and click OK, the Import Mass Spectrometer Signal 
dialog is displayed.

Configuring the Analog Signals

The import utility reads both the mass spectrometer data and any analog signals that are 
collected by the ThermoStar. The analog signals must be configured for them to be 
imported properly. This is accomplished through the Parset program, which is part of the 
Quadstar software.

1. Launch the Parset program; using Windows Explorer, double-click on Parset.exe.

2. Refer to the Instrument Configuration section of the ThermoStar operator’s manual 
and configure the characteristic curves as follows:

A1 = T
A0 = TCD

Mass Spectrometer File Displays the mass spectrometer file you selected from 
the previous dialog to import into the ChemiSoft 
program.

Sample File Displays the sample file into which the mass spectrome-
ter file will be imported. 

If you have a sample file open, its name is displayed in 
this field and the data will be imported into this file 
when you click OK.

If you do not have a sample file open, the next 
sequenced file number is displayed in this field. When 
you click OK, the data will automatically import and 
assume the next sequenced number; you will not be 
asked if you wish to create the file.

Browse This push button is provided for each type of file so that 
you can choose a different file from the one(s) displayed.
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Export

Export allows you to copy data in a sample information file and reformat it in ASCII 
format or Grams/32 format. ASCII data can be imported into other applications, such as 
spreadsheets. Grams/32 data format can be used with the Grams/32 program (a peak 
editing program used in earlier versions of the Micromeritics AutoChem analyzer). You 
may select multiple files by holding down  and clicking the left mouse button once on 
each file. See Appendix D for a description of exported data.

Select Export from the File menu; the Export Sample File dialog is displayed.

File name The name of the file you select from the Files list box is 
copied to this field.

Export Type You can export the data from a sample information file 
in an ASCII or Grams/32 format.

• Choose ASCII to create a data file that can be imported 
into an application such as a spreadsheet program.

• Choose Grams/32 to create a data file that can be used 
with the Grams/32 program.

Status Enables you to choose the type of files to display in the 
Files window.

Dates Enables you to choose a date range for the files to 
display in the Files window.
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When you click  OK, the Collected Data Export Options dialog is displayed.

Settings group box The Destination field contains a list of the available 
print destinations.

If you select Printer or Printer/Plotter, the Copies field 
is enabled allowing you to enter up to four copies.

If you select File, the tabular reports of the requested file 
are converted to a text file which can be viewed with a 
text editor or other text file manipulation tools. The File 
name field is also enabled allowing you to enter a name 
(or you can accept the default).

A sample information file exported as a Grams/32 type can only be generated to a 
File destination. When you export a Grams/32 type, five separate files (which can 
be read only the Grams/32 software) are generated.

Selected Experiments Displays a list of the experiments included in this sample 
file. All experiments are selected by default, you may 
deselect any you do not wish to include in the export 
operation. 

This portion of the dialog is the only field displayed if 
you are exporting a file as a Grams/32 type.

Peak summaries Exports a summary of the peaks contained in the 
selected experiment(s); enables the Normalize by 
weight field.

Normalize by weight Divides the TCD signal by the sample weight to correct 
the signal strength for different sample sizes. 

Only this portion of the 
dialog displays when 
you choose Grams/32 
as the type of export.
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Report calibrated values Exports the calibrated values for the TCD signal if cali-
bration data are available.

Measurements Select this option to report measurements; the related 
fields are enabled.

Report at a specified 
time interval

Select this option to report measurements at a specified 
interval; a field is enabled so that you may enter an 
interval (the number of seconds between reported data 
readings). You may wish to use this feature if a large 
amount of data was collected during the analysis (such 
as in a lengthy analysis with readings taken every 
second). If you do not specify an interval for data 
reporting, points are reported as follows:

• Up to 500 lines per experiment if destination is to the 
screen or to a printer.

• Up to 10,000 total lines if destination is to a file.

Select a time range Select this option to specify relative starting and ending 
times of the measurements you wish to export. This fea-
ture allows you to specify a region of interest to be 
extracted from a large data set.
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Exit

Exit enables you to exit the ChemiSoft program. Select Exit from the File menu. 

• If a window containing unsaved changes is open, the following message is 
displayed:

(path\file name) has been changed. Save changes 
before closing?

Yes No Cancel

Click Yes to save the changes and exit the program
Click No to discard the changes and exit the program
Click Cancel to allow the file to remain active

• If an analysis is in progress, the following message is displayed: 

2547- An instrument is busy. Exiting the applicaiton will result in 
termination of the analysis. Continue with Exit?

Yes No

Click Yes if you are not concerned with terminating the analysis.
Click No to allow the analysis to finish.

• If a report is in progress or a report window is open, the following message is 
displayed:

A report is currently printing. Exiting the application now will cancel 
the report. Continue with the termination?

Yes No

Click Yes to cancel the report(s) and exit the program.
Click No to allow the program to remain active.
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6.  UNIT MENU

The Unit menu contains options that enable you to perform operations relating to the 
analyzer. 

Description

Listed below are brief descriptions of the Unit menu options. Detailed descriptions follow 
this section.

Start Analysis Opens a series of dialog boxes that enable you to start an 
analysis. Page 6-2.

Show Status Displays only the Status Bar of the operational window. 
Page 6-9.

Show Instrument Log Displays a log of instrument operations. Page 6-10.

Show Results Shows data collection for the current analysis. 
Page 6-12.

Unit Configuration Displays the software versions for the analysis program 
and controller, the analyzer model and serial numbers.

Also allows you to enter the loop (if applicable) volume. 
Page 6-14.

TCD Calibration Displays a series of dialogs allowing you to create, edit, 
and manage calibration files. Calibration files enable the 
software to convert sample signal, temperature, and peak 
area data to volume data. Page 6-15.

Thermocouple Calibration Enables you to calibrate the sample thermocouple. 
Page 6-20.
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Start Analysis

When you select Start Analysis, the Analysis dialog is displayed with a file selection 
dialog positioned on top. You can either select a sample file that has been previously 
created, or you can create a new sample file using the next sequenced number.

Which option you choose depends on the method you prefer for your laboratory. The 
analysis process is the same either way. For example, your lab may prefer to create 
numerous sample files in advance, then analyze the samples when they become available. 
Alternatively, your lab may prefer to create sample files for each sample as you begin the 
analysis.

After you choose a sample file and click OK, the Analysis dialog becomes totally visible. 

The Analysis dialog for all presentation modes are identical except for the group of push 
buttons positioned just below the Analysis Conditions window. This group of push 
buttons is used for inserting and editing steps (if needed) and is available only in the 
Advanced mode.

The software is unable to determine if the wrong gas is physically connected to 
the port, or selected with the proper push button on the analyzer front panel. Be 
sure that appropriate gases are connected as requested in the sample file.

This group of push 
buttons does not 
display in the Basic 
and Restricted 
presentations.
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View Allows you to choose from four views to display in the 
current window

Operate Displays the dialogs associated with the current 
operation.

Results Displays analysis results as they are collected.It is best to 
use the Show Results command so that you can allow 
the operation window to remain viewable. 

Sample log Displays a log of each step as it is completed, as well as 
any error messages or manual operations that occur 
during the analysis.

Browse Enables you to choose a different sample file for the 
current analysis.

Sample Displays the description for the current file. 

Replace All Allows you to replace the contents of the current file 
with those of another one. After the values have been 
copied into the current file, you may edit them in any 
way you wish. Editing the values will not affect the file 
from which they were copied.

Mass Enables you to edit the value for the mass of the current 
sample.

Analysis Conditions Displays the current Analysis Conditions file. You can 
choose a different file (if desired) from the drop-down 
list. The files in the drop-down list are predefined 
parameter files created and saved to the parameter files 
directory (some also were included with the ChemiSoft 
program).

The window directly below this list contains the 
conditions specified in the Analysis Conditions file. If 
you are using the Advanced format for the current 
analysis, you can edit the conditions using the push 
buttons provided below the Analysis Conditions 
window. Refer to Chapter 5 for operation of these push 
buttons.
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Analysis Conditions
(continued)

You can also edit analysis conditions after the analysis 
has begun. Click Suspend to suspend the analysis; this 
enables the editing push buttons. You can edit only the 
steps or experiments following the current one. After 
editing is complete, resume the analysis.

Report Options Displays the current Report Options file. This drop-
down list contains predefined parameter files, some of 
which are supplied with the analysis program. For newly 
created files to display in this list, they must be saved to 
the directory specified as the parameter files directory 
(see Chapter 8). Click the down arrow to the right of the 
field to choose a different file. 

The window directly below this list contains the reports 
requested for the current Report Options file. You can 
select additional reports or deselect currently selected 
ones if desired. A report is selected when it is preceded 
with a check mark. Simply double-click to select (or 
deselect) a report. Alternatively, you can highlight the 
report and press Spacebar.

Next Advances you to the second view of the Analysis dialog. 
This view lists the gases required for the current 
analysis. 
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Click Next to advance to the next view of the Analysis dialog. This view enables you to 
choose a TCD calibration for each experiment in this sample’s analysis conditions set. A 
TCD calibration allows the ares of the peaks recorded by the instrument to be converted 
into volumes. A TCD calibrating is not required by all analysis types, nor is it necessary 
to select the calibration from this dialog. A calibration can be associated with an 
experiment during peak editing (after analysis has ended).

The default(s) for the calibration file(s) are those specified using the TCD Calibration 
Defaults option on the Unit menu (discussed later in this chapter).
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Click Next to advance to the next view of the Analysis dialog. This view enables you to 
generate reports automatically when the analysis is complete. The reports generated are 
those selected in the report options portion of the sample information file.

Report AfterAnalysis Choose this option to have the reports specified in the 
sample file generated automatically after the analysis is 
complete.

Number of Reports Enabled when Printer or Printer/Plotter is selected as 
the report destination. You can print up to four copies.

Destination Allows you to choose a destination for the reports.

Choices: File, Printer, Printer/Plotter, Screen

If you choose Screen for the destination, many options 
are available for manipulating and customizing your 
reports.

File name Enabled when File is selected as the report destination, 
allowing you to enter a file name (or you can accept the 
default).
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Click  Next; a dialog instructing you to verify the following is displayed:

• Verify in the sample file that the combinations or sequence of gases in the analyzer 
are not dangerous, and that the sample will not react with any of the gases in a 
dangerous way.

• Verify that the current method for venting the analyzer’s exhausts is adequate and 
safe for all products of the analysis.

After you have ascertained that all conditions are safe for the analysis, click Start to 
begin the analysis; this view of the analysis dialog is displayed.

Synopsis Shows the list of experiment steps in the sample 
information file. Upcoming steps are shown in blue or 
black. The current step is highlighted and shown in light 
blue; completed steps are shown in light green.

You may scroll through the list to review the analysis 
steps. You can also edit steps that have not been started; 
the analysis must be suspended to do this (see Suspend 
below).

Step Detail Shows detailed information about the current step.
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Stop Stops operation of the current step, displaying of the 
prompts, and suspends the analysis. Click Resume to 
restart the analysis and the operating prompts. The anal-
ysis resumes at the beginning of the next step. This 
button is used to skip the remaining portion of the cur-
rent step. 

Cancel Cancels the analysis; the current step is not completed. 
After confirmation, all operating prompts cease to 
display, and the analysis ends. The analysis cannot be 
resumed. 

Suspend Suspends the analysis. This button is a toggle button; it 
reads Resume when the analysis is suspended.

You may wish to suspend the analysis to edit steps in the 
list or add steps to the list. Steps can only be added or 
edited in the portion of the list that has not yet been 
executed; such editing is available only if you are using 
Advanced presentation format. The current step cannot 
be edited. Click Resume to continue the analysis after 
editing has been completed.

During analysis, analysis conditions can be edited only using this view of the Start 
Analysis dialogs. Analysis conditions cannot be edited in the sample file during  
analysis. The analysis must be in a suspended state.

Prompt Displays information about the step and any actions 
required from the operator before the analysis can 
continue. If an action is required, the message displays in 
blue. 

Continue Click this push button after you have completed the 
task(s) displayed at the Prompt. 

Exit Repeat Enabled during a Stop Repeat step, enabling you to exit 
the Repeat sequence.
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 Show Status

Select this option to display the status bar of the operation window. The bottom portion of 
the Analysis dialog sequence displays the instrument’s Status window. This option allows 
you to display only the status portion of the operational window.

The Status window displays:

During analysis, the Status window also displays:

Run File Gives the name of the sample information file currently 
being used for analysis. If no file is currently selected, 
this field remains blank.

Temperature Gives the sample’s temperature, as measured by the 
sample thermocouple.

TCD Reading Displays the current detector reading (0.0000 if 
disabled).

Sample (Identifier) Gives the identifier of the sample information file 
currently being used for analysis. If no file is currently 
selected, this field remains blank.

Step Shows the step currently being performed. When no 
analysis is in progress, Status: Idle is displayed instead.

Duration Shows the amount of time that has elapsed since the 
current step was started. If the analysis is waiting for a 
fixed period of time, the time left to wait is shown in 
parentheses next to the time.

Repeat Count Shows how many times the current Repeat loop has been 
entered.
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Show Instrument Log

Select this option to display a log of instrument tasks and messages.

Analysis
Calibration
Message

Use these options to choose the type of information you 
wish to display in the window. For example, you may 
wish to select only the Analysis option to display 
analyses only.

Add Log Entry Enables you to add an entry to the instrument log. For 
example, you may wish to enter some type of 
maintenance you performed on your analyzer. This entry 
displays in the Message category.

Report Displays the Log Report dialog enabling you to generate 
a report on the contents of the Instrument Log.

Start Date Use this field to specify a date at which to start the log 
entries. You can enter a date or double-click in the field 
to display a calendar from which to choose a date.

Copies Enabled when you choose Printer or Printer/Plotter as 
the destination, allowing you to print up to four copies of 
the report.
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Destination Presents destination options; Printer, Printer/Plotter, 
Screen, or File name.

File name Enabled when you choose File as the print destination, 
allowing you to enter a name for your file.
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Show Results

Select this option to view data collection for the current analysis. 

This feature enables you to view collection of data as it progresses and leave the 
operational window open so that you can respond to prompts requesting user interaction. 
If you choose Results from the View drop-down list on the operational window, you 
cannot view the requested actions of the prompts.

Click Options to customize the presentation of data in the Results view. You can change 
the axes and select or deselect the data that are presented. If you specify a value for 
Starting at (X-Axis), only those data collected after that point are shown.

.
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Y-Axis Displays Y-axis choices.Use the Scaling push button to 
choose autoscaling or to specify a range for scaling

X-Axis Allows you to choose the X-Axis variable. You can use 
the Starting at field to specify at what point you wish to 
start data collection. If you enter a value greater than the 
experiment duration, all data are shown

Smoothing Options When detector signals are weak and noise or other 
irregular signals are present, judicious use of these 
options can often suppress noise and enhance data.
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Unit Configuration

Select this option to display the configuration for the analyzer on which the software is 
being used.

Software Versions Displays the name and version number of the ChemiSoft 
program and the data acquisition module.

Model
Serial #

Displays the model and serial numbers of the instrument 
on which the ChemiSoft program is being used.

Loop Volume Allows you to enter the volume of the gas injection loop 
that is attached to the instrument. Three standard-volume 
loops are provided with your instrument. The loop 
volume is determined by performing a loop calibration. 
Loop calibration is performed as an experiment step 
(refer to Loop Calibration in Chapter 5) 
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TCD Calibration

Analyses yield data on signal reading, peak area, temperature, and time. These data are 
sufficient for many applications, but in some cases, actual gas volume data are desired as 
well.

A group of calibration routines is provided in the form of specialized experiment steps. A 
calibration run is an analysis using one of these experiment steps. The calibration run can 
be performed before or after the sample analysis. A calibration experiment can be 
included as a step within your sample analysis, or it can be performed as a separate 
analysis. 

After the sample data and calibration data are collected, the calibration file is associated 
with the sample file, and the sample data are converted to volume. A single calibration 
run can be associated with an unlimited number of sample data files. For example, TPR 
yields peak area and the temperature(s) at which maximum reduction occurs. To obtain 
the volume of gas uptake, however, you must select a calibration file to associate with the 
analysis file. Then you can create reports in which the area data are converted to volume 
data.

You can associate a calibration file with a sample file in three different ways:

• Select TCD calibration, Defaults on the Unit menu and specify a default calibration 
file for each experiment type.

• Choose Set Calibration from the Peak Editor (described in Chapter 7). This choice 
allows you to select a calibration file that was created after the sample file was used 
in an analysis.  

In applications where volume data are not required, it is not necessary to perform 
a calibration. If volume data are desired, calibration may be performed either 
before or after the analysis.
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Defaults

Allows you to specify default calibration files for each type of analysis. An additional 
default can be specified for analyses you have customized, using the Other drop-down 
list. Setting default calibrations can save you time when you frequently perform analyses 
using the same gases.

The calibration files that appear in the lists are those that are available for the instrument.

You can select a different calibration file using Set Calibration on the Peak Editor dialog.

New

Allows you to create a new TCD calibration file; the TCD Calibration dialog is displayed.

Click Load Calibration Data to load the values from an existing TCD file, then proceed 
with editing as desired. The fields on this dialog are identical to the ones on the Open 
TCD dialog (refer to the next section for a description of the fields).
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Open

Allows you to open an existing calibration file for editing; the Edit Existing TCD 
Calibration dialog is displayed.

This dialog contains a drop-down list of the existing TCD calibration files for this 
instrument. After choosing the desired file, click OK; the TCD Calibration dialog is 
displayed.  

Peak Table This table displays the sample file number, the 
experiment identification, the peak area, and the peak 
volume.The values in the table are graphically depicted 
in a plot adjacent to the table.

Delete Peak Deletes the selected peak.

Load Calibration Data Enables you to load another calibration file. The 
calibration file you choose must have been created with 
the current instrument. If you select a file created on a 
different instrument, an error message is displayed
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Report

Select this option to print a report of a calibration file.

.

Degree Allows you to choose a different degree of polynomial; 
usually the 2nd degree is adequate.

Coefficients Shows the fit of data to the polynomial.

Description Displays the name of the current calibration file. This 
field can also be sued to enter a new name when changes 
have been made.

Save Enabled when the current file as been edited, allowing 
you to save the changes. If you wish to save it under a 
different name, enter a name in the Description field.

Close Closes the dialog box.

Calibration From the drop-down list, select the file for which you 
wish to generate a report.

Copies Enabled when you choose Printer or Printer/Plotter as 
the report destination. You can print up to four copies.

Destination Allows you to choose a destination for the report.

Choices: File, Printer, Printer/Plotter, Screen

File name Enabled when File is selected as the report destination, 
allowing you to enter a file name (or accept the default).
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List

Select this option to display a list of the files in the Calibration Directory, including details 
such as the calibration file’s identifier (as entered in the sample information file) and the 
date the file was created (or last edited).

Next/Prev Allow you to view the next or previous page of the list. 
Enabled only when the report contains multiple pages.

Close Closes the window.

Print Prints the list.

Header This toggle button hides/shows the header of this list. If 
the header is selected, it appears on every page of the list 
when it is displayed and/or printed.
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Thermocouple Calibration

This option displays the Thermocouple Calibration dialog.

The sample and furnace thermocouples are precalibrated and typically are appropriate for 
all applications. However, this option has been included if modifications are desired.  

Heat Zones Displays information on the sample and furnace 
thermocouples. If you choose to recalibrate either 
thermocouple using an external reference, simply 
double-click in the appropriate Low/High Cal field to 
enter the value you obtain; a dialog similar to this one is 
displayed.

The date you enter the new value will automatically be 
inserted into the appropriate Calibrated field.

Load from File Allows you to load a different calibration file.
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Save to File Allows you to save the current calibration settings to a 
file. This function is useful in protecting your calibration 
data. It is wise to save the current settings before 
attempting a recalibration. Be sure to use the next 
sequenced file name generated by the system.

Accept Replaces the existing calibration values with those you 
have entered in this session. After a confirmation, the 
software gives you the opportunity to save the existing 
values. The Calibrate Hardware dialog is closed after 
you accept the new values.

Cancel Cancels any changes made to the current calibration 
settings. A warning message is displayed before the 
dialog closes  

Reset Enabled when a change has been made to any field on 
this dialog. Click this push button to reset any changed 
value(s) to its last saved state.
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7.  REPORT MENU

The Report menu contains options which allow you to initiate and close reports. This 
menu also allows you to access the Peak Editor, a flexible and powerful tool for process-
ing results.

This chapter describes the options contained on the Report menu, as well as a few exam-
ples of generated reports.

Description

Listed below are brief descriptions of the options contained on the Report menu. Detailed 
descriptions follow this section.

Start Report Allows you to generate a report on a sample which has 
been analyzed or on one which is being analyfzed. 
Page 7-2.

Close Reports Closes all open report window(s). Page 7-5.

Peak Editor Allows you to view peak data, combine and overlay 
results from multiple analyses, change the calibration 
files selected, and edit the data. Page 7-14.
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Start Report

Select this option to generate a report on a sample analysis. The Start Report dialog is 
displayed.

File name The name you select from the Files list box is copied to 
this field. If you select multiple files, the last one 
selected is displayed. If you have a file open, its name is 
displayed.

Status This drop-down list determines the type of sample files 
displayed in the Files list box.

Choices: All, Analyzing, Complete

All Displays all sample information files in the specified 
directory and within the range of dates selected in the 
Dates dialog.

Analyzing Displays sample information files that are currently 
being used for analysis.

Complete Displays sample information files that have been used in 
an analysis.

No Analysis Displays sample information file that have been prepared 
but not yet used in an analysis.
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Dates Displays the Select Dates dialog.

This dialog enables you to specify a date range for the 
files you wish to display in the Files window.

Show All Dates Displays all sample files of the type selected in the 
Status list, in the current directory.

Show Date Range Enables the From and To fields allowing you to specify 
a range of dates in which to display the sample files. Use 
one of the following methods to select date ranges:

• Highlight the field and enter a date, simply by typing 
the date; you do not have to enter a slash (/).

• Double-click in the selected field to display a calendar 
from which you can select a date.

For convenience, the following shortcut keys are 
available to assist you:

F2 Clears the field
F3 Inserts the current date
F4 Displays a calendar from which to select a date

Copies Enabled when the Printer or Printer/Plotter destination 
is chosen, enabling you to print up to four copies of the 
selected report(s).

Destination Displays a list of output destinations.

Choices: File, Printer, Printer/Plotter, Screen

If you select Printer or Printer/Plotter, requested 
reports are printed to your default printer and/or plotter.

If you select Screen, many options are available for 
manipulating and customizing reports. Refer to Printed 
Reports later in this chapter for manipulation methods 
of onscreen reports.
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If you choose a single sample file and click  OK, the Select Reports dialog is displayed so 
that you may select the desired reports. The reports selected are the ones you specified in 
the sample file. This dialog allows you to deselect reports or select additional ones. If you 
choose more than one file, this dialog is not displayed; the reports selected in each file are 
generated.

Double-click on the report(s) you wish to select (or deselect). A check mark is placed 
before each selected report. Pressing the Spacebar  (when the report is highlighted) 
performs the same function. After you make your report selection and click OK , the 
requested reports are sent to the specified destination.

Destination
(continued)

If you select File, the tabular reports of the requested file 
are converted to a text file which can be viewed with a 
text editor or other text file manipulation tools. Graphi-
cal reports cannot be generated to a file. 

File name Enabled when you select File as the destination. Allows 
you to enter a name, or you may accept the default.

Files list Displays a list of the available sample files for the choice 
shown in the Status field.

Directories Displays a list of available drives and directories. The 
drive and directory last accessed is displayed 
immediately above the Directories: list box.
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Close Reports

This option enables you to close all open report windows at one time. This avoids having 
to select close on each report window. This option is unavailable if reports are being 
generated.

Printed Reports

Header

All printed reports (either to the screen or to a printer) contain a header displaying file 
statistics.

• Tabular and graphical reports contain sample and instrument statistics such as date 
and time of analysis, analysis conditions, and so forth. 

Also included in the Tabular and graphical report headers are notes of any changes to 
the sample file which occur after analysis.

• Summary report headers contain the same type of information displayed in tabular 
and graphical reports with the exception of notes.

Some operating systems may cause the main menu bar to grey-out and appear 
nonfunctional when a Report window is closed. Simply click on the menu bar to 
return it to its normal state.
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Onscreen Reports

The report window containing onscreen reports provides many options for customizing 
and manipulating reports: 

• a tool bar
• shortcut menu options
• zoom feature
• axis cross hairs 

When reports are printed to the screen, they are printed in a window like the one shown 
below. Each requested report is listed in the Reports window on the tool bar; reports are 
also indicated by selectable tabs across the top of the report header. To view a specific 
report, select its tab or select the report in the Reports window and click Show.

Tabs display for each type of report you generate.

Header

Displays graphical 
(or tabular) data

Toolbar options

Lists the types of 
report generated.
7-6                                                    May 04



ChemiSoft TPx Operator’s Manual Printed Reports
Tool Bar

Reports Contains a list of all requested reports.

Show Shows the selected report in the report window. If the 
report has been hidden, it and its associated tab will 
become visible.

Delete Deletes the selected report. A deletion confirmation 
dialog is displayed since this function cannot be undone. 
The deleted report(s) will have to be regenerated if 
deleted in error.

Hide Hides (removes) the selected report from the report 
window. The report’s associated tab is also removed. 

Open Allows you to open a previously saved report file.

Print Displays a print dialog so that you can choose a printer 
for report output. A list of available reports is displayed 
in the window on the right side of the dialog.
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Print
(continued)

For convenience in selecting which reports to print, push 
buttons are provided beneath the report window. Or, you 
can make your selection by clicking on the desired 
reports.

Current selects the report displayed in the report 
window.

Shown selects only the shown reports; any non-
highlighted reports indicate they are hidden. You can still 
select hidden reports from this window to print.

All selects all reports, including those that may have 
been hidden.

Clear clears all selections.

Default Fonts Displays the Default Fonts dialog so that you can edit 
report fonts.

The window on the left lists the items for which the font 
can be edited.

Close Closes the dialog.

Load Loads the default font for the selected item.

Save Saves the changes as the defaults. If you do not click 
Save, the changes will apply to the current report set 
only; subsequent reports will revert to the default font

Edit Enables you to edit the font for the selected item; a font 
dialog is displayed so that you can specify the desired 
font and attributes.
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Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a 
report. 

For Tabular Reports

Resize column Displays a dialog so that you can specify the width  of 
the selected column (in inches).

Rename column Displays a dialog so that you can edit the name of the 
selected column. Use Ctrl + Enter to insert line feeds.

Move column Allows you to move the location of the selected column 
to the left or to the right.

Align column Enables you to right-align, left-align, or center the data 
in the selected column.

Hide column Displays a list of all columns, enabling you to select the 
one you wish to hide.

Show column Displays a list of all hidden columns, enabling you to 
select the one you wish to have shown again.

Column font Displays a Font dialog, allowing you to change font 
attributes for the tabular data in the current report. 

Header font Displays a Font dialog, allowing you to change font 
attributes for column headers in the current report.
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For Graphs

Edit title Allows you to edit the table title, as well as its font.

Copy table as text Enables you to copy the entire table (column headers and 
data) and then insert it into another program. Columns 
are tab-delimited, allowing easy alignment.

Autoscale Sets the axis boundaries to autoscale, presenting the 
signal in full scale.

Redraw Sets axis boundaries to its original view, allowing easier 
editing of peaks

In many cases, the AutoScale and Redraw options will show very little difference. 
Both options are also used to return the view to its original presentation after 
zooming a report or to remove cross-hairs.

Show curve Allows you to show curves that have been hidden. This 
option is disabled (greyed) if no curves have been 
hidden.

Hide curve Allows you to hide (remove) unwanted curves.
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Edit curve Displays the Curve Properties dialog, allowing you to 
edit curve properties.

Title Displays the title of the curve you are editing.

Style Drop-down list containing styles in which collected data 
can be displayed.

Choices: Curve, Histogram, Points, Curve and Points

Curve group box These options are enabled when you choose Curve, 
Points, or Curve and Points as the style. You can edit the 
curve interpolation, the style of curve and/or points, as 
well as the pen color. 

Histogram group box These options are enabled when you choose Histogram 
as the style, allowing you to specify the type of fill as 
well as the color

Edit axis Displays the Axis Properties dialog, allowing you to edit 
axis properties.

The options in this dialog enable you to edit the axis 
title, scaling, and graph grid lines.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine 
fine detail of the distribution. To use this feature, simply hold down the left mouse button 
and drag the mouse cursor (drawing a box) across the area you wish to view; then release 
the button. The enlarged area immediately fills the graph area. You can return to the 
normal view by right-clicking on the graph and selecting Redraw. 

Edit legend Displays the Legend Properties dialog, allowing you to 
edit the placement of the legend.

Edit title Displays the Title Properties dialog, allowing you to edit 
the current graph’s title and font.

Copy as metafile Copies the graph and places it on the clipboard, allowing 
you to paste it into other applications accepting 
Windows metafiles.

Use Copy as metafile to capture graphics for use in reports and presentations.

Copy as text Copies the data used to generate the graph as a series of 
tab-delimited columns of text.
7-12                                                    May 04



ChemiSoft TPx Operator’s Manual Printed Reports
Axis Cross-Hair

A cross-hair function is available so that you can view axis coordinates. To use this 
feature, simply left-click in the desired area of the graph.

You can remove cross-hair lines and return to the normal view by right-clicking on the 
graph and selecting Redraw, or clicking out of the graph area.

X-axis position

Y-axis position

Point of 
Coordination
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Peak Editor

The Peak Editor allows you to view and edit data from sample files. You can view the 
peaks in a stacked or overlaid manner. You can also edit the peaks and delete undesirable 
ones.

When you select the Peak Editor option, the Edit Sample Peaks dialog allowing you to 
select the desired file(s) is displayed. The fields on this dialog function in the same 
manner as other dialogs allowing you to select files. The Peak Editor allows you to view 
up to 16 experiments at one time. If you choose files containing more than 16 
experiments, a dialog displaying the experiments available in the chosen files is 
displayed.

This dialog allows you to choose the 16 experiments you wish to view and defaults with 
the first 16 experiments selected. You may deselect and select as desired. This is 
accomplished by double-clicking on the file, or by highlighting the file and pressing the 
space bar (the same method used in selecting reports).

After you select your file(s) or your experiments (whichever is relevant) and click OK, 
the Peak Editor window is displayed. This window contains five tabs. the first three tabs 
— Experiments Stacked, Experiments Overlay, and Signals View — provide different 
views of the data; the last two tabs — Edit Peaks and Fit Peaks — provide the TCD vs. 
time (or temperature) and tabular information for the integrated peaks.
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Features of the Peak Editor Window

The Peak Editor window provides the following tools for viewing and editing peaks:

• Shortcut menus
• Shortcut keys
• Zoom in on the TCD signal
• Cross-hairs

Shortcut Menu

A shortcut menu is available for each view of the Peak Editor window. This shortcut menu 
contains the available functions and is accessed by right-clicking in the graph area. For 
example, when you right-click in the Experiments view, the following menu is displayed:

The options on the menu displayed for each view are explained in subsequent sections.

Shortcut Keys

Shortcut keys are provided for many of the functions in the Peak Editor. These shortcut 
keys have been assigned function-relevant characters enabling you to remember them 
more quickly. For example, Ctrl+A is assigned to Autoscale. Refer to Table 7-1 for a 
complete list of the shortcut keys you can use while operating the Peak Editor.
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Table 7-1. Shortcut Keys for the Peak Editor

Zoom Feature

A zoom feature is included with the Peak Editor allowing you to zoom in on peaks. This 
feature functions in the same manner as the zoom for reports; hold down the left mouse 
button and drag the mouse cursor (drawing a box) across the area you wish to view; then 
release the button. If you have multiple graphs displayed, the area you define on the 
selected graph is enlarged for each graph. You can return to the normal view by right-
clicking on the graph and selecting Autoscale, or you can use the shortcut keys Ctrl + D.

Cross-Hairs

When you click the mouse in the graph area, locator cross-hairs are displayed. The exact 
values associated with the intersection of the cross-hairs are displayed along the axes. 
This makes it easy to determine exact values for points on the second Y-axis, or for the 
point on the time/temperature trace that corresponds with the signal/temperature trace.

Key(s) Function

Ctrl + A Sets the axes to autoscale (full scale view)

Ctrl + D Returns the Peak Editor window to its original view

Ctrl + M Shows or Hides Peak Marks

Ctrl + T Displays the X-axis by Time or Temperature

Ctrl + F Copies graph(s) as a Metafile, allowing you to paste it into 
another application

Ctrl + C Copies data to the clipboard, allowing you to paste it into 
another application 

Ctrl + N Advances you to the next peak

Ctrl + P Returns you to the previous peak

Ctrl + L Marks the left edge of the peak

Ctrl + R Marks the right edge of the peak

Ctrl + S Saves the changes made to the current file
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Experiments

The Experiments View shows curves for all experiments within the selected file(s). You 
can display the curves in a stacked fashion or in an overlaid fashion. You can display up 
to 16 experiments; each experiment is displayed in a different color.

Stacked

The Stacked view displays up to 16 experiments, stacked one after the other. In this view, 
you can select the individual experiments to obtain information. When you select an 
experiment, its name is displayed in the title bar of the window. Cross-hairs are also 
displayed to show exact vales in the selected area.

When you right-click in the graph area, the following shortcut menu is displayed:

Some functions are assigned shortcut keys allowing you to perform the action 
without having to access the shortcut menu. Refer to Table 7-1 in this chapter for a 
list of the shortcut keys available with the peak Editor. You may wish to make a 
copy of this page and keep it close to your keyboard.
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Autoscale Sets the axis boundaries to autoscale, presenting the 
signal in full scale.

Redraw Sets axis boundaries to its original view, allowing easier 
editing of peaks.

In many cases, the AutoScale and Redraw options will show very little difference. 
Both options are also used to return the view to its original presentation after 
zooming a report or to remove cross-hairs.

View Displays a cascading menu allowing you to:

• Show or hide the peak marks

• Specify X-axis in Time or Temperature

• Copy the contents of the window to the clipboard  as a 
metafile or as text, then paste it into another applica-
tion

Insert Enables you to insert experiments from another sample 
file.

Remove Removes the selected experiment from the Peak editor 
window; the data are not deleted from the sample file.

Save As Allows you to save the experiments in the window as a 
new sample file. For example, if you have a file opened 
containing five experiments but are only interested in two 
of them, you can remove the three of no interest and save 
the file with the remaining two.

Close Closes the Peak Editor window.
7-18                                                    May 04



ChemiSoft TPx Operator’s Manual Peak Editor
Overlay

The Overlay view displays up to 16 experiments, overlaid each on top of the other. This 
view does not allow you to select an experiment; you must switch to the Stacked view to 
select experiments. 

When you right-click in the graph area, the following shortcut menu is displayed:

The options on this menu are identical to the ones available in the Stacked view.  Remove 
is disabled on this menu because individual experiments cannot be selected in the Overlay 
view.
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Signals View

The Signals view displays all signals stacked one on top of the other. This allows you to 
view the relationship of peaks to temperature and auxiliary signal conditions that occurred 
during data collection.

When you right-click in the graph area of the Signals view, the following shortcut menu is 
displayed:

Some functions are assigned shortcut keys allowing you to perform the action 
without having to access the shortcut menu. Refer to Table 7-1 in this chapter for a 
list of the shortcut keys available with the peak Editor. You may wish to make a 
copy of this page and keep it close to your keyboard.

Autoscale Sets the axis boundaries to autoscale, presenting the 
signal in full scale.

Redraw Sets axis boundaries to its original view, allowing easier 
editing of peaks
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.

Edit Peaks

Edit Peaks allows you to edit the peaks of the selected experiment; the Peak Table dialog 
listing peak information for all peaks of the selected experiment is displayed.

The peak table remains on the screen until you select a different view; you cannot 
minimize or close the peak table until you switch views. You can move the peak table 
over to the side, top, or bottom or your screen. 

Use one of the following methods to select a peak:

• Highlight the desired peak in the Peak Table

In many cases, the Autoscale and Redraw options will show very little difference. 
Both options are also used to return the view to tis original presentation after 
zooming a report or to remove cross-hairs.

X-Axis Enables you to display the X-axis by Time or 
Temperature.

Copy Enables you to copy the graph area to the clipboard as a 
metafile or as text, then paste it into another application.

Close Closes the Peak Editor window.
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• Access the shortcut menu and select Next Peak or Previous Peak until you navigate 
to the desired peak

• Use Ctrl + N (advance to the next peak) or Ctrl + P (return to the previous peak) to 
navigate to the desired peak

When a peak is selected, its peak marks display in a light green color; the peak marks for 
unselected peaks display in red.

Peaks are edited by accessing functions from the shortcut menu which is displayed when 
you right-click in the graph area.

Some functions are assigned shortcut keys allowing you to perform the action 
without having to access the shortcut menu. Refer to Table 7-1 in this chapter for a 
list of the shortcut keys available with the peak Editor. You may wish to make a 
copy of this page and keep it close to your keyboard.

Autoscale Sets the axis boundaries to autoscale, presenting the 
signal in full scale.

Redraw Sets axis boundaries to its original view, allowing easier 
editing of peaks.

In many cases, the AutoScale and Redraw options will show very little difference. 
Both options are also used to return the view to tis original presentation after 
zooming a report or to remove cross-hairs.

Next Peak Advances you to the next peak.
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Previous Peak Returns you to the previous peak.

Insert New Peak Click in the graph area where you wish to insert a new 
peak; the peak is inserted where the cross-hairs meet.

Mark Left Edge A peak is automatically marked by the program; this 
option allows you to redefine the left edge. Simply place 
the mouse cursor where you wish to have the left edge 
marked, right-click, and select this option.

Mark Right Edge A peak is automatically marked by the program; this 
option allows you to redefine the right edge. Use the 
same method used for marking the left edge.

Find All Peaks This option is used to find all peaks automatically in the 
Peak Editor window. This is a rapid technique for 
integrating pulse chemisorption data. This option is most 
effective for narrow peaks with good baseline separation.

Delete Peak Removes the selected peak from the peak table. Deletes 
all peak information for a single peak.

Delete All Peaks Clears the Peak table of all data and removes all 
markings from the peaks.

View Displays a cascading menu allowing you to:

• Show or hide the peak marks

• Specify X-axis in Time or Temperature

• Enable or disable smoothing, and specify smoothing 
options if desired, as well as zero and/or invert signal 
options

• Copy the contents of the window to the clipboard as a 
metafile or as text, then paste it into another applica-
tion

Save Saves the peak table to the sample file.
May 04                                                      7-23 



Peak Editor ChemiSoft TPx Operator’s Manual
Set Calibration Allows you to choose a TCD calibration that is 
appropriate for the selected experiment.

Peak Integration 
Options

Displays the Peak Integration dialog.

This dialog allows you to adjust the parameters enabling 
you to optimize the results you obtain using the Find All 
Peaks option. Refer to Appendix E for additional 
information on the fields in this dialog.
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Fit Peaks

Fit Peaks allows you to separate overlapping peaks by fitting curves to the data, and save 
them as a new peak set in the Fit Peak table.

Right-click in the graph area to access the shortcut menu for creating the table.

Some functions are assigned shortcut keys allowing you to perform the action 
without having to access the shortcut menu. Refer to Table 7-1 in this chapter for a 
list of the shortcut keys available with the peak Editor. You may wish to make a 
copy of this page and keep it close to your keyboard.
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Autoscale Sets the axis boundaries to autoscale, presenting the 
signal in full scale.

Redraw Sets axis boundaries to its original view, allowing easier 
editing of peaks.

In many cases, the AutoScale and Redraw options will show very little difference. 
Both options are also used to return the view to tis original presentation after 
zooming a report or to remove cross-hairs.

Insert New Peak Set Enables you to define a region of the TCD signal that 
contains multiple peaks. The peak fitting and optimiza-
tion are constrained to this region of the TCD signal. 

To insert a new peak set: left click at the point you wish 
to insert the peak set, then right-click and choose this 
option.

Insert New Peak Allows you to insert a new peak into the selected peak 
set. If you are inserting a peak outside of a peak set, a 
peak set is automatically created. You cannot insert a 
peak in a negative area.

Mark (Peak Set) 
Left Edge

Changes the left edge of the peak set.

Mark (Peak Set)  
Right Edge

Changes the right edge of the peak set.

Change Peak Shape Allows you to choose the type of peak shape.

Log Normal Skewed This is a 4-parameter, log-normal shape that allows for 
skewed peaks, and is the default peak.

Gaussian This is the traditional symmetrical shape.

View Displays a cascading menu enabling you to copy the 
contents of the window to the clipboard as a metafile or 
as text, then paste it into another application

Delete Peak Removes the selected peak from the peak set table.
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Delete Peak Set Deletes the selected Peak set from the table.

Delete All Peaks Removes all peaks and peak-set information from the 
table.

Import Standard Peaks Imports the saved peak parameters from the Peak Edit 
screen and uses them for the initial estimates for the 
peak set.

Optimize Peaks Locates the best peak height, width, and skewness after 
initial peak estimates have been given.

Auto Fit Locates the best number of peaks and parameters from 
the Peak Set without user estimates.

Display Allows you to enable or disable smoothing, and specify 
smoothing options if desired, as well as zero and/or 
invert signal options

Save Save the current peak set.

Close Closes the Peak Editor window.
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Report Examples

This section contains examples of some of the types of reports that may be generated by 
the ChemiSoft program. You can customize portions of some reports, such as the title and 
the axes of graphs, using the Report Options tab of the sample information file 
(Advanced format only). If reports are printed to the Screen, there are many ways in 
which they may be manipulated and customized.
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Temperature-Programmed Desorption

TCD Signal vs. Time
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TCD Signal vs. Temperature
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Temperature vs. Time
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Pulse Chemisorption

Report
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TCD Signal vs. Time
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Summary
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Loop Calibration

Report
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TCD Signal vs. Time
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8.  OPTIONS MENU

The Options menu enables you to configure the system to suit your laboratory’s 
requirements. With the options on this menu, you can:

• Select a default for the sample file presentation
• Specify or edit program defaults
• Specify data presentation modes
• Specify printer/plotter options
• Specify a directory for predefined parameter files

Description

Listed below are brief descriptions of the Options menu contents. Detailed descriptions 
are found in this chapter.

Option Presentation Allows you to set the default for the sample information 
file presentation format. Choose between Basic, 
Advanced, or Restricted format. Page 8-3.

Data Presentation Allows you to specify the way in which data are 
presented on the screen and in printed reports. Page 8-6.

Sample Defaults Allows you to specify default values for sample and 
parameter files. Page 8-7.

Gas Defaults Provides a table defining characteristics of gases used 
for analysis, to be used in calculations. Page 8-14.
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Active Metal Defaults Provides a table defining characteristics of metals 
contained in samples, to be used in calculations. 
Page 8-15.

Environmental Defaults Allows you to enter the current environmental 
conditions, so that their effect on analyses can be 
accounted for in calculations. Page 8-16.

System Configuration Allows you to specify the printer and/or plotter to which 
you wish to send reports. Page 8-17.

Parameter Files Directory Allows you to specify a directory for predefined 
parameter files displayed in the drop-down lists of the 
Basic sample information dialog. Page 8-18.
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Option Presentation

Sample information file dialogs may be presented in three formats: Basic, Advanced, and 
Restricted.  

Advanced Format 

Presents all four parts of the sample information file as a group of dialog boxes with 
index card-type tabs (the Collected data tab does not appear until after analysis). Clicking 
on each tab opens an associated dialog. 

Use this format when you wish to edit the parameter files and create customized Sample 
Information files, rather than using standard parameter files. Just click on the tab of the 
parameter you wish to edit, or use Next and Prev to navigate through the dialogs.

The sample information file for the Basic and Advanced format contains a toggle 
button for conveniently switching back and forth between the two formats.
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Basic Format 

Presents the entire sample information file in a single dialog box. 

Basic format makes it easy to create sample files using previously defined parameter files 
in convenient drop-down lists. Each time you select a file from the list, its conditions are 
listed in the window directly below. If editing is required, you can easily switch to the 
Advanced format by clicking Advanced.
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Restricted Format 

Restricted format is identical to the Basic format, except that certain menu options are 
disabled. You also cannot switch to the Advanced format. This format is password-
protected and typically is used in laboratories where analysis conditions must remain 
constant, for example, in the pharmaceutical industry.

When you choose the Restricted format from the Options menu, the Option Presentation 
Password dialog is displayed.

You can enter any password (up to 31 characters) to enable the Restricted format. The 
same password must be used to exit the Restricted format. For example, if you enter 
“password” to enable the restricted format, then you must enter “password” to exit. If you 
forget the password, open the system INI file and navigate to the Private section. The 
password is shown immediately following “OptionPresentationPassword.” Make a note 
of the password, exit the INI file, and enter the password where prompted. Deleting the 
password from the INI file will not disable the Restricted mode; you must enter the 
password using the Password dialog to exit the Restricted format.
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Data Presentation

The options on the Data presentation drop-down menu allow you to specify how you 
wish tabular and graphical data to be displayed onscreen and in printed reports. 

Pressure in mmHg
Pressure in kPa

Allow you to choose how data are displayed on the 
screen and in printed reports. 

Solid graph grid lines
Dotted graph grid lines

These options allow you to choose whether you wish to 
have grid lines display on your report.

Show graph grid lines Allows you to specify whether or not you wish to have 
grid lines display on graphs and, if so, what type. You 
can choose to have Horizontal, Vertical, Both, or None.
8-6                                                    May 04



ChemiSoft  TPx Operator’s Manual Sample Defaults
Sample Defaults

This option allows you to specify default parameters for the dialogs used to create sample 
information files. 

Sample defaults are the values you see in the sample information editors when you create 
a new sample file. For efficiency, it is best to specify defaults for materials you most 
commonly analyze. You can always edit the values in the sample file when it is created. 

The dialog used for specifying default parameters is presented in the same format you 
have selected as your default for sample information files. Sample defaults cannot be 
specified using the Restricted format. The default values that appear in the Restricted 
sample information presentation are the same as specified for the Basic presentation.

Basic

Sequence Allows you to specify a default sequence for the file 
name. The number you enter is incrementally sequenced 
each time you create a file. It is the number that appears 
in the File name field when you select File, Open, 
Sample Information.

• Use numbers, letters, or other printable characters, 
such as dashes.

• Include at least three numbers

• Use up to eight characters.

• Do not use characters such as * or ?. Refer to your sys-
tem operating manual for more information.
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Sample Allows you to enter an additional identification that 
provides more information than the sequence number.

You can edit the label for the prompt using the field on 
the left. For example, you may prefer to use Test or 
Material. You can use up to 20 characters.

The field on the right is used to specify a format for the 
sample identification.

• Use numbers, letters, or other printable characters, 
such as dashes.

• Use up to 42 characters, plus the $ symbol.

• Include the automatically generated file name as part 
of the identification by using the $ symbol where you 
want the sequence number to appear 

For example, if the sequence number is 000-001, enter 
the sample identification as follows:

Lab #25 - $

The resulting sample identification for the first 
Sample Information file would be:

Lab #25 - 000-001

and for the second one:

Lab #25 - 000-002, and so on.

Replace All Click this button to copy the values from an existing 
sample information file into the default file you are 
creating. A dialog is displayed so that you can choose 
the file containing the values you wish to copy. Click 
OK; the values are copied into the defaults automatically. 
You may then edit the values in the default file without 
altering the sample information file from which they 
were copied.

Mass Enter a default value for the sample mass. This value can 
be edited in the sample file if needed.
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Analysis Conditions From the drop-down list, choose a default analysis 
conditions file. The list contains the analysis conditions 
files included with the software, as well as any you have 
created and stored in the parameter file directory 
(selected on the Options menu).

Each step in the analysis is listed in the Synopsis 
(directly below the drop-down list) and its parameters 
can be viewed by clicking View.

Report Options From the drop-down list, choose a default report options 
file. The list contains the report options files included 
with the software, as well as any you have created. 

Directly below the drop-down list is a list of the reports 
available. The reports preceded with a check mark are 
the ones selected for the file you choose. Select or 
deselect or desired.

Save Saves the defaults you have selected.

Close Closes the dialog. If there are any unsaved changes, you 
are prompted to save before the dialog closes.

Advanced Changes the presentation to the Sample Defaults dialog 
to the Advanced presentation.
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Advanced

When you select Sample Defaults while in the Advanced format, the Sample Defaults 
dialog is displayed in this manner.

Sequence Allows you to specify a default sequence for the file 
name. The number you specify is incrementally 
sequenced each time you create a file. It is the number 
that appears in the File name field when you select File, 
Open, Sample Information.

• Use numbers, letters, or other printable characters, 
such as dashes. At least three numbers must be 
included.

• Use up to eight characters.

• Do not use characters such as * or ?. Refer to your sys-
tem operating manual for more information

Replace All Click this button to copy the values from an existing 
sample information file into the default file you are 
creating. A dialog is displayed so that you can choose 
the file containing the values you wish to copy. Click 
OK; the values are copied into the defaults automatically. 
You may then edit the values in the default file without 
altering the sample information file from which they 
were copied.
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Sample Allows you to enter an additional identification that 
provides more information than the sequence number.

In the field on the left, you can edit the prompt for the 
sample identification. For example, you may prefer to 
use Test or Material. You can use up to 20 characters.

In the field on the right, you can specify a format for the 
sample identification.

• Use numbers, letters, or other printable characters, 
such as dashes.

• Use up to 42 characters, plus the $ symbol.

• Include the automatically generated file name as part 
of the identification by using the $ symbol where you 
want the sequence number to appear 

For example, if the sequence number is 000-001, enter 
the sample identification as follows:

Lab #25 - $

The resulting sample identification for the first 
Sample Information file would be:

Lab #25 - 000-001

and for the second one:

Lab #25 - 000-002, and so on
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Operator
Submitter

These fields contain the name (or other identification) of 
the operator performing the analysis, and the department, 
customer, etc, that submitted the sample for analysis. 

• In the fields on the left, you can edit the prompts if 
desired; you can enter up to 20 characters.

• In the fields on the right, you can specify default 
names or titles; you can use up to 42 characters 
(including the $ symbol).

• Include the automatically generated file name as part 
of the identification by using the symbol $ where you 
want the sequence number to appear. Refer to the 
example in the previous section.

• Select Omit to prevent the fields from appearing on the 
sample information dialog.

Mass Enter a default value for the sample mass. You can edit 
this value in the sample file if needed.

Comments Use this window to enter pertinent information. Any 
information you enter in this window is printed in the 
report header. You can edit the comments in the sample 
file if needed.
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Analysis Conditions Defaults

The default settings for analysis conditions files are set using the Advanced format 
sample information file defaults, regardless of whether you plan to create independent 
analysis conditions files, or complete analysis conditions dialogs as part of the sample 
information file.

From the Options menu, choose Sample Defaults when Advanced is selected as the 
default format. The Advanced presentation of the Sample Defaults dialog is displayed; 
click the Analysis Conditions tab. The fields on the sample defaults dialog are identical to 
the ones on the Advanced format sample file, which is described in Chapter 5.

Report Options Defaults

The default settings for report options files are set using the Advanced format sample 
information file defaults, regardless of whether you plan to create independent report 
options files, or complete report options tabs as part of the sample information file.

From the Options menu, choose Sample Defaults when Advanced is selected as the 
default format. The Advanced presentation of the Defaults dialog is displayed; click the 
Report Options tab. The fields on the sample defaults dialog are identical to the ones on 
the Advanced format sample file, which is described in Chapter 5.

If you repeatedly use the same sample preparation techniques, then vary the 
analysis conditions, you may wish to make your default analysis conditions the 
preparation steps alone. Then the preparation steps will always be in place when 
you create a new file, ready for you to add analysis steps as needed.

When the first experiment is inserted into an analysis conditions file, its initial 
values are set by the first experiment step in the default analysis conditions. 
Including a single “default” experiment step in your default sample file will ensure 
that new experiments are initialized properly.
May 04                                                      8-13 



Gas Defaults ChemiSoft TPx Operator’s Manual
Gas Defaults

In order to characterize the gases used in an analysis, a symbol and the % of the gas that 
is active concentration must be specified. A table is provided containing default values; 
these values can be edited simply by highlighting the field and entering the desired value.

Symbol Contains the standard symbol (mnemonic) for each gas 
listed.

% Active Concentration Displays the percent of the gas mixture that is composed 
of the reactive gas versus an inert filler.

Insert Enables you to insert a new gas into the table above the 
selected line.

Delete Deletes the selected gas from the table.

Clear Clears the table of all gases except one; one is required.
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Active Metals Defaults

In order to characterize the active metals in a sample, certain properties of the metals must 
be defined. A table containing default values for the following properties is provided with 
the ChemiSoft program; however, you can edit the contents as desired.

The values defined in this table are the defaults used when a new entry is inserted 
into the metal table of the Pulse Chemisorption report options. Changing this table 
does not affect the tables within the report options files.

Atomic Weight The atomic weight of the element.

Atomic Area The atomic cross-sectional area of the element.

Density The density of the element.

Stoichiometry Factor A factor which expresses the ratio between the number 
of active metal atoms and the number of adsorbate 
molecules. This number varies, based on the adsorbate 
used. The most common value should be entered into the 
defaults table. Within the Pulse-Chemisorption report 
options, the value for a specific analysis can be set.

Insert Enables you to insert a new element and its values into 
the table above the selected line.

Delete Deletes the selected element from the table.

Clear Clears the table of all gases except one; one is required.
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Environmental Defaults

To ensure accurate loop calibration and BET surface area data, you should enter current 
environmental conditions every day, or whenever there is a significant change in one or 
more of the environmental conditions. These values are used in some calculations to 
account for the effect of environmental conditions on the analysis. When you select this 
option, the Environmental Defaults dialog opens.

As an analysis is started, these parameters are saved in the Collected Data portion of the 
sample information file. (Collected Data can be viewed in the sample file in Advanced 
format only.)

Ambient temperature Enter the temperature of the room in which the analyzer 
is located.

Ambient pressure Enter the atmospheric pressure of the room in which the 
analyzer is located.

Saturation pressure (Po)
of adsorbate

Enter the saturation pressure of the adsorbate gas in the 
room in which the analyzer is located. Disregard this 
field if the saturation pressure of the adsorbate gas is not 
pertinent to your analysis.
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System Configuration

This option allows you to specify printer and plotter destinations for data output. When 
you select this option, the System Configuration dialog is displayed.

Printer name 
Plotter name

The printer and plotter names are shown exactly as they 
appear in the Operating System Print Manager. 

Select Default if you wish to use the default printer and 
plotter as designated in the Print Manager. 

If you wish to change the default printer, deselect 
Default. Then choose another printer (or plotter) from 
the drop-down list of installed printers (plotters).
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Parameter Files Directory

This option allows you to specify a location for the predefined Analysis conditions and 
Report options files displayed in the drop-down lists on the Basic and Restricted Sample 
Information dialogs.

The current directory is displayed above the drives/directory window. The default 
directory is params and includes several parameter files supplied with the Chemisoft 
program. If you specify a different directory, these files will not be included in the drop-
down lists unless you copy (or move) them to the new directory.

If you wish to continue using the params directory for parameter files, be sure to save any 
files you create to this directory; otherwise they will not be included in the drop-down 
lists(s).
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9.  ORDERING INFORMATION

Accessories for the ChemiSoft TPx option can be ordered using one of the following method:

• Call our Customer Service Department at (770) 662-3636
• Access our web site at www.micromeritics.com
• Contact your local sales representative

When ordering, please use the information provided in this chapter to place your order:

Part Number Item and Description

003-51134-00 Fuse; 3AG Slow-Blow, 5 A, 250 V

003-51208-00 Fuse; 5 x 20 mm Slow-Blow, 2.0 A, 250 V

004-32187-00 Gloves, cotton

027-32600-00 Insulating cover, right side

027-32600-01 Insulating cover, left side

291-53904-00 Thermocouple, sample

200-60845-00 Extension cord, for sample thermocouple

291-53901-00 Thermocouple, furnace

291-63700-00 Cable, thermocouple
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A.  FORMS

This appendix contains the following form:

• Programmer worksheett

Copy and use this form as needed.
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Programmer Worksheet

This worksheet is used to record target setpoints, ramp rates, and dwell times when programming the 
controller for your analysis. (Use this as your original, making a copy as needed.) 

Type of Analysis:___________________________________________

SEG.n
(Segment )

rmP.r dwEll

End
tGt

(Target Setpoint)
ºC

rAtE
(Ramp Rate)

ºC/minute

dur
(Dwell Time)

minutes
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B.  ERROR MESSAGES

This appendix contains a numerical listing of the error messages associated with the Chemi-
Soft program.

2201- Cannot execute report subsystem.
2202- Cannot execute Peak Editor subsystem.
2203- Cannot execute 028 controller subsystem.

2401- FATAL ERROR: (Error message)

2430- Error accessing file (file name), error code = (number)

The 1000-series error messages (used primarily for software testing) are not 
included in this appendix. These errors should not occur during normal operation. 
If you receive a 1000 series error message or an error message not listed in this 
appendix: record the error message, make backup copies of any files involved, 
then contact your service representative.

Cause: The software for the report subsystem has been corrupted and cannot 
be started.

Action: Reinstall the software.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Action A: Hard disk may be damaged.

Action A: Run diagnostics.

Action B: A software error occurred when the file was accessed.

Action B: Contact your service representative.
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2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI 'FILE_READ' request.

2433- New entries have been found in this directory. Refresh the directory 
information?

2434- File (file name) - Subset # (number) wrote wrong amount of data.

Cause: The hard disk does not have enough space left to perform the opera-
tion.

Action: Copy files not used regularly from the hard disk to diskette, delete 
them from the hard disk, and then try the operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: Several files (sample information, analysis conditions, or report 
options) have been added to this directory by some function other than 
the AutoChem program.

Action: Click Yes to update the directory information with data from each new 
file. This operation may take a few minutes.Click No if you do not 
want to spend the time updating the directory information. 

This option may be feasible if a large number of files has been copied 
into the directory and you know the name of the file you wish to 
access.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.
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2436- Path specification (path name) is invalid.

2437- File (file name) does not exist.

2438- Disk drive (letter): is inaccessible.

2439- Could not register file.

2440- Subset not found.

2441- Seek within file failed.

2442- Had header in subset file.

2443- Subset owner denied access.

2444- Not a valid file format.

2445- Subset wrote the wrong amount of data.

2446- Error reading data.

2447- Error writing data.

2448- File directory (path name) is invalid. Resetting to the installation directory.

Cause: You entered an invalid path name and/or extension.

Action: Enter a valid path name (including the proper extension) and press 
Enter.

Cause: You entered an invalid file name.

Action: Enter the name of an existing file or select a file name from the Files 
list window.

Cause: You selected a disk drive that is presently inaccessible.

Action: Ensure that the disk in the disk drive is not write-protected

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.
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2449- This field does not contain a valid file specification.

2450- Sample Defaults may not be edited while this operation is in progress. Do you 
wish to save and close the Sample Defaults edit session?

2452- Attempt to write MICATTR.DIR in read only mode. File (file name).

2453- Attempt to append MICATTR.DIR in read only mode. File (file name)

2454- Too many selections for a print-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories list to move to the correct directory.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your operating sys-
tem or Windows manual and reenter the name.

Cause: You are in the process of initiating an automatic analysis (an analysis in 
which sample files are created using the defaults) while editing the 
defaults.

Action: Finish your edit session of the defaults and close the dialog. Then 
restart the automatic analysis.

Cause: The Read-Only attribute is turned on in the application's 
MICATTR.DIR file (this file exists in each folder containing sample or 
parameter files).

Action: Use Windows Explorer to access the folder containing the 
MICATTR.DIR file and disable the Read-Only option.

Cause: You selected too many files for this operation.

Action: Select only the number of files specified in the message.
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2456- Insufficient file handles available. Application cannot continue.

2457- Results cannot be displayed. More than (number) windows are currently dis-
playing or printing results.

2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

2461- No instruments are in operation. This application will unconditionally 
terminate.

Cause: You have more than 50 files open at the same time.

Action: Refer to the manual for your operating system and set the limit for 
open files to 50 or greater.

Cause: You have too many windows open in the application.

Action: Close some of the open windows.

Cause: You are attempting to exit the application while the instrument is per-
forming a critical operation. This operation must be completed before 
the application can be stopped.

Action: Wait a short time and attempt to stop the application again.

Cause: An analyzer must be active for the application to operate. The initial-
ization of the analyzes configured with the Setup program has failed. 
The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the analyzer's failure to initialize. See the instructions for that mes-
sage. 

Action B: Ensure that the analyzer is attached to the computer. Verify that the 
analyzer has the power switch in the ON position. If the application 
continues to fail in its attempts to initialize the analyzer, contact your 
service representative.
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2478- Error copying sequential data segment.

2480- File (name) cannot be analyzed. It is currently being edited.

2481- Error accessing the sample information file (name).

2482- File (file name) cannot be opened for writing. It is already in use.

2483- An analysis cannot be performed on (file name). It is open for editing and con-
tains errors.

Cause: An internal processing and/or hardware error occurred while accessing 
a portion of a sample file.

Action: Confirm that the media being accessed does not contain errors; for 
example, you may wish to use a utility such as ScanDisk. 

Contact your service representative if you continue to receive this mes-
sage.

Cause: You attempted to start an analysis using a file that is open for editing.

Action: Finish editing the file, save and close it; then restart the analysis.

Cause: An unexplained error prevents you from accessing this file.

Action: The hard disk drive may be corrupt. Run diagnostics.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation

Cause: You attempted to start an analysis using a file that contains errors and is 
open for editing.

Action: Finish editing the file, save and close it; then start the analysis.
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2484- The edit session for (file name) must be saved before the analysis. Save 
changes and proceed with the analysis?

2486- Cannot construct (name) report type. Program will terminate.

2487- Cannot start report generator. Error code (number). Program will terminate.

2488- File (file name) cannot be opened for editing. It is already in use.

2490- No '.INI' file present. Application will terminate.

Cause: You attempted to start an analysis using a file that contains unsaved 
changes and is still open.

Action: Click Yes to save the changes and proceed with the analysis. Click No 
to cancel the analysis and continue editing the file.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this mes-
sage.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this mes-
sage.

Cause: The file you specified is already open for editing.

Action: Check the windows list to locate the other edit session.

Cause: The ASCII file containing initialization information and system 
options information used during program startup does not exist.

Action: Run the AutoChem Setup program (located on the applications CD), 
select Change the number of units and enter the pertinent information.
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2491- Highlighted fields contain errors. Please correct the errors before closing.

2492- This field's entry is invalid.

2493- An entry is required for this field.

2494- Value is out of the valid range.

2495- Value is out of the valid range. Enter a value between (value) and (value).

Cause: The highlighted fields contain invalid entries. You will not be able to 
close the dialog box until you correct the errors.

Action: Check the entries, correct the errors, and close the dialog box. 

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: This field contains an invalid entry.

Action: Enter or select an appropriate value.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select a value within the indicated range. 
The valid range is shown in the information bar across the bottom of 
the dialog.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter a value between the range indicated.
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2496- Invalid number.

2497- This field contains an invalid character.

2498- The requested change to the Sample’s status is invalid at this time.

2499- Sequence number must contain at least 3 digits.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered data) could not be done.

Action: Contact your service representative if you continue to receive this mes-
sage. Record the name of the sample file in which the problem 
occurred.

Cause: You tried to enter a sequence number that did not contain at least three 
digits.

Action: Enter a sequence number that contains at least three digits.
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2500- All sample files that can be created using the sequence number pattern already 
exist. You may want to modify the next sequence number.

2502- Error writing to file (name) during print. Error code: (number).

2503- Error converting file (name). Could not create DIO intermediate file.

2504- Cannot create output file for sample (name).

2505- Error Logger cannot be initialized. Error code (number). Program will exit.

Cause: No more sample information files can be created using the currently 
specified file sequence number.

Action: Select Options, Sample defaults form the main menu and enter a new 
sequence number.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause A: Insufficient space is available on the hard disk. The DIO file is placed 
in the directory specified by the TEMP environment variable.

Action A: Determine if there is sufficient space on the drive where the TEMP 
directory is located.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative.

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your service repre-
sentative if you continue to receive this message.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.
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2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

2507- Error opening file (name) for printing. Error code: (number).

2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

2510- (sample file) Error parsing reports from file (name). Reports cannot be 
produced.

Cause: The selected output device is not installed.

Action: Select a different output device in the System Configuration dialog. 
Install the device using the Control Panel, Printers operation.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

Cause: An error occurred while the program was opening a file necessary to 
the report operation.

Action: Use the name given in the error message to investigate. Contact your 
service representative if you continue to receive this error message.

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and 
remove the invalid character.
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2511- Print job (name) has been cancelled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) has been canceled.

2513-  Unable to read the calibration file (file name).

Cause B: The system was unable to create the usual temporary files during the 
report, possible due to insufficient disk space.

Action B: Check the space available on the had disk.

Cause C: An internal processing error occurred.

Action C: Contact your service representative.

Cause: The disk drive does not have enough space for the temporary file 
required by the Windows Print Manager. Therefore, printing of the 
requested report has been canceled.

Action: Delete unnecessary files form the disk. You will require at least five 
megabytes of free space for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.

Cause: The calibration file selected for loading is not valid or cannot be read.

Action: Confirm the media containing the alleged calibration file has no prob-
lems.
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2514-  Unable to write the calibration file (file name).

2534- Error opening file (name) for printing. Error code: (number)

2547- The instrument is busy. Exiting the application will result in the termination of 
the analysis. Continue with program exit? (Yes, No)

Cause: An attempt to Save calibration data has failed due to possible media 
problems

Action A: Confirm the media containing the alleged calibration file has no prob-
lems.

Action B: Choose an alternate media to Save the calibration data.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.

Cause: You attempted to exit the application while an analysis is in progress. 

Action: If you are not concerned with cancellation of the analysis, click Yes to 
continue the exit; otherwise select No and allow the analysis to finish.
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4200- At least two experiments are needed for this report.

4209- New steps cannot be inserted in the synopsis at any point that precedes the 
step that is currently being executed.

4210- No new steps may be inserted. Analysis is complete.

Cause: The report options for this report do not include the selection of at least 
two experiments.

Action: Open the sample file and choose at least two experiments for this 
report.

Cause: The analysis has already progressed past the point at which you 
attempted to insert a step; therefore the step would not be performed.

Action: Insert the new analysis step after the step that is currently being exe-
cuted.

Cause: The analysis for this sample file has ended. You cannot insert a step in 
a sample file whose analysis is complete.

Action: The analysis conditions for a completed sample cannot be changed. 
You can, however, create a new sample file and use the Replace button 
to copy the completed file. Then, add the desired step to the new sam-
ple file. A new sample can be analyzed using the new (edited) sample 
file.
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4214- This analysis exceeds the maximum allowed length.

4219- At least one experiment must be selected and at least one box checked.

4220- Unexpected I/O error accessing data for an experiment in sample (name).

Cause: The current analysis conditions script contains the maximum number 
of allowed steps (1000). You cannot add another step.

Action: Divide the analysis steps into two or more sample information files. 
Allow the sample tube to remain undisturbed on the analyzer while you 
repeatedly start analyses using these sample information files in 
sequence. When you divide the steps between sample information 
files, plan your divisions so that the ending conditions of one file and 
the initial experiment conditions of the next file facilitate the continu-
ing analysis. The data from the various sample files can be integrated 
using the Peak Editor since multiple sample files can be edited at once. 
Note that the maximum number of experiments that can be loaded into 
Peak Editor at one time (regardless of the number of sample files) is 
16.

Cause: You attempted to export the collected data from a sample file, but not 
all of the required fields on this dialog have been completed correctly.

Action: Choose at least one experiment for export and select either Peak sum-
maries, Measurements, or both.

Cause: An unexpected disk error occurred while you were attempting to 
access experiment data.

Action: The hard disk drive may have failed or may be corrupted. Run diag-
nostics.
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4221- Cannot append an experiment to Sample file (name). Maximum size may be 
exceeded.

4222- The Active Metal Table Options dialog box does not specify a stoichiometry 
factor for element (name). One (1.0) was substituted for this value in the calculations.

4223- No element in the Active Metals Table Options dialog box has a '% of Sample 
Weight' value greater than zero.

Cause: You selected Save As from the experiment editor and elected to append 
the loaded experiments to an existing file. Either the existing sample 
file already contains the maximum number of allowed experiments or 
the hard disk is full.

Action: Verify that the sample file contains fewer than 20 experiments and that 
there is at least 20 megabytes of disk space available on the target disk 
drive.

Cause: The Pulse Chemisorption report was selected and requires a valid stoi-
chiometry factor for calculations. The Active Metal Table does not 
contain a valid stoichiometry factor for the specified element.

Action: Open the sample file in Advanced presentation. Click on the Report 
Options tab. Select the Pulse Chemisorption report, then click Edit. 
Specify a valid stoichiometry factor for the metal named in the error 
message. Save and close the file, then print the report.

Cause: The Pulse Chemisorption report was selected. None of the metals in the 
Active Metal Table are designated as being part of this sample.

Action: Edit the Active Metal Table in the Pulse Chemisorption report options 
and specify a % of Sample Weight greater than zero for at least one 
metal.
B-16                                                    May 04



Appendix B ChemiSoft TPx Operator’s Manual
4224- The first peak is larger than the last. This report assumes inverse 
chemisorption.

4225- No reports were selected.

4226- No experiments were selected for inclusion in this report.

4227- The data requested on this report are not available.

Cause: This message appears on the Pulse Chemisorption Report when an 
inverse chemisorption experiment is reported.

Action: None required; informational only. If this experiment is not actually an 
inverse chemisorption experiment, it is inappropriate for this type of 
data reduction.

Cause: A report was requested, but there are not reports selected in the sample 
information file.

Action: Open the sample information file and edit the report options. Make 
sure that at least one report type is selected (double-click on a report to 
select it; a check mark appears next to selected reports).

Cause: The report type that was selected for printing requires that you specify 
which experiments should be included in the report. No experiments 
were selected for this report.

Action: Open the sample file in advanced presentation. Click on Report 
Options, then on the selected report type. Click Edit and choose the 
experiments you wish to include in this report. If none of the experi-
ments within the sample file are applicable to this type of report, dese-
lect the report type from the list shown on the Report Options dialog.

Cause: The data requested on a report, such as the Auxiliary 1 signal, are not 
contained within any of the selected experiments.

Action: Open the sample file in advanced presentation. Click the Report 
Options tab and deselect this report type. Or, click the report type and 
click Edit. Change the options so that they request data contained 
within the file.
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4228- This sample file does not contain an experiment which can be used in a (name) 
calibration.

4229- The calibration data for experiment (name) may already be loaded. You may 
delete duplicates after loading.

4230- The destination of a Grams/32 export must be a file.

4231- An error occurred exporting experiment (number) from the sample '(file name)'.

Cause: You attempted to load a sample file that does not have valid peaks for 
this type of calibration into the calibration editor. A Gas Concentration 
calibration requires a TCD calibration experiment. A Spread Peaks cal-
ibration requires a Vapor Calibration experiment. A User-Defined 
Peaks calibration will accept any experiment type with valid peaks 
defined.

Action: Select a sample file that contains the appropriate experiment type.

Cause: You attempted to load calibration data from an experiment that was 
already loaded.

Action: Delete any duplicate peaks from the peak table and continue with the 
calibration.

Cause: You attempted to export data to the Grams/32 application using an 
invalid destination. Data exported to the Grams/32 application must be 
printed as a disk file.

Action: Repeat the export operation and choose File as the destination.

Cause: You attempted to export data to the Grams/32 application when an 
error occurred. Either the disk file required by the export could not be 
created or the named experiment contains invalid data.

Action: Ensure that sufficient disk space (at least 20 megabytes) to contain the 
exported file is available. Also examine the selected experiment with 
the Peak Editor to ensure that it contains valid data.
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4232- At least two peaks are required to determine heat of desorption.

4233- Default mass spectrometer file directory (path name) is invalid. Resetting to the 
installation directory.

4234- File (name) is not a mass spectrometer data file.

4235- The mass spectrometer file (file name) cannot be opened for reading.

Cause: The heat of desorption is determined by fitting data obtained at differ-
ent temperature ramp rates. At least two data points must be present for 
the fit to be performed.

Action: Repeat the analysis with at least two experiments that have different 
ramp rates. Refer to Appendix J in the operator’s manual for a tutorial 
on performing a TPD analysis.

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories list to move to the correct directory.

Cause: You selected a file that does not contain appropriate mass spectrometer 
data.

Action: Choose a file that contains data collected by the Pfeiffer Vacuum (for-
merly Balzers) mass spectrometer which uses the QuadStar software.

Cause: A file-access error occurred when you attempted to access the mass 
spectrometer file.

Action: Ensure that you have selected a valid file name, and that you have the 
required permissions to read mass spectrometer files.
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4236- The calibration data file (name) was not created with this instrument.

4237- Peak processing cannot be performed. The mass spectrometer data cannot be 
imported.

4238- Peak Editor cannot be started.

4239- A calibration from instrument S/N (number) is required to calibrate experiment 
(name).

Cause: You attempted to load a calibration file containing data collected on an 
instrument different from the current one.

Action: Choose a sample file containing calibration data that were collected on 
the current instrument.

Cause: The mass spectrometer data did not include identifiable peaks.

Action: Review the mass spectrometer data; select a different mass spectrom-
eter data file.

Cause: You attempted to open the Peak Editor, but one of its components is 
missing.

Action: Reinstall the software.

Cause: You attempted to associate a calibration file with a sample file, but 
were unable to complete the operation. In order to associate a calibra-
tion file with a sample file,  the files’ analyses must have been per-
formed on the same instrument. The instrument must be connected to 
the computer for its calibration files to be available.

Action: Ensure that the instrument with the designated serial number is con-
nected to the computer and is active.
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4240- Error writing calibration information. The calibration of experiment (name) 
could not be changed.

4241-  TCD Calibration is required for the calculations of this report.

4243-  Ambient Temperature should be > 10º C.

4244-  Average Syringe Area should be > 0.

4245-  The peak table contains [nn] peaks. Exactly 6 peaks are required for loop 
calibration.

Cause: The calibration information for an experiment could not be changed 
because of an error writing to the disk file.

Action: The hard disk drive may have failed or it may be corrupt. Run diag-
nostics. Check that no other application has write access to the sample 
file.

Cause:  This report requires that TCD Calibration be applied to the sample file.  

Action:  BET, Langmuir, and Total Pore Volume reports require inclusion of a 
TCD Calibration. Use the Peak Editor command on the Reports menu 
to set a TCD Calibration for the file (done on the Edit Peaks view).

Cause:  The value for the ambient temperature is out of range; the sample file 
may be corrupt.

Action:  Contact your Micromeritics service representative.

Cause:  There is no peak data for the Loop calibration.

Action:  Using the Peak Editor, edit the peaks; insert new peaks if possible.

Cause:  You do not have six peaks in the loop calibration; six are required.

Action:  Using the Peak Editor, insert new peaks until there is a total of six.
May 04                                                  B-21 



Chemisoft TPx Operator’s Manual Appendix B
4375- Cannot insert peak with negative height.

4376- Auto Fit cannot be executed unless a valid peak-set is selected.

4377- This operation cannot be performed on a negative peak set.

Cause: You attempted to insert a peak below the peak set’s baseline.

Action: Insert the new peak above the peak set’s baseline and/or adjust the 
baseline.

Cause A: You attempted to auto-fit a peak set, but there is no peak set current 
active.

Action A: Click on the desired peak or peak set in the peak-fit table to select a 
peak set.

Cause B: You attempted to auto-fit, but there are no peak sets in the experiment.

Action B: Insert a new peak set into the experiment. Then choose Auto Fit to find 
all peaks in the set.

Cause A: You attempted to insert a peak in a negative peak set.

Cause B: You attempted to move the boundaries of a negative peak set.

Cause C: You attempted to change the shape of a peak found within a negative 
peak set.

Cause D: You attempted to optimize the peaks of a negative peak set.

Cause E: You attempted to auto-fit the peaks of a negative peak set.

Action: Invert the graph to make the peak set positive, then repeat the opera-
tion.
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6002- File cannot be opened for writing. It is already in use.

6003- Time-out on wait. The wait on a single event or wait on multiple events timed 
out.

6004- Requested device is not online or it is missing. The device cannot be detected.

6005- A buffer overrun occurred. The acquisition transfer buffer located in PC mem-
ory has overrun.

6006- Invalid scan frequency specified. Could not program the unit to scan or update 
at requested rate.

6007- The driver cannot properly communicate and/or initialize the device.

6008- Invalid digital I/O device type.

6009- Could not allocate the needed memory. Memory could not be allocated by the 
driver.

6010- Invalid device handle.

6011- Communications failure. System will shut down.

6012- The sample has an invalid status and cannot be used for this analysis.

Cause: You attempted to access a file that is in use by some other part of the 
application.

Action: Close the window or application that is currently using the desired file 
and try again.

Cause: An internal processing error has occurred.

Action: A Exit the ChemiSoft program and disconnect the USB cable from the 
controller. Then reconnect the cable, and restart the application. If the 
problem persists, try Action B.

Action: B Restart the computer, then restart the application. If the problem per-
sists, contact your Micromeritics service representative.

Cause: Only sample files with a status of No analysis can be used for analysis. 
The sample file you have selected has a status other than No analysis.

Action: Select a sample with a status of No analysis.
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6227- This instrument has no TCD calibration file to edit.

Cause: You are attempting to edit a TCD calibration file. No TCD calibration 
files currently exist for this instrument.

Action: Select TCD, New from the Unit menu to create a TCD calibration file.
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C.  CALCULATIONS

Volume at STP

Volume at standard reduction of gas data to Standard Temperature Pressure (STP) 
conditions (273.13K and 760 mmHg).

VSTP = Volume at STP, mL
Va = Volume at ambient temperature and pressure, mL
Ta = Ambient temperature, °C
Pa = Ambient pressure, mmHg

Injection Loop Calibration

The Injection Loop calibration applies to the Pulse ChemiSorb 2750 only. These 
equations are used during calibration of a dose loop

(1)

(2)

VSSTP = Volume of syringe at STP, mL
VS = Physical volume injected from syringe, mL
Ta = Ambient temperature, °C
Pa = Ambient pressure, mmHg
Vl = Effective loop volume (at loop temperature), mL
Al = Average peak area of loop injections
AS = Average peak area of syringe injections
CA = % of active gas, typically 100%

VSTP Va
273.15

273.15 Ta+
---------------------------- 
  Pa

760 mmHg
---------------------------- 
 =

VSSTP
VS

273.15
273.15 Ta+
---------------------------- 
  Pa

760 mmHg
---------------------------- 
 

CA

100
---------=

V1

A1 VSSTP


AS
------------------------=
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Injection Loop Volume – Temperature Change

This equation is used to correct the apparent loop volume when the temperature of the 
loop heat zone is changed.

Vn = New Effective Loop Volume, mL
Vo = Old Loop Volume, mL
To = Old Loop Temperature, °C
Tn = New Loop Temperature, °C

Calibration Error (Goodness of Fit)

This equation is a means to determine whether the calibration curve is acceptable.

E% = Percent error
Qm = Quantity measured
Qc = Quantity calculated
N = Number of measurements

Vn Va

To 273.15+

Tn 273.15+
---------------------------- 
 =

E%

Qmi
Qci

– 

N 1– 
---------------------------

i 0=

N



1
2
---

=
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Percent Dispersion

This equation is used in a Pulse Chemisorption Analysis to calculate the percent 
dispersion. Some understanding of the chemistry is required to select the proper 
stoichiometric factor and gram molecular weight.

%D = Percent dispersion
Vs = Volume sorbed (mL at STP)
SFcalc = Calculated stoichiometry factor
SM = Sample mass (g)
FN = Fraction of sample mass of metal N
GMWcalc = Gram Molecular Weight (g/g-mole)

%D 100
VS SFcalc

FN SM 22414
------------------------------------------ 
 GMWcalc=
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BET Surface Area

Single-Point

These equations are used to determine the BET surface area. The default value for surface 
area of the N2 molecule is 16.210-20m2.

(1)

(2)

(3)

Va = Volume sorbed at ambient conditions, mL
VSTP = Volume sorbed at STP, mL/g of sample
Vm = Volume of the monolayer, mL
Ta = Ambient temperature, °C
Pa = Ambient pressure, mmHg
P = Absolute pressure of N2 (estimated by %N2/100 x Pa), mmHg

SA = Surface area, m2/g
AN2 = Surface area of the N2 molecule, m2/molecule
SM = Sample mass (g)
P0 = Saturation pressure of N2 (estimated by Pa + 15 mmHg), mmHg

(The default value for P0 is used in data reduction unless youcalculate 
a new value and enter it on the Collected Data tab of the sample 
information file.)

VSTP

Va

SM
-------- 273.15K

273.15K Ta+
--------------------------------- 
  Pa

760 mmHg
---------------------------- 
 =

Vm VSTP 1
P

Po
-------– 

 =

SA
Vm

22414
--------------- 6.023 10

23  AN2
=
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Volume Sorbed

This equation is for loop or syringe injections to calculate volume removed from the 
injections by the sample.

Vs = Volume sorbed, mL
I = Number of injections
VI = Volume per injection, mL
Ai = Injection peak area from Volume Vl

Ap = Peak area at saturation

Peak Area Volume

This is the basic data reduction equation. It converts the area under a peak to mL of gas.

Vpa = Peak area volume, mL
Ap = Peak area
Fc = Calibration factor

Stoichiometry Factor

The calculated stoichiometry factor is a weighted average. It is dependent on both the 
individual stoichiometry factor and number of moles of each active metal.

SFcalc = Calculated stoichiometry factor
SFN = Stoichiometry factor for metal N
F1 = Fraction of sample mass for metal N
Watomic1 = Gram molecular weight of first metal (g/g-mole)
GMWcalc = Gram molecular weight (g/g-mole)

VS VI  1-
Ai

Ap

------ 
 =

Vpa Ap Fc=

SFcalc

F1 SF1
Watomic1
--------------------- 
  F2 SF2

Watomic2
--------------------- 
  

FN SFn
WatomicN
---------------------- 
 + + +  GMWcalc=
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Gram Molecular Weight

The calculated Gram Molecular Weight is a weighted average of the number of moles of 
each active metal.

GMWcalc = Gram molecular weight (g/g-mole)
FN = Fraction of sample mass for metal N
WatomicN = Gram Molecular Weight of first metal (g/g-mole)

Cross-Sectional Area

SAcalc = Calculated cross-sectional area
FN = Fraction of sample mass for metal N
SAN = Cross-sectional area for metal N
WatomicN = Gram molecular weight of first metal (g/g-mole)

Metal Density

Dcalc = Calculated density
FN = Fraction of sample mass for metal N
DN = Density for metal N
WatomicN = Gram Molecular Weight of first metal (g/g-mole)

GMWcalc
1

F1

Watomic1
--------------------- 
  F2

Watomic2
--------------------- 
  

FN

WatomicN
---------------------- 
 + + +

-----------------------------------------------------------------------------------------------------------=

SAcalc

F1 SA1
Watomic1

--------------------- 
  F2 SA2

Watomic2

--------------------- 
  

FN SAn
WatomicN

---------------------- 
  GMWcalc+ + +=

Dcalc

F1 D1
Watomic1

--------------------- 
  F2 D2

Watomic2

--------------------- 
  

FN Dn
WatomicN

---------------------- 
  GMWcalc+ + +=
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Metallic Surface Area

This equation calculates the effective metallic surface area per gram of sample.

SAmetallic = Metallic surface area (m2/g of metal)
Vs = Volume sorbed (mL at STP)
SFcalc = Calculated stoichiometry factor
SAcalc = Calculated specific surface area
SM = Sample mass (g)

Active Particle Size

This equation calculates the active particle size for a hemispherical particle.

APS = Active particle size
Dcalc = Calculated metal density (g/mL)
Ms = Sample mass, g
GMWcalc = Gram molecular weight (g/g-mole)
SAcalc = Calculated specific surface area (per gram of metal)

SAmetallic

VS

SM 22414
----------------------------- 
  SFcalc  6.123 10

23  SAcalc =

APS
6

Dcalc

Ms

GMWcalc
----------------------- 
  6.023 10

23  SAcalc 
--------------------------------------------------------------------------------------------------------------------=
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First Order Kinetics

This series of steps calculates the heat of desorption. At least two experiments must be 
run — typically three experiments are run. The ramp rate must be different for each run. 
The data are plotted and the slope determined.

The general equation is:

Determine the slope s by plotting 2 ln Tp - ln  vs.   then determine Ed using:

 = Sample ramp rate, degrees/min
Ea = Activation energy, K joules/(mole K)
R = Gas constant
Tp = Temperature at peak max
s = Slope
Vm = Monolayer volume
ko = Arrhenius pre-exponential constant



Tp
  2

--------
 
 
 

ln -
Ea

RTp
---------

EdVm

Rko
-------------- 
 ln+=

1
Tp
-----

Ea s R=
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D.  FORMAT OF EXPORTED DATA

Data collected using the ChemiSoft program can be exported to a file for use in other 
applications. Data may be exported as an ASCII or Grams/32 (a peak-editing program 
used with early versions of Micromeritics’ AutoChem software) format. Refer to Chapter 
4 for instructions on exporting data. 

ASCII Format

Data are exported in the following format when ASCII is chosen as the export type:

Header

<sample id>
<operator>
<submitter>
<weight>
<loop volume>
<room temperature>
<ambient pressure>
<N2Po>

Remaining Data

The remaining data are displayed based on your choice of Peak Summaries or 
Measurements in report options.

Peak Summaries 

The peaks for each selected experiment in the file are summarized. Data are exported as 
follows:

<experiment number>, <start time>, <end time>
<start temp>, <end temp>, 
<peak  height>, <peak area>
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Measurements

The data points for each checked experiment in the file are reported. Data are exported as 
follows:

<experiment number>, <start time>, <end time>
<temperature>, <tcd signal,> <event flag>, <aux1>, <aux2> 

The tcd signal may be either calibrated or not calibrated based upon the selections made 
when the export operation was performed.

The event flag is either 1 or 0. The state of the event flag switches when a pulse 
chemisorption dose is started.

Grams/32

When Gr:ams/32 is chosen as the export type, five files are created for each experiment 
selected for export. Grams/32 is a peak editing program used in early versions of 
Micromeritics’ AutoChem analyzer. The data in these files can be read only by the 
Grams/32 software. Table D-1 lists the names and contents of these files.

Table D-1. Grams/32 Export File Names

Where xxx is the first three characters of the input sample file name and nn is the number 
of the experiment within the sample.

For example, the second experiment of the sample file ABC.SMP would be exported into 
the following Grams/32 files:

ABC02.CGM
ABCSG02.SPC
ABCTM02.SPC
ABCT102.SPC
ABCT202.SPC

File Name Contents

xxxnn.CGM Calibrated TCD signal vs. time (same as xxxSGnn.SPC when 
no calibration is specified)

xxxSGnn.SPC Uncalibrated TCD signal vs. time

xxxTMnn.SPC Sample temperature vs. time

xxxT1nn.SPC Auxiliary signal one vs. time

xxxT2nn.SPC Auxiliary signal two vs. time
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E.  PEAK DETECTION/INTEGRATION OPTIONS

Peak detection parameters can be customized using the Peak Detection/Integration 
Options dialog. If you customize this dialog when you create the sample file, you can 
control peak detection during analysis. You can also control peak detection after analysis 
by customizing this dialog in Peak Editor. The defaults for the parameters on this dialog 
are usually acceptable, but they may be changed if you wish. 

• To open this dialog while you are creating the sample file:
With the sample file open in Advanced presentation, click on the Analysis 
Conditions tab. Click Insert, then select Experiment. Click Peaks.

• To open the dialog while you are in Peak Editor:
Select the Edit Peaks tab. Then right-click in the graph area and choose Peak 
Integration Options.

The TCD detects and records all deviations from baseline, but only those which satisfy the 
criteria established in this dialog are reported as peaks.

Peak detection is accomplished through a combination of noise, height, and area 
thresholds.
May 04                                                      E-1 



ChemiSoft TPx Operator’s Manual Appendix E
Threshold Y Level

Sets the minimum height for peaks to be identified and included in the peak table. This 
value is expressed in terms of the trace’s Y-axis units. Use a value of 0 (zero) to include 
all peaks.

Smoothing

This feature allows the software to average the points before using them, so that noise 
spikes are ignored. Specify the number of points you wish the software to average into a 
single value during the peak picking process.

The smoothing parameter can be turned off by setting the value at 1 or 0 (zero). A setting 
of 1 disables smoothing, and the peak edges are interpolated to the best X-axis value. A 
setting of 0 also disables smoothing, but the peak edges (the points where the peak begins 
and ends) are not interpolated. Instead, the nearest data point is used as the peak edge.

Sensitivity

Sets the noise rejection level for identifying the peaks in a trace. Use a value from -100 to 
100%. For example, a sensitivity level of 5% means that 5% of all local maxima in the 
trace are greater than the noise and are, therefore to be considered as peaks. A value of 
100% identifies all local maxima (or minima for traces with transmission Y units) as 
peaks. One possible exception to note is the combination of other rejection parameters 
(such as Minimum Peak Area and Threshold Y Level) which can reject peaks even when 
the sensitivity is set to 100%.

The sensitivity can also be set to negative values to define a specific noise level (in Y 
units) for peak rejection. For example, a sensitivity setting of -2.5% sets the noise 
rejection to 2.5 V. This means that maxima with an amplitude of 2.5 V or less will be 
considered as baseline noise instead of as peaks. (As opposed to the Threshold Y Level 
rejection parameter which eliminates refined peaks by using their height above the 
baseline.)

A setting of 0 (zero) automatically sets a default noise level for the trace.
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Edge Detection

Determines the peak edge-detection algorithm used by the software.

These algorithms can be classified into two general categories: noise-level-based 
detection and slope-based detection.

Algorithm Description

Noise-Based Detection

Raw The “Raw” algorithm performs noise-level-based edge detection 
without further edge refinement. The peak edges are detected at the local 
minimum on either side of the peak. This is the fastest method of peak 
edge detection.

Tangent The Tangent algorithm performs noise-level-based edge detection with 
“tangent baseline” peak edge refinement. The raw  edges are first 
detected at the local minimum on either side of the peak. These edges 
are then refined by finding a line that is tangent to the trace on either side 
of the identified peak. The peak edges are defined where the tangent line 
touches the trace. This tangent line then becomes the baseline used for 
calculating the peak height and area.

Slope-Based Detection

Slope The Slope algorithm performs slope-based edge detection without 
further edge refinement. The peak edges are detected on either side of a 
peak where the absolute value of the slope exceeds a minimum slope 
value.  his minimum detectable slope is defined by another parameter, 
Minimum Edge Slope. Normally, a Smoothing setting greater than 1 
must also be used.

Normal The Normal algorithm performs slope-based edge detection with 
“tangent baseline” peak edge refinement. The raw  edges are first 
detected on either side of a peak where the absolute value of the slope 
exceeds a minimum slope value.  (This minimum detectable slope is 
defined by the Minimum Edge Slope parameter described later in this 
chapter.) These edges are then refined by finding a line that is tangent to 
the trace on either side of the identified peak. The peak edges are defined 
where the tangent line touches the trace. This tangent line then becomes 
the baseline used for calculating the peak height and area.
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Max Shoulder Ratio

There can also be “shoulder peaks” (also called combination peaks) within a group. (For 
a discussion of peak groups, see the description of Max Group Separation below.)  
Shoulders are usually small peaks that are overlapped on the front or the tail of a larger 
peak. These peaks can also be called “leaders” and “followers,” respectively. As with 
baseline groups, the areas of these peaks can be calculated incorrectly. If the larger 
“parent” peak has a long tail with a much smaller peak riding on it, most of the area under 
the trace belongs to the parent peak. However, if the area of these peaks was determined 
using baseline grouping, the smaller peak would be calculated by using vertical drop lines 
at the edges. This would give the parent peak too little area, and the rider peak too much.

The software can detect these shoulder peaks. The areas of shoulder peaks are calculated 
by drawing a skimmed baseline from the leading edge to the trailing edge. Either an 
exponential or a straight skim line can be used. The skim type is specified by a secondary 
method parameter and the default is exponential skimming. The remaining area between 
the shoulder peak baseline and the group baseline is considered to be part of the parent 
peak.

The Max Shoulder Ratio parameter is used to specify whether the peaks that are 
overlapped in the front or the tail of much larger peaks should be identified as shoulder 
peaks. To use shoulder peak detection, use a non-zero value for the Max Shoulder Ratio 
parameter. After a baseline group has been identified, the software looks for peaks within 
the group that satisfy the following shoulder peak criteria: 

Shoulders must have a significantly higher Y value at one edge than the other.  More 
importantly, the height of the shoulder above the common value must be much smaller 
than the height of the “parent” (larger) peak above the same valley.  It must be smaller by 
the Max Shoulder Ratio setting. For example, a setting of 33 implies that shoulders must 
be smaller than 33% of their parents in terms of height above the common valley. The 
areas for shoulder peaks are calculated by drawing a skimmed baseline from the left edge 
to the right edge of the peak.  The remaining area between the shoulder peak baseline and 
the group common baseline is considered to be part of the parent peak.

Shoulder peaks can only be calculated within a group of peaks. (See the description of 
peak groups in the section below on Max Group Separation.) If the Max Group 
Separation parameter is set to 0 (no groups), a Max Shoulder Ratio parameter value is not 
used. Use a value of zero to specify no shoulder peak detection.

A value of 33% works well with most data. Use a setting of zero to treat shoulder peaks 
with a perpendicular drop to the common group baseline instead of a skimmed baseline. 

If the software detects unwanted baseline noise peaks, try increasing the Sensitivity 
setting. Conversely, if some peaks are not detected, decrease the value.
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Max Group Separation

The software normally calculates peak areas by drawing a “valley-to-valley” baseline 
from the leading edge to the trailing edge of every identified peak. However, in many 
traces, the valleys between peaks do not always drop back to the original baseline. If a 
valley-to-valley baseline is used for this type of peak, the calculated area does not 
accurately reflect the true area under the peak.

The software provides a parameter that allows the calculation of “Baseline Groups.” A 
group of peaks is defined by a common baseline that extends from the leading edge of the 
first peak in the group to the trailing edge of the last.  The areas of grouped peaks are 
calculated by dropping vertical lines from the peak edges down to the group baseline. 
(Note there may also be “Report Groups” defined by the method and assigned group 
letters from A through Z. Unlike these Baseline Groups, the Report Groups need not be 
next to one another. The two types of groups are not related.)

The Max Group Separation parameter is used to determine which peaks in a trace have a 
common baseline. When using peak grouping, the software compares the width (actually 
double the largest half width) of every identified peak in a trace to the width of the 
following peak. The Max Group Separation parameter specifies a percentage of the 
smallest of these two widths in X units. If the edges of two adjacent peaks differ by less 
than this value, the two peaks constitute a group and are given a common baseline. For 
example, if two adjacent peaks in the trace have largest half widths of 1 and 1.5 
respectively, and the Max Group Separation parameter is set at 20%, then a difference of 
less than 0.4 X units between the adjacent edges of these peaks would make them a group 
with a common baseline. If the same two peaks have adjacent edges that are greater than 
0.4 X units apart, they do not define a group, and each peak has its own separate baseline.

The areas for grouped peaks are calculated by drawing imaginary vertical lines from the 
peak edges to the common baseline. Any peaks that share common edges are 
automatically considered a group and are given a common baseline for any Max Group 
Separation setting greater than 0. To specify no peak grouping (each identified peak has 
its own baseline), use a setting of zero. A value of 33% for this parameter works well 
with most data. Use a setting of zero to force all baselines to be drawn from peak valley 
to valley.
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Minimum Edge Slope

This parameter is used by slope-based peak edge detection algorithms to differentiate between 
peaks and baseline. It specifies the minimum slope threshold in terms of your trace’s Y-axis units 
divided by the X-axis units (e.g., millivolt/minutes). Sections of the trace with slopes exceeding 
this value are considered peaks, while all other areas are considered baseline.

To have the software automatically determine the best value for the “Minimum Edge Slope” 
parameter, use a setting of 0.

If the software incorrectly locates the trailing edges of your peaks, as evident by improperly drawn 
baselines, decrease the setting by typing in a smaller value. If the trace contains a significant 
amount of baseline noise, you may also need to adjust the Smoothing parameter.

Minimum Peak Area

This parameter sets the minimum area required for refined, processed peaks to be 
recognized, identified, and included in the peak table. Any peak with a calculated peak 
area smaller than the current setting is not detected. Values for this parameter are 
expressed in terms of the trace X-axis units multiplied by the Y-axis units (e.g., millivolt-
minutes).

Setting the Sensitivity parameter to large values (greater than 20%) can cause noise 
“spikes” (or “dips”) on the sides of major peaks to be identified as peaks themselves. If 
the areas of the peaks are smaller than the Minimum Peak Area parameter, major peaks in 
the trace may not be identified at all. Exercise caution when using high Sensitivity 
settings with the Minimum Peak Area parameter.

If peaks are not detected by the software, lower the setting with a smaller value. You must 
adjust this parameter in conjunction with the Peak Sensitivity and/or Threshold Y 
parameters above. Peak rejection is accomplished through a combination of peak height 
and peak area rejection parameters. If the software is not detecting your peak(s) of 
interest, you probably need to decrease both parameters.
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F.  TUTORIAL

This tutorial will guide you through a typical calibration, analysis, and peak-editing 
session for a multipoint BET analysis. The process involves:

• creating a sample information file, in which you set up parameters for your analysis
• performing the analysis
• creating the calibration file
• assigning the calibration file to the sample data
• editing peaks

Creating a Sample Information File

This sample file will contain steps for three calibrations and three analyses.

Calibration Steps

1. Select Open, Sample Information from the File menu; the Open Sample Information 
dialog is displayed.

2. Click OK, then Yes to create the file; the sample information dialog is displayed.

3. Enter an appropriate description in the Sample field.

4. Enter the operator and submitter names (if applicable).

5. Enter the sample mass in the Mass field.
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6. Use the Comments window (if desired) to enter pertinent information about your 
sample or analysis conditions. Anything you enter in this window displays in the 
header of the report.

7. Click the Analysis Conditions tab; the Analysis Conditions dialog is displayed.

8. Click Insert; the Insert Experiment dialog is displayed. 

9. Choose Experiment, then click OK; the New Experiment dialog is displayed.

10. Enter a description in the Experiment description field; the first experiment is a 
calibration.
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11. Click Gas Flows; the Gas Flows dialog is displayed.

12. Choose your Carrier gas from the drop-down list; this example shows 30 N2-He. The 
flow rate of 25 is appropriate.

13. In the Flow Options group box, choose:

• Bypass for the path
• Long delay

The Cold Trap Dewar and Loop options are not applicable in this tutorial.   

14. Click OK to return to the New Experiment dialog, then again to close the dialog.

15. Now that you have defined your experiment (calibration), you must define its 
associated steps; click Insert to display the Insert Experiment Step dialog.

16. Select Wait, then click OK; the Wait dialog is displayed.

17. Click Wait until baseline is stable, then click OK to close the dialog.

18. Click Insert; the Insert Experiment Step dialog is displayed.
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19. Select Recording; the Start Recording dialog is displayed.

20. Enter how often you wish to record a measurement, then click OK to close the dialog; 
the Analysis Conditions dialog is displayed.

21. This experiment contains three calibration peaks, so repeat steps 8 through 20  
two more times. 

This completes the steps for the calibrations. 

Analysis Steps

1. Click Insert; the Insert Experiment dialog is displayed. 

2. Choose Experiment, then click OK; the New Experiment dialog is displayed.

3. Enter a description in the Experiment description field.

4. Click the down arrow to the right of the Type of analysis field and select 
Physisorption Surface Area.
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5. Click Gas Flows; the Gas Flows dialog is displayed.

6. In the Flow Options group box, choose:

• Sample for the path
• Long delay

The Cold Trap Dewar and Loop options are not applicable in this tutorial.   

7. Click OK to return to the New Experiment dialog, then again to close the dialog.

8. Click Insert; the Insert Experiment Step dialog is displayed.

9. Select Wait, then click OK; the Wait dialog is displayed.

10. Click Wait until baseline is stable, then click OK to close the dialog.

11. Click Insert; the Insert Experiment Step dialog is displayed.

12. Select Recording; the Start Recording dialog is displayed.
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13. Enter how often you wish to record a measurement, then click OK to close the dialog.

14. Click Insert; the Insert Experiment Step dialog is displayed.

15. Select Dose and click OK; the Dose dialog is displayed.

16. Select Get Physisorption Point, then click OK to return to the Analysis Conditions 
dialog.

17. Perform steps 1 through 16 two more times, entering two additional experiments. Be 
sure to change the description accordingly. For example, the second experiment will 
be on 20% concentration so indicate 20% in the description field of the second 
experiment.

18. Click the Report Options tab to specify report options.

19. Select the following reports (double-click on each, or highlight and press the 
spacebar):

• Summary

• BET Surface Area; edit this report and select Multipoint plus one single point, 
Tabular Report, Surface Area Plot, and Isotherm Plot  

• Langmuir Surface Area; edit this report and select Tabular Report, Surface Area 
Plot, and Isotherm Plot 

20. Click Save, then Close.

Select File, Print, and choose your sample file to print the entire contents of the 
file. This allows you to verify that all parameters are correctly entered. You can also 
check parameters by clicking on the step and viewing the contents in the Step 
Detail window.
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Performing the Analysis

Now that you have created your sample file and loaded your prepared sample, it is 
time to perform the analysis.

1. Click Start analysis from the Unit menu; the Analysis dialog with the Open Sample 
Information dialog positioned on top is displayed.

2. Select the file you created and click OK; the Analysis dialog containing the 
parameters specified in your sample becomes fully visible.
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3.  Click Next; a dialog displaying the gases required for the experiments is displayed.

4. Click Next; a dialog  allowing you to choose a calibration file for your analysis is 
displayed.   

Calibration experiments can be performed before analysis if desired and applied to the 
analysis using this dialog. This tutorial, however, does not show this method. 
Calibrations for this analysis are being  performed in the first experiment and will be 
applied during the peak-editing procedure.
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5. Click Next; a dialog enabling you to have a report generated automatically after 
analysis is displayed. You can select this option if desired, or you can have the report 
generated later by selecting Start Report from the Reports menu. 

6. Click Next; a warning dialog about incompatible gases is displayed. 

7. Click Start; this view of the dialog is displayed.

Notice that this view of the dialog contains a prompt just below the synopsis. This 
prompt displays interaction requirements with the analyzer. All remaining analysis 
dialogs will contain this prompt. 

8. Perform the action requested at the prompt, then click Continue. Repeat this step for 
the remaining analysis dialogs. 

9. Click Show Results on the Unit menu to view the data as collected. This enables you 
to view the data as collected and allows the analysis window to remain onscreen so 
that you can respond to the prompts. 

After you have completed your experiments, edit your peaks and assign your calibration 
files (next section). It is best to do this before you generate your report(s).

This prompt 
displays actions 
required to 
complete the 
analysis.
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Editing the Peaks

1. Select Peak Editor from the Reports menu.

2. Choose the file for the analysis we just completed, then click OK; the Peak Editor, 
Stacked view dialog is displayed. This view of the dialog displays all calibrations and 
experiments contained in the file, stacked one after the other.

3. Click a calibration experiment; the name of the experiment displays in the title bar of 
the dialog. This is why it is important when creating files, that you enter an intuitive 
description for your experiment.

4. Click the Edit Peaks tab; the Edit Peaks dialog and table for the selected calibration 
are displayed.

5. Right-click in the graph area and select Find All Peaks; this option finds all peaks and 
marks them.

6. Right-click and select Save.

Peaks should be in a positive position before integrating. If you have any negative 
peaks, right-click in the graph area, choose View, Display and click the Invert 
option.

You can further define peaks if desired. Select the peak (the baseline area of the 
peak displays in green when selected), right-click, and use the Mark Left Edge and 
Mark Right Edge options.
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Creating the Calibration File

After you have defined your calibration peaks, you can create your calibration file.

1. Select TCD Calibration, New from the Unit menu; the TCD Calibration dialog is 
displayed

2. Click Load Calibration Data; the Load Calibration Sample File dialog is displayed.

3. Select the sample file, then click OK; all peak data are imported into the Peak Table.

4. Enter an intuitive description into the Description field. It is important that you use a 
description that you will easily recognize.

5. Delete from the Peak Table any data not associated with your calibration experiment.

6. Using the formula given below, calculate the peak volume for each peak in the table; 
enter the results into the appropriate fields

Example: Calculations for 1 mL injection, ambient temperature of 22 ºC, ambient 
pressure of 740 mmHg 

Peak
amb

amb
injsyr V

mmHg760

P
x

15.273T

15.273
xV 



mLSTP901.0
mmHg760

740
x

15.27322

15.273
x1 


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7. Click Save to save the calibration file, then Close to close the dialog.

Repeat steps 1 through 7 for each gas concentration in the calibration. For example, if 
you have gas concentrations of 10%, 30%, and 20%, you should mark your calibration 
peaks and create calibration files for all three concentrations; a total of three files.

Assigning the Calibration File to the Experiment

Now you must assign the calibration to the appropriate experiment.

1. Click back into the Peak Editor dialog and select the Experiments-Stacked tab.

2. Click a sample experiment. Remember, you can view the experiment name in the title 
bar.

3. Click the Edit Peaks tab; the Edit Peaks dialog and table for the selected sample 
experiment are displayed.

4. Right-click in the graph area and select Find All Peaks. 

5. You should have only one peak in the table; if multiple peaks are included, delete all 
but the desorption peak. The desorption peak typically is the last one in the table.
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6. Right-click in the graph area and select Set Calibration; the Set Calibration dialog is 
displayed.

7. Click on the down arrow to the right of the Calibration field and choose the 
Calibration file you created for the concentration for the selected experiment. Be sure 
that the Experiment and the Calibration match.

8. Right-click in the graph area and select Save.

Now you are ready to generate your report; proceed with the next section.
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Generate the report

1. Select Start Report from the Reports menu; The Start Report dialog is displayed.

2. Choose your sample file and click OK; the Select Reports dialog is displayed. 

3. Ensure that appropriate reports are selected and click OK; requested reports are sent 
to the destination specified in the sample file. 

Most users generate reports to the screen. This allows you to view parameters and 
data, and customize the reports in other ways. You can also generate the reports to 
a printer from the onscreen report window.
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INDEX

$ symbol, 4-2, 4-3, 8-8, 8-11

A
Activation energy, 1-5
Active concentration, 5-42, 8-14
Active Metals Defaults command, 8-15
Active Metals Table dialog, 5-17, 5-43
Active sites, 1-5
Add Log Entry, 5-9
Adsorbate

cross-sectional area, 5-34, 5-35
density conversion factor, 5-36

Advanced format, 5-5, 8-3
sample defaults, 4-1, 8-10
Sample information file, 5-8

All file status, 5-3
Ambient pressure, 8-16
Ambient temperature, 8-16
Analysis

canceling, 6-8
performing, 4-11, F-7
starting, 6-2
stopping, 6-8
suspending, 6-8
types of, 5-16

Analysis conditions
editing after start of analysis, 6-4

Analysis conditions file, 5-11
creating, 4-5
listing file statistics, 4-16, 5-47
printing contents, 5-46
saving as a different name, 5-44
specifying defaults for, 8-13
verifying parameters before analysis, F-6

Analysis dialog, 6-2
Analysis Log report, 5-32, 5-39

entries, 5-9
Analysis program

exiting, 5-54
information, 3-9
installing, 2-1
menu structure, 3-8
reinstalling, 2-10
system requirements, 1-8
uninstalling, 2-15

Analyzer
moving from one computer to another one, 2-11
removing from computer, 2-14

Analyzing file status, 5-3
Atmospheric pressure, 8-16
Atomic weight, 8-15
Autofit peaks, 7-27
Automatic report generation, 6-6
Autoscale, 5-41, 7-18
Axis coordinates,viewing, 7-13
Axis Properties dialog, 7-11

B
Baseline, 5-29

specifying parameters, 5-25
Baseline Detection Parameters dialog, 5-25
Basic format, 5-5, 8-4

sample defaults, 4-3, 8-7
Sample information file, 5-6

BET surface area
analysis, 1-6

BET surface area report
calculations, C-4

C
Calculations used for reports, C-1
Calibration

file, assigning to experiment, 7-24
loop, 5-21
TCD, 6-15
thermocouple, 6-20

Calibration file
assigning to experiment, F-12
creating, F-11

Canceling an analysis, 6-8
Carrier gas, 5-18
Cascade windows, 3-9
Cautions, defined, 1-2
Change Flow Options dialog, 5-23
Check box, 3-4
ChemiSoft program

information, 3-9
installing, 2-1
menu structure, 3-8
reinstalling, 2-10
uninstalling, 2-15

Close All command, 5-45
Close command, 5-45
Close Reports command, 7-5
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Cold trap dewar, 5-20, 5-23
Collected data, 5-42
Columns on reports, editing, 7-9
Comments window, 5-9
Complete file status, 5-4
Controller. See Furnace Controller
Cooling fan, enabling, 5-28, 5-30
Cross-hairs

peak editor, 7-16
reports, 7-13

Cross-sectional area
calculations, C-6
for elements, 8-15

Curve Properties dialog, 7-11

D
Data

collected, 5-42
export format, D-1
exporting, 5-51
importing MS signal, 5-49
reporting at specified intervals, 5-33

Data entry field, 3-3
viewing valid ranges for, 3-4

Data Presentation command, 8-6
Dates push button, 3-5
Deconvolution, 1-4
Defaults

active metals, 8-15
environmental, 8-16
for sample information files, 4-1
gas, 8-14
report font, 7-8
specifying for parameter files, 8-13
specifying for sample files, 8-7
TCD calibration, 6-16

Delay, 5-19, 5-23
Density conversion factor, 5-36
Density, active metals table, 8-15
Dewar, 5-24

cold trap, 5-20
Dialog boxes, 3-3
Done step, 5-30
Dose dialog, 5-24
Drop-down list, 3-4
Duration, on status bar, 6-9
Dwell time, 5-28

E
Edges

marking for peak set, 7-26
marking for peaks, 7-23

Edit Peaks view, 7-21
Energy, activation, 1-5
Environmental Defaults command, 8-16
Equilibration delay, 5-21
Error Messages, B-1
Eurotherm Controller. See Furnace Controller
Exit command, 5-54
Exit Repeat, 6-8
Exiting analysis program, 5-54
Experiment

inserting, 5-12, 5-15
inserting multiple, 5-19
selecting, 7-19

Experiment step
Change Flow Options, 5-23
Change Gas Flows, 5-22
Done, 5-30
Dose, 5-24
inserting, 5-13, 5-16, 5-22
moving, 5-13
Recording, 5-26
Repeat, 5-27
Temperature ramp, 5-28
Wait, 5-29

Export command, 5-51
Exported data

format, D-1

F
File

destination, 5-46, 5-48
exporting, 5-51
name, 8-7
name, as part of identification, 8-8
selecting, 3-5
sequence, 8-7
statistics, 5-47
status, 3-6

File menu, 5-1
Close All command, 5-45
Close command, 5-45
description, 5-1
Exit command, 5-54
Export command, 5-51
Import MS Signal command, 5-49
List command, 5-47
Open command, 5-3
Print command, 5-46
Save As command, 5-44
Save command, 5-44

File name default extensions, 3-7
File parameters

verifying for accuracy before analysis, F-6
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First Order Kinetics report
calculations, C-8
editing, 5-38

Fit Peaks view, 7-25
Fitted points, 5-42
Flow rate, specifying, 5-21
Font, editing for reports, 7-8
Forms, A-1
Furnace controller

display description, 3-10
installing, 2-3
programming, 2-6
selecting power input, 2-3

Furnace thermocouple
connecting, 2-8
readings, 6-20

Fuse
type and rating, 2-5

G
Gas

carrier, 5-18
flow, 5-18
for calibration, 5-21
injection, 5-18
loop, injecting, 5-24

Gas Defaults command, 8-14
Gas Flows dialog, 5-18
Gaussian, 7-26
Grams/32, 5-52

export format, D-2
Graph

copying to clipboard, 7-12
grid lines, showing, 8-6
report options, 5-40

Graphic, displaying in report header, 4-6, 5-32
Gridlines in reports, 8-6

H
Heat of adsorption, 5-38
Help menu, 3-9
Histogram, 7-11
Hydrogen uptake, 1-5

I
Import Mass Spectrometer Signal dialog, 5-50
Import MS signal command, 5-49
Information bar, 3-4
Injection

gas, 5-18

volume, 5-21, 5-42
Injection loop, 5-24

calculations for calibration, C-1
Insert

experiment step, 5-16
method, 5-13

Invert peaks, 7-27
Invert TCD signal, 5-21, 7-23

L
Langmuir Surface Area, 1-7
Langmuir surface area report

editing, 5-35
Legend Properties dialog, 7-12
List calibration files, 6-19
List command, 5-47
Listing file statistics, 4-16
Log Normal Skewed, 7-26
Loop

gas, 5-24
injection, 5-24
valve, 5-20, 5-23

Loop calibration, 5-21
inserting, 5-15

Loop Calibration report
editing, 5-39
example of, 7-35

Loop volume
entering, 6-1, 6-14

M
Main Menu bar, 3-8
Manual

conventions, 1-2
organization, 1-1

Marking peak edges, 7-23, 7-26
Mass

entering, 5-6, 5-9, 6-3
specifying default value, 8-12

Mass spectrometer data
importing, 5-49

Menu structure, 3-8
Messages, error, B-1
Metafile, copying graphs as, 7-12
Metal density, C-6
Moving an analyzer from one computer to another one,

2-11
Multipoint surface area, 5-34
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N
No Analysis file status, 5-4
Notes, defined, 1-2

O
Open command, 5-3
Open Mass Spectrometer Data File dialog, 5-49
Operator default, 8-12
Operator manual. See Manual
Option Presentation command, 8-3
Options button, 6-12
Options menu

Active Metals Defaults command, 8-15
Data Presentation command, 8-6
description, 8-1
Environmental Defaults command, 8-16
Gas Defaults command, 8-14
Option Presentation command, 8-3
Parameter Files Directory command, 8-18
Sample Defaults command, 8-7
System Configuration command, 8-17

Ordering information, 9-1
Overlay view, 7-19
Oxidation, 1-6

P
Parameter files, 4-4

Analysis conditions, defining, 4-5, 5-11
directory, 8-18
listing file statistics, 4-16
opening, 5-3
printing contents, 5-46
Report options, choosing, 4-6, 5-31
saving, 5-44
saving as a different name, 5-44

Parameter Files Directory command, 8-18
Parts, ordering, 9-1
Password, Restricted format, 8-5
Path select, 5-23
Peak

area, E-6
area, calculations, C-5
autofit, 7-27
detection, E-1
edge, E-3
edge, marking, 7-23
edge, marking for peak set, 7-26
editing, F-10
finding all, 7-23
inserting, 7-23
inserting into Peak set, 7-26

integration, 7-24
inverting, 7-23, 7-27
optimization, 7-27
set, inserting, 7-26
shape, 7-26
smoothing, 7-27

Peak Detection/Integration Options, E-1
Peak Detection/Integration Options dialog, 5-20
Peak Editor, 7-14

Edit Peaks view, 7-21
Experiments view, 7-17
Fit Peaks view, 7-25
Overlay view, 7-19
Signals view, 7-20
Stacked view, 7-17

Peak Editor command, 7-14
Percent active concentration, 8-14
Percent dispersion calculations, C-3
Physisorption point, 5-24
Po

See Saturation Pressure
Pore plugging, 1-6, 1-7
Pore volume, 5-36
Presentation formats, 5-5
Print command, 5-46
Printer selection, 8-17
Printing to a File, 5-46, 5-48
Prompt on analysis dialog, 4-14
Pulse Chemisorption, 1-6

report options, 5-37
Pulse chemisorption, 5-23, C-3
Pulse Chemisorption report

example of, 7-32
Pulse chemisorption report

editing, 5-37
Push button, 3-3

R
Radio button, 3-4
Ramp rate, 5-28
Ranges, viewing for selected field, 3-4
Recording step, 5-26
Redraw, 7-18
Repeat step, 5-27
Replace all, 8-8, 8-10
Replace push button, 5-11
Report

automatically generating, 6-6
calculations used, C-1
cross-hairs, 7-13
editing, 5-32
editing legend, 7-12
editing title, 7-12
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examples, 7-28
generating, F-14
header, 7-5
onscreen, 7-6
selecting, 4-6, 7-4
showing company logo in title, 5-32
zoom feature, 7-12

Report menu, 7-1
Close Reports command, 7-5
description, 7-1
Peak Editor command, 7-14
Start Report command, 7-2

Report options
BET surface area, 5-34
First order kinetics, 5-38
graphs, 5-40
Langmuir surface area, 5-35
Loop calibration, 5-39
Pulse chemisorption, 5-37
tabular, 5-33
Tabular report, 5-33
Total pore volume, 5-36

Report options file, 5-31
creating, 4-6
listing file statistics, 4-16, 5-47
printing contents, 5-46
saving as a different name, 5-44
specifying defaults for, 8-13
verifying parameters before analysis, F-6

Report title, showing in report header, 4-6
Restricted format, 5-5, 8-5

Sample information file, 5-10

S
Sample defaults

Advanced format, 8-10
Basic format, 8-7

Sample Defaults command, 8-7
Sample file number, including in description, 4-2, 4-3
Sample information file

verifying parameters before analysis, F-6
Sample information files, 4-7, 5-5

Advanced format, 4-8, 5-5, 5-8
Basic format, 4-9, 5-5, 5-6
exporting, 5-51
exporting data, 4-17
exporting isotherm data, 5-51
listing file statistics, 4-16, 5-47
opening, 5-3
printing contents, 5-46
Restricted format, 4-10, 5-5, 5-10
saving, 5-44
saving as a different name, 5-44

specifying defaults, 4-1, 8-7
status, 5-3
status types, 3-6

Sample temperature, 5-28
viewing, 6-9

Sample thermocouple
inserting, 4-11
readings, 6-20

Saturation pressure, 1-7, 5-42
adsorbate gas, 8-16

Save All command, 5-44
Save As command, 5-44
Save command, 5-44
Save to file calibration, 6-21
Select Dates dialog, 3-5
Sequence file name, 8-7
Setup program

moving an analyzer to another computer, 2-11
reinstalling the software, 2-10
removing an analyzer, 2-14
using for other functions, 2-9

Shortcut keys, 3-1
analysis program, 3-2
for Select Dates dialog, 3-6
peak editor, 7-15

Shortcut menu, 3-1, 7-9
Edit peaks view, Peak Editor, 7-22
Fit Peaks view, Peak Editor, 7-25
for graphs, 7-10
for tabular reports, 7-9
Overlay view, Peak Editor, 7-19
peak editor, 7-15
Signals view, Peak Editor, 7-20
Stacked view, Peak Editor, 7-17

Show Instrument Log command, 6-10
Show Results command, 6-12
Signal

reading, 5-26
TCD, 5-21

Signals view, 7-20
Sintering, 1-6
Slope threshold, E-6
Smoothing, 7-23, E-2
Software

installing, 2-1
reinstalling, 2-10
uninstalling, 2-15
using, 3-1

Specifications, 1-8
Stacked view, 7-17
Start analysis command, 6-2
Start recording step, 5-26
Start Repeat, 5-27
Start Report command, 7-2
Aug 08                                          Index-5   



Index ChemiSoft TPx Operator’s Manual
Start Report dialog box, 7-2
Status, 5-3
Status window, 6-9
Step

details, 5-14
moving, 5-13
repeating, 5-27

Stoichiometry factor, 8-15
calculations, C-5

Stop analysis, 6-8
Stop recording step, 5-26
Stop Repeat, 5-27
Submitter default, 8-12
Summary report, 5-32

example of, 7-34
Surface area

high, 1-7
specific, 1-6

Suspend analysis, 6-8
Synopsis, 5-12

during analysis, 6-7
Syringe

volume, 5-42
System Configuration command, 8-17

T
Tabular report

copying as text, 7-10
editing, 5-33
shortcut menu, 7-9

TCD, 1-5
reading, 6-9

TCD calibration
assigning to analysis, 7-24
associating with analysis, 6-15
creating new file, 6-16
defaults, 6-16
listing files, 6-19
opening files, 6-17
printing reports for, 6-18

TCD calibration command, 6-15
TCD signal

invert, 5-21, 5-22, 7-23, 7-27
zero, 5-20, 5-22

Temperature
ramp, 5-28

Temperature-Programmed Desorption, 1-5
report example, 7-29
See also TPD

Temperature-Programmed Oxidation, 1-6
See also TPO

Temperature-Programmed Reduction, 1-5
See also TPR

Text, copy graph data as, 7-12
Thermal Conductivity Detector

See TCD
Thermocouple

furnace, 2-8
sample, 2-8

Thermocouple Calibration command, 6-20
Tile windows, 3-9
Title Properties dialog, 7-12
Tool bar, Report window, 7-7
Total Pore Volume, 1-7
Total Pore Volume report

editing, 5-36
TPD analysis, 1-5
TPO analysis, 1-6
TPR analysis, 1-5
Tutorial

assigning calibraiton file to experiment, F-12
creating a calibration file, F-11
creating a sample file, F-1
defining analysis steps, F-4
defining calibration steps, F-1
editing peaks, F-10
generating the report, F-14
performing the analysis, F-7

U
Unit configuration command, 6-14
Unit menu, 6-1

description, 6-1
Show Instrument Log command, 6-10
Show Results command, 6-12
Show Status command, 6-9
Start analysis command, 6-2
TCD Calibration command, 6-15
Thermocouple Calibration command, 6-20
Unit Configuration command, 6-14

Units, choosing type to display, 8-6
USB cable, connecting, 2-3

V
Volume, syringe, 5-21

W
Wait step, 5-29
Warnings, defined, 1-2
Weight

See Mass
Windows menu, 3-9
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X
X-axis, 5-41, 7-21

Y
Y-axis, 5-41

Z
Zeolites, 1-7
Zoom feature

peak editor, 7-16
reports, 7-12
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